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Chapter 1. Getting Started

About this Tutorial
This tutorial for the Sterling Gentran:Server® Application Integration subsystem
references the ANSI X12, EDIFACT, and TRADACOMS standards.

Any sections in this tutorial that do not apply to all three standards are marked
with the applicable standard name. If a section heading does not include a
standard name, then the section applies to all three standards. In some tasks, the
steps and information apply to all three standards but a specific detail may be
different, such as a field name.

For example: In the "What is the name of the form" box, enter one of the
following:
v PET_850 (for ANSI X12)
v PET_EORD (for EDIFACT)
v PET_TORD (for TRADACOMS)

This tutorial includes an inbound mapping example (purchase order) and an
outbound mapping example (invoice). It covers EDI to flat file translation only. The
purpose of this tutorial is to break the mapping process into concise and
understandable steps, using examples that allow you to understand and master the
tasks and processes required to create your own maps.

This guide assumes that you are familiar with using a PC and with Microsoft
Windows functions, including:
v The terminology used to describe mouse and cursor actions.
v The terminology used to describe Windows-specific attributes, including dialog

boxes, icons, windows, and buttons.
v Using the Windows Program Manager.

This guide also assumes that you are familiar with EDI concepts, EDI standard
structure, your internal application format, data mapping concepts, and with the
Sterling Gentran:Server product.

Additional Information

To access reference information, see the IBM® Sterling Gentran:Server for Microsoft
Windows Application Integration User Guide.

For additional information on the various tasks described in this guide, refer to the
IBM Sterling Gentran:Server for Microsoft Windows User Guide.

For XML mapping information, see the tutorial in the IBM Sterling Gentran:Server
for Microsoft Windows XML User Guide.

© Copyright IBM Corp. 1996, 2012 1



Mapping Overview
A map is a set of instructions you define in the Sterling Gentran:Server Application
Integration subsystem that defines the relationship between your application file
and the EDI standards, and defines how the system should translate data.

For inbound mapping, the system translates your trading partner’s EDI standard
formatted business document to your file format. To translate inbound data, you
need to create an export map in Sterling Gentran:Server Application Integration
(because the system is exporting to your application file).

For outbound mapping, the system translates your file format to EDI standard
formats, so you can send documents to your partners. To translate outbound data,
you need to create an import map and a system import map in the Sterling
Gentran:Server Application Integration subsystem. You need to create an import
map because the system is importing from your application file.

The import map defines how to move data from your application file (flat file
definition), which may contain multiple documents, to the EDI standard-formatted
documents that your partners expect to receive from you. You need to create a
system import map to determine which trading relationship (established in Partner
Editor) corresponds to each document in the application file, so the system knows
which import map to use to process the document.

Translation Objects

The map you create is the source from which you compile a translation object. A
translation object is a set of instructions the translator uses to convert a file from
one format to another. Every function performed during translation requires a
translation object. Translation objects control all the functions of Sterling
Gentran:Server EDI translation. Translation objects can belong to one of the
following categories:
v system translation objects
v user translation objects

System translation objects control the creation and separation of interchanges,
functional groups, and transaction sets. They are also used to generate and
reconcile functional acknowledgements. User translation objects control data entry,
importing, exporting, document turnaround, and creating printed reports. All
required system translation objects are automatically installed with the Sterling
Gentran:Server system.

The Application Integration subsystem enables you to generate import, export, and
turnaround translation objects. Once you generate a translation object using the
Application Integration subsystem, you must register the translation object with
Sterling Gentran:Server. In addition, you must set up relationships for all trading
partners from which you receive or to which you send data. During the process of
establishing a trading relationship, you need to specify the name of the appropriate
translation object that the translator uses to translate the data. See the IBM Sterling
Gentran:Server for Microsoft Windows User Guide for more information about trading
partners.

2 IBM Sterling Gentran:Server for Windows: Application Integration Tutorial for Outbound Invoices



Inbound and Outbound Translation Process

The following diagram shows a high-level view of the inbound EDI to application
and outbound application to EDI translation processes.

When you create an export map, you need to define to Sterling Gentran:Server the
EDI standard format in which your partners sends documents and your
application file format (how the data needs to be formatted for your application to
process it). When you create an import map, you must define to Sterling
Gentran:Server your application file format (your data that you will send to your
partners) and the EDI standard format in which your partners expect to receive the
documents.

Application File Format
If you are creating an import or export map, you must define your application to
the Application Integration subsystem. In Sterling Gentran:Server terminology,
your application file is also referred to as a fixed-format file or a positional file.
Your application file must contain all the information that you need to either
extract from your partner’s document (if the map is inbound) or send to your
partner (if the map is outbound).

This table describes the map components that you use to define your application
file.

Component Icon Description

Group This is a looping structure that contains related records and/or groups that repeat in
sequence until either the group data ends or the maximum number of times that the
loop is allowed to repeat is exhausted. If you create a group that is subordinate to
another group (a subgroup), this corresponds to a nested looping structure (a loop
within a loop). The application (positional) file is a group and therefore, it is visually
represented the same way as other groups and subgroups in the Application
Integration subsystem.

Record Contains a group of related fields. A record can occur once or can repeat multiple
times.

Field This is the smallest piece of information defined in the application file. A field is the
application map component that is mapped (linked) to a corresponding EDI element.
When an element contains a standard rule a black asterisk appears to the right of the
element icon.

Notes:
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v When a field has a mapping operation performed against it, a red checkmark is
displayed over the field icon.

v When a field contains a standard or extended rule a black asterisk appears to the
right of the element icon.

v When a group contains an extended rule, a yellow asterisk appears to the right
of the group icon.

Before you define your application file format, you should obtain a layout of the
necessary records, fields, and groups. Each map component is arranged
sequentially in the order that it is most logical for the system to process. Therefore,
each level of your application file must be created sequentially. For example, your
application file contains records and groups. The records contain fields and the
groups contain records and/or subgroups. This means that you must create records
and groups before you create the subordinate fields.

EDI File Format
The EDI file must contain all the information that you expect to receive from your
partner (if the map is inbound) or need to send to your partner (if the map is
outbound).

The Application Integration subsystem generates an EDI file for you, based on the
standard (agency), version, transaction set, and release (for TRADACOMS only)
that you selected. The system includes all the groups, segments, composites, and
elements that are defined by the standards agency for the version of the document
you selected. If you are creating an import or export map, you typically need to
customize the system-generated EDI file by modifying the properties of the map
components and using specialized Sterling Gentran:Server functions to manipulate
the EDI file structure.

The specific EDI map components that you use depends on the type of map you
are creating. This includes the standard, version, and transaction set (document)
selected, and which groups, segments, composites, and elements your company
requires. We recommend that you determine which map components you are using
before generating or defining an EDI file.

The system activates all of the groups, segments, composites, and elements that are
defined as mandatory by the standard. The system does not enable you to
deactivate the mandatory groups, segments, composites, and elements. By default,
Sterling Gentran:Server displays active map components with a black font, and
inactive map components with a grey (dimmed) font.

When translating data, the system does not process groups, segments, composites,
and elements (or records and fields) that are not activated. Therefore, you must
activate the groups, segments, composites, and elements that are not defined as
mandatory by the standard, but that you have determined that you need to use in
mapping.

If you want to use a specialized version of an EDI standard that is not available in
the Sterling Gentran:Server standards database, it may be appropriate for you to
define the EDI file yourself.

This table describes the map components Sterling Gentran:Server uses to define the
EDI file.
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Component Icon Description

Group This is a looping structure that contains related segments and/or groups that repeat
in sequence until either the group data ends or the maximum number of times that
the loop is allowed to repeat is exhausted. Groups are defined by the EDI standards.
A group that is subordinate to another group is a subgroup (this corresponds to a
nested looping structure – a loop within a loop). The EDI file is a group and is
visually represented the same way as other groups and subgroups in the
Application Integration subsystemt.

Segment Contains a group of related elements or composite data elements that combine to
communicate useful data. Segments are defined by the EDI standards. A segment
can occur once or can repeat multiple times.

Composite This is a data element that contains two or more component data elements or
subelements. Composites are defined by the EDI standards that use them (EDIFACT,
TRADACOMS, and certain ANSI X12 standards).

Element This is the smallest piece of information defined by the EDI standards. An element
is the EDI map component that is mapped (linked) to a corresponding application
field to move data to and from the EDI file.

Notes:

v When an element has a mapping operation performed against it, a red
checkmark is displayed over the element icon.

v When a field contains a standard or extended rule a black asterisk appears to the
right of the element icon.

v When a group contains an extended rule, a yellow asterisk appears to the right
of the group icon.

Default Delimiter Values
The default delimiter values for all three standards are shown in the following
table:

Box
ANSI X12
Default Char.

ANSI X12
Default Hex

EDIFACT
Default Char.

EDIFACT
Default Hex

Tradacoms
Default Char.

Tradacoms
Default Hex

Tag Delimiter = (equal sign) 0x3D

Element
Delimiter

* (asterisk) 0x2A + (plus) 0x2B + (plus sign) 0x2B

Segment
Delimiter

~ (tilde) 0x7E ‘ (single quote) 0x27 ' (single quote) 0x27

Sub Element : (colon) 0x3A : (colon) 0x3A : (colon) 0x3A

Release
Character

? (question
mark)

0x3F ? (question
mark)

0x3F

Decimal
Separator

. (period) 0x2E . (full stop) 0x2E

The Application Integration Subsystem
The Application Integration subsystem enables you to translate your application
files to EDI standard formats for documents you send to your partners (outbound
mapping) and to translate EDI standard formats to your application format for
documents that you receive from your partners (inbound mapping).
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Application Integration Window

The following diagram illustrates the Sterling Gentran:Server - Application
Integration Window. (This is a TRADACOMS example.)

This table describes the Application Integration window components.

Part Function

Control Menu Allows you to control the Application Integration window by
moving, maximizing, or closing it.

Title Bar Contains the name of the application. You can use this to move
the position of the EDI Director window on your desktop.

Minimize Reduces the window to an icon.

Maximize Enlarges the window to its maximum size.

Main Menu Bar Contains drop-down menus. Unavailable items are dimmed.

Main Toolbar Enables you access to some of the most common operations in the
Application Integration subsystem. Unavailable items are
dimmed. The Main Toolbar is a dockable toolbar, so you can affix
it to any edge of the client window.

Status Bar Displays status information about a selection, command, or
process; defines menu items as you highlight each item in the
menu; and indicates any current keyboard-initiated mode for
typing (for example, CAP for the Caps Lock key).

6 IBM Sterling Gentran:Server for Windows: Application Integration Tutorial for Outbound Invoices



Customizing Global Display Options
The Sterling Gentran:Server Application Integration subsystem allows you to
customize the display of maps in several different ways. The global display options
that are established apply to all maps.

About this task

Note: You can set or change global map display options at any time.

Use this procedure to customize global display options for all maps.

Procedure
1. Select Options > Preferences. The Preferences dialog box enables you to set

global defaults for Sterling Gentran:Server.
The Preferences dialog box is displayed.

2. To turn on the default display of group, record (segment), and field (element)
descriptions, select the appropriate options.

Notes:

v You typically want all descriptions displayed for reference. But depending on
the size of your monitor, it may be easier to see the entire map if the
descriptions are not displayed.

v You may want to experiment with shrinking the size of the font for the map
before you turn off the display of descriptions.

3. Click OK to save changes and exit the Preferences dialog box.

Customizing Global Display of Links
Mapping Links are the visual lines that connect a field/element on the Input side
of the map to a field/element on the Output side of the map.

About this task

Use this procedure to customize the global display of mapping links.

Procedure
1. Select Options > Preferences.

The Preferences dialog box is displayed. The Tree tab is displayed by default.
2. Click the Links tab. The Links tab enables you to set the default display of

mapping links.
3. Select one of the following settings:

v Show no links - Do not display mapping links.
v Show links to or from the currently selected element - Display only the

mapping links for the currently selected field.
v Show links to or from all visible elements - Display all the mapping links.

We recommend that you select this option.
The option you select is the default for all maps.

4. Click OK to save changes and exit the Preferences dialog box.
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Customizing Global Confirmation Options
The Confirmations tab on the Preferences dialog allows you specify when you
want confirmation messages displayed. Depending on how you set these options,
you may receive either more or fewer confirmation messages than described in this
tutorial.

About this task

Use this procedure to set the confirmation options.

Procedure
1. Select Options > Preferences.

The system displays the Preferences dialog box (Tree tab displayed by default).
2. Select the Confirmation tab.

The system displays the confirmation options.
3. Set the global confirmation options by either selecting the Confirm everything

check box (displays all confirmation messages) or by selecting individual
confirmation messages by action performed.

4. Click OK to save the confirmation options.
The system sets the confirmation options you selected.

The Application Integration Map-building Process
The following table provides an overview of the map-building process.

Stage Description

1 Prepare and analyze.

Obtain a layout of your application file and determine how it corresponds
with the EDI standard you are using. Determine how you move data to or
from each application field.

2 Set global defaults (first time only).

The first time you use the Application Integration subsystem, you should
establish the default date format that the system uses. Please see the IBM
Sterling Gentran:Server for Microsoft Windows User Guide for more information
on setting the global date default.

3 Create, save, and name a new map.

See the topics on creating maps for more information.

v For outbound invoices, create both a system import map and an import
map.

v For inbound purchase orders, create an export map.

4 Activate the appropriate EDI groups, segments, and elements.

See the topic on activating EDI map components for more information.

5 Define your application file format.

See the topic on analyzing the application file format for more information.

6 Map the appropriate data for each application field.

Specific mapping tasks begin with mapping or defining the header of the
translation object.
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Stage Description

7 Print the mapping report.

Validate and review the map, and make modifications as needed. See the
topic on printing the report for more information.

8 Compile the translation object.

See the topic on compiling the map for more information.

9 Register the translation object with Sterling Gentran:Server.

See the IBM Sterling Gentran:Server for Microsoft Windows User Guide for
more information on registering translation objects.

10 Create the appropriate trading relationship.

Establish the appropriate trading relationship in Sterling Gentran:Server for
your trading partners. The trading relationship that you will use in this
tutorial is provided in the tutorial folders. You need to import the partner
profile into Sterling Gentran:Server, before you begin this tutorial.

See the IBM Sterling Gentran:Server for Microsoft Windows User Guide for
more information on trading partners.

11 Testing the translation object.

Obtain test data from your partners and process the data. Verify
acknowledgement processing (if applicable). Verify communications with
your network.

How to Use the Tutorial
Tutorial basics for ANSI X12

For these tutorials, we have provided test data for the translation objects you
create. The following table describes how to locate that test data:

Translation Object Type Test Data Name Default Path Location

Inbound (export) PETTEST.INT C:\GENSRVNT\TUTORIAL\PETTEST.INT

Outbound (system import
and import)

PET_810.TXT C:\GENSRVNT\TUTORIAL\PET_810.TXT

Tutorial basics for EDIFACT

For these tutorials, we have provided test data for the translation objects you
create. The following table describes how to locate that test data:

Translation Object Type Test Data Name Default Path Location

Inbound (export) PETTSTE1.INT C:\GENSRVNT\TUTORIAL\PETTESTE1.INT

Outbound (system import
and import)

PET_EINV.TXT C:\GENSRVNT\TUTORIAL\PET_EINV.TXT

Tutorial basics for TRADACOMS

For these tutorials, we have provided test data for the translation objects you
create. The following table describes how to locate that test data:
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Translation Object Type Test Data Name Default Path Location

Inbound (export) PETTSTT1.INT C:\GENSRVNT\TUTORIAL\PETTSTT1.INT

Outbound (system import
and import)

PET_TINV.TXT C:\GENSRVNT\TUTORIAL\PET_TINV.TXT

Tips and Recommendations
The following information includes tips and recommendations that you can use
while you are going through the tutorials and building your maps. You might
want to print these pages to keep available through the process.

Map names

You allocate a file name to a map when you save the map for the first time or use
Save As to save a copy of the map under a different name. The name should
define the map in a meaningful way. The default filename extension is .MAP (it
must have a MAP extension to open in the Map Editor). Using this extension
distinguishes map files from other types of files, such as translation objects. The
naming conventions in Sterling Gentran:Server include:

The source map (map created in Sterling Gentran:Server) should be named using
the file extension .MAP (for example, PET_810.MAP, PET_EINV.MAP, or
PET_TINV.MAP).

The compiled translation object (translation object that is the result of compiling
the source map) should be named using the same filename that was allocated to
the source map, but with the file extension .TPL (for example, PET_810.TPL,
PET_EINV.TPL, or PET_TINV.TPL).

We recommend that you use these naming conventions to distinguish source maps
and compiled translation objects from other types of files. We also recommend that
you use the same file name (different file extension) for a source map and the
translation object that was compiled from it.

Be careful not to overlay the source map with the compiled translation object. Use
the .TPL file extension to distinguish the translation object.

Document names and references

We recommend that you set up a Document Name for each map to make the
identification of a document created by this map easier in Sterling Gentran:Server.
This allows you to differentiate between documents in the document browsers in
Sterling Gentran:Server. Document names can be up to 255 characters in length.

To set up a Document Name, you must select an element or field in the map that
contains data that distinguishes the documents translated by this map. (If you
choose a non-string element or field, you need to convert it to a string first.) Then,
the Name field of the document browsers that contain this document contain the
data from the selected element or field. You can choose any element or field as the
Document Name, but we strongly recommend that you select an element or field
that occurs only once in the document and has a data type of String. In this
tutorial, the document name for the map is the purchase order number.
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You can also establish a Document Reference for each map, which also assists you
in differentiating between documents. When you set up the Reference in the
Application Integration subsystem, the RefData field of the document browsers
that contain this document in Sterling Gentran:Server contains the data from that
mapped field. In this tutorial, the document reference for the import map in this
tutorial is the purchase order number.

Link function

The Link function allows you to map a field or element from the Input side of the
map to a field or element on the Output side of the map. When you click the
element, the cursor changes to a Link Arrow. The link between the two fields is
visually represented with a line connecting the two fields.

You can only map fields and elements that are at the same level. This means that
you cannot map to a group from a segment that does not repeat.

Important: If you select Confirm when I link options at different levels, you will
get a warning when an element should not be linked. Do not ignore this warning.
If you link elements when you see this warning, your output may be incorrect.

When compiling

Each rule in the map is compiled when you compile the translation object after
you complete the map. However, the system allows you to compile each rule
individually so that you can verify its accuracy after you create it.

The Compile function will compile the rule interactively and allows you to correct
any generated errors. Errors or warnings that occur during the compilation process
are displayed in the Compile Errors box (or in the Errors list).

Entries in dialog boxes

Names

Do not use spaces or dashes (-) in the Name box. You can use the underscore (_) to
separate words.

Each application field must have a unique name. It is useful to tag the end of the
fields that occur in multiple records with a suffix that identifies the record that
contains it. For example, HDR for the Header record, DET for the detail record,
DESC for the description record, AC for the allowance/charge record, SUM for the
summary record.

Dates:

v For ANSI X12 and EDIFACT, dates are in the MMDDYY format. For example,
120511 would be December 5, 2011.

v For Tradacoms, dates are in the DD/MM/YY format. For example, 05/12/11
would be 5 December 2011.

Descriptions:

This box is used to provide a brief explanation and allows you to differentiate it
from similar fields.
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Tags:

A record is recognized by the system as:
<TAG>[Field_1][Field_2]

The record TAG for each record enables the system to recognize that record and
then determine the mapping requirements.

For temporary storage, use a value of $$$. The system does not read a segment
with a value of $$$ in the Tag box. Therefore, it does not flag this temporary
storage segment as an error during compliance checking.

We recommend that you define the record tag on the Positional Record Properties
dialog box, instead of defining fields with the purpose of explicitly containing the
record tag.

Looping Tab:

The Looping section allows you to specify the minimum and maximum number of
times an element can repeat, and whether it is mandatory or conditional. Alter this
section only if the element is a repeating element. Otherwise, accept the defaults.

Minimum Usage (Looping):

This is the minimum number of times the loop must be repeated. For a conditional
loop, the minimum usage should always be 0. For a mandatory loop, the minimum
usage should be 1 or greater.

Position tab:

To indicate the exact position of the field in the record, type the starting position of
the field in the Start Pos box. For example, you should specify field start positions
if you are only using a few fields but you want them positioned exactly in the
record.

In this tutorial, add the fields sequentially in the record and then use the Auto
Position function.

Auto Position:

This automatically calculates the start position in the record of each field based on
the criteria that each field is positioned directly after the previous field and is of
the length specified in the Max Length box.

It is only valid to use the Auto Position function if you define a record tag on the
Positional Record Properties dialog box, and if you define every field in the record
in the sequence that each field occurs, as you are doing in this tutorial.

Positional Field Editor:

If you press Enter after typing the information for the last field in the record, a
blank field is created. Click Delete and then Yes to delete the blank field.
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Accumulators

There is only one set of accumulators for each map. This means that accumulator
0, whether it is used in the Primary Accumulator or Alternate Accum field is the
same accumulator with the same contents. If you assign calculations to
accumulator 0 at the beginning of the map and then use accumulator 0 again later
in the map, the content of that accumulator will be the result of the earlier
calculation. Any additional calculations you assign to that accumulator will be
performed on the contents resulting from an earlier calculation.
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Chapter 2. Outbound Invoice

About the Outbound Invoice Tutorial
This part of the tutorial defines the step-by-step tasks that are necessary to create a
map that will be used to translate your application file to invoices that you send to
your trading partner.

These tasks include the following:
v Mapping analysis
v Creating the new map
v Defining constants
v Activating groups, segments, and elements
v Activating EDI map components
v Verifying EDI delimiters
v Defining the application side of the map
v Mapping your data
v Finalizing the map

There are tasks and information for ANSI X12, EDIFACT, and TRADACOMS in
this tutorial. Some tasks and information may not apply to all three standards, and
the heading will indicate this. If the heading does not specify which standard it
applies to, then it applies to all three.

Getting Started with your Outbound Invoice
This tutorial is meant to be completed in its entirety. We recommend that you
complete each task sequentially without referring to the completed map that is
provided with the installation program. You can then verify your completed map
with the model we have provided.

Completing each task in this tutorial in sequential order as if it were your own
scenario not only teaches individual mapping tasks, but also provides a logical
approach to methods that you use when you create your own map.

Outbound Mapping Scenario

This tutorial sets up the following scenario:
v Your company is MWT Manufacturing Co., which manufactures a wide variety

of supplies for pet stores.
v MWT Manufacturing Co. sells pet supplies directly to large pet supply retail

chains.
v Pet Zone, a large pet supply retailer, is the trading partner. After shipping an

order to Pet Zone, generate the invoice.

You need to create a map that enables your company to translate your application
file to the invoices that you send to Pet Zone.

You have an existing application file layout from your accounts payable
department that defines the information your system generates for the invoice.
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And from discussions with Pet Zone, you know the requirements for the EDI
invoices that you are sending them.

About Mapping Analysis

The first step in creating a map is to analyze your mapping requirements. This is
the most important step in creating a successful map. If your analysis is complete,
you have all the information you need to create the map in an efficient and logical
manner. If you omit this critical step and proceed directly to creating the map, it is
likely that creating the map will be a much longer and arduous task, and the map
may be invalid due to oversights and omissions.

This table describes the steps used in mapping analysis for translating both
inbound and outbound data.

Step Action

1 Analyze your application file format.

2 Analyze your partner’s EDI file format.

3 Correlate your application file format and the EDI file.

4 Create the map.

Analysis of the Application File Format for your Outbound Invoice
The first step of mapping analysis is analyzing your application file format,
because this is probably the component that is the most familiar to you. In this
tutorial, your application file contains the data that you need to convert to an EDI
file so your system can generate the document correctly. In this tutorial, your
application file contains all the information that you need to generate the invoice
that you send to your partner. This enables your company to bill your partner
correctly for the goods you shipped to them.

You must define your application file to Sterling Gentran:Server. If your company
has an existing application file, as in this tutorial, you should obtain the record
layout from the appropriate person. If you did not have an existing application file
layout, you would need to create one by determining which fields are necessary to
process the data correctly, and then grouping the fields logically under records.

Invoices are divided into four parts:
v Header (HEADER)
v Beginning (INVBEGIN)
v Comments (INVCommentGroup)
v Summary (INVSUMMARY)

Header record:

The HEADER record contains the five-field key (partner identifier, standard,
version, transaction set (message), and test/production flag), which is used for
selecting the appropriate trading relationship. This header record is mandatory and
occurs once for each invoice translated.

Beginning record:
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The INVBEGIN record contains the purchase order number and date; the vendor,
ship to, and remit to address information; and the bill of lading number, ship date,
and (for ANSI X12) the term of the invoice. The beginning record is mandatory
and occurs once for each invoice.

Comment group:

The INVCommentGroup includes all comment information for the invoice,
including the reference number and the message text. The INVCommentGroup
occurs once (for ANSI X12) or up to 10 times (for EDIFACT and TRADACOMS)
per invoice translated. The information within the INVCommentGroup is further
segregated by record.
v First comment record (INVCOMMENT1)—for ANSI X12 and EDIFACT�Contains

the reference number. The first comment record is mandatory and occurs once
per INVCommentGroup (once for each comment line).

v Second comment record (INVCOMMENT2)—for ANSI and EDIFACT�Contains
message text. The second comment record is mandatory and occurs up to ten
times per INVCommentGroup (once for EDIFACT).

v Comment record (INVCOMMENT)—for TRADACOMS only�Contains the
message text. The first comment record is mandatory and occurs once per
INVCommentGroup (once for each comment line).

Detail record (INVDETAIL):

Contains line item number and description, quantity shipped, quantity ordered,
unit of measure, price, product code, invoice terms (ANSI X12) and VAT
calculation information (TRADACOMS). The detail record is mandatory and occurs
up to 200,000 times per invoice translated (once for each line item invoiced).

Temporary storage for VAT subtotals record (TEMPVATSTL) - for TRADACOMS
only:

Contains temporary storage fields to enable VAT subtotal calculations. The
temporary storage record is conditional and occurs up to 20 times per invoice
translated (once for each possible VAT code subtotal).

Summary record:

The INVSUMMARY record contains the total invoice amount and the total
transaction amount. The summary record is mandatory and occurs once per
invoice translated.

Application File Definitions for an Invoice
The tables in the following topics contain the minimum information necessary to
define your application file to Sterling Gentran:Server (name, mandatory status,
description, data type, and field length). Each record contains a group of
logically-related application fields. These fields contain the information that your
system needs to generate the invoice.

Each record (except the HEADER record, which is used for selecting the
appropriate trading relationship) contains a three-field record key that ensures that
the same identifying information is located at the beginning of each record. Your
application file format contains a record key so that each record can be identified
individually. The record key for this invoice consists of:
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v your partner’s bill to account number
v the document type
v the invoice number

Application File Header Layout for an Invoice
The application file header layout for this tutorial is shown in the table below. This
information applies to both system maps and system import maps. This occurs
once per document.

Field Name Description Data Type

Length

(min - max)

PARTNER_ID Partner Identifier

(mandatory)

String 1 - 9

STANDARD

ANSI X12, EDIFACT

Standard

(mandatory)

String 1

VERSION

ANSI X12, EDIFACT

Version

(mandatory)

String 6

TRANSACTION_SET

ANSI X12, EDIFACT

Transaction Set

(mandatory)

String 1 - 6

TEST_PROD

ANSI X12, EDIFACT

Test/Production Flag

(mandatory)

String 1

APPL_ID

TRADACOMS

Application ID String 0 - 6

APPL_ALIAS_VALUE

TRADACOMS

Application Alias Value String 0 - 6

Application File Beginning Record Layout for an Invoice
The application file beginning record layout for this tutorial is shown in the table
below. This occurs once per document.

Field Name Description Data Type

Length

(min - max)

BILLTOACCTBEG Bill to Acct Number

(mandatory)

String 1 - 9

DOCTYPBEG Document Type

(mandatory)

String 1 - 6

INVNUMBEG Invoice Number

(mandatory)

String 1 - 10

INVDATE Invoice Date

(mandatory)

Dt/Tm
(YYMMDD)

6

PONUM Purchase Order Number String 0 - 20
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Field Name Description Data Type

Length

(min - max)

PODATE Purchase Order Date Dt/Tm
(YYMMDD)

6

VENDNAME

ANSI X12, EDIFACT

Vendor Name String 0 - 35

VENDADD1

ANSI X12, EDIFACT

Vendor Address Line 1 String 0 - 35

VENDADD2

ANSI X12, EDIFACT

Vendor Address Line2 String 0 - 35

VENDCITY

ANSI X12, EDIFACT

Vendor City String 0 - 30 (for ANSI)

0 - 35 (for
EDIFACT)

VENDSTATE

ANSI X12, EDIFACT

Vendor State String 0 - 2

VENDPOSTAL CODE

ANSI X12, EDIFACT

Vendor Postal Code String 0 - 9

SHIPTONAME Ship To Name String 0 - 35

SHIPTOADD1 Ship To Address Line 1 String 0 - 35

SHIPTOADD2 Ship To Address Line2 String 0 - 35

SHIPTOCITY Ship To City String 0 - 35

0 - 30 (for ANSI)

SHIPTOSTATE Ship To State String 0 - 2

0 - 35 (for
TRADACOMS)

SHIPTOPOSTAL CODE Ship To Postal Code String 0 - 9

0 - 8 (for
TRADACOMS)

SHIPTOLOC Ship To Store Location String 0 - 9

0 - 8 (for
TRADACOMS)

SHIPTODEPTNUM Ship To Dept Number String 0 - 4

REMITTONAME

ANSI X12, EDIFACT

Remit To Name String 0 - 35

REMITTOADD1

ANSI X12, EDIFACT

Remit To Address Line 1 String 0 - 35

REMITTOADD2

ANSI X12, EDIFACT

Remit To Address Line 2 String 0 - 35
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Field Name Description Data Type

Length

(min - max)

REMITTOCITY

ANSI X12, EDIFACT

Remit To City String 0 - 30 (for ANSI)

0 - 35 (for
EDIFACT)

REMITTOSTATE

ANSI X12, EDIFACT

Remit To State String 0 - 2

REMITTOPOSTAL CODE

ANSI X12, EDIFACT

Remit To Postal Code String 0 - 9

BOLNUM Bill of Lading Number String 0 - 12

SHIPDATE Ship Date Dt/Tm
(YYMMDD)

6

TERMS_WHOLE

ANSI X12

Terms Percent Whole Number (N2) 0 - 3

TERMSNETDUE

ANSI 12, TRADACOMS

Terms Net Due Days Number

N0 (for ANSI)

R0 (for
TRADACOMS)

0 - 3

TERMSDISDUE

ANSI 12

Terms Discount Due Days Number (N0) 0 - 3

TERMSTEXT

TRADACOMS

Payment Terms Text String 0 - 40

Application File Comment Group Layout for an Invoice
Each INVCommentGroup can occur up to:
v ANSI X12: once per document
v EDIFACT: 10 times per message
v TRADACOMS: 10 times per message

The ANSI X12 and EDIFACT application file first comment record layout for this
tutorial is shown in the table below. This occurs once per document.

Field Name Description Data Type

Length

(min - max)

BILLTOACCTCM1 Bill To Acct Number

(mandatory)

String 1 - 9

DOCTYPCM1 Document Type

(mandatory)

String 1 - 6

INVNUMCM1 Invoice Number

(mandatory)

String 1 - 10
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Field Name Description Data Type

Length

(min - max)

REFNUM Reference Number

(mandatory)

String 1 - 30

The ANSI X12 and EDIFACT application file second comment record layout for
this tutorial is shown in the table below. This occurs up to ten times for ANSI X12
document or once per EDIFACT message.

Field Name Description Data Type

Length

(min - max)

BILLTOACCTCM2 Bill To Acct Number

(mandatory)

String 1 - 9

DOCTYPCM2 Document Type

(mandatory)

String 1 - 6

INVNUMCM2 Invoice Number

(mandatory)

String 1 - 10

MESSAGETEXT Message Text

(mandatory)

String 1 - 232

The TRADACOMS application file comment record layout for this tutorial is
shown in the table below. This occurs once per message.

Field Name Description Data Type

Length

(min - max)

BILLTOACCTCMT Bill To Acct Number

(mandatory)

String 1 - 9

DOCTYPCMT Document Type

(mandatory)

String 1 - 6

INVNUMCMT Invoice Number

(mandatory)

String 1 - 10

MESSAGETEXT1 Message Text Line 1 String 1 - 40

MESSAGETEXT2 Message Text Line 2 String 1 - 40

MESSAGETEXT3 Message Text Line 3 String 1 - 40

MESSAGETEXT4 Message Text Line 4 String 1 - 40

The application file detail record layout for this tutorial is shown in the table
below. This occurs up to 200,000 times per document.

Chapter 2. Outbound Invoice 21



Field Name Description Data Type

Length

(min - max)

BILLTOACCTDET Bill To Acct Number

(mandatory)

String 1 - 9

DOCTYPDET Document Type

(mandatory)

String 1 - 6

INVNUMDET Invoice Number

(mandatory)

String 1 - 10

ITEMNUM Item Number

(mandatory)

String 1 - 6

QTYSHIP Quantity Shipped

(mandatory)

Number

N0

R0 (for
TRADACOMS)

1 - 5

QTYORD

ANSI X12, EDIFACT

Quantity Ordered

(mandatory)

Number (N0) 1 - 5

UNITPRICE Unit Price

(mandatory)

Number

N2

R2 (for
TRADACOMS)

1 - 7

UOM Unit of Measure

(mandatory)

String 1 - 4

CUSTPROCODE Customer Product Code

(mandatory)

String 1 - 10

UPCCODE UPC Code

(mandatory)

String 1 - 12

ITEMDESC Item Description String 0 - 30

TERMSTYPE

ANSI X12

Terms Type Code String 0 - 2

TERMSDISP

ANSI X12

Terms Discount Percent Number (N2) 0 - 6

VATCODE

TRADACOMS

VAT Rate Code

(mandatory)

String 1 - 2

TEMPVATRATE

TRADACOMS

Temporary Storage VAT
Percentage Rate

String 0 - 10

TEMPLEXC

TRADACOMS

Temporary Line Extended
Cost

Number (R4) 0 - 14

22 IBM Sterling Gentran:Server for Windows: Application Integration Tutorial for Outbound Invoices



The TRADACOMS application file temporary storage VAT record layout for this
tutorial is shown in the table below. This occurs up to 10 times per message.

Field Name Description Data Type

Length

(min - max)

BILLTOACCTTS Bill To Acct Number

(mandatory)

String 1 - 9

DOCTYPTS Document Type

(mandatory)

String 1 - 6

INVNUMTS Invoice Number

(mandatory)

String 1 - 10

SEQA Sequence Number of STL Number (R0) 0 - 10

VATRATE VAT Rate Number (R3) 0 - 6

VATRATECODE VAT Code String 0 - 1

NUMLINES Number of Lines for VAT
Code

Number (R0) 0 - 10

LVLA Line Subtotal Amount
(before VAT)

Number (R2) 0 - 12

VATA VAT Amount Payable Number (R2) 0 - 12

Application File Summary Layout for an Invoice
The application file summary layout for this tutorial is shown in the table below.
This occurs once per document.

Field Name Description Data Type

Length

(min - max)

BILLTOACCTSUM Bill To Acct Number

(mandatory)

String 1 - 9

DOCTYPSUM Document Type

(mandatory)

String 1 - 6

INVNUMSUM Invoice Number

(mandatory)

String 1 - 10

TOTALAMOUNT Total Monetary Value
Summary

(mandatory)

Number

N2

R2 (for
TRADACOMS)

1 - 10

TRANSTOTAL

ANSI X12, EDIFACT

Transaction Totals

(mandatory)

Number (N0) 1 - 6
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Analysis of the Customer EDI File for an Invoice
To analyze the EDI file, you must first determine what you need to send your
trading partner and what your partner expects to receive. It is important to know
the information that your partners expects you to send within the invoice, and
what data is contained in each element used. You and your partners must agree on
which standard, version, and message or transaction set you are using.

In this tutorial, we are using the following standards:
v ANSI X12 version 003030 810 invoice
v EDIFACT version 92.1 INVOIC
v TRADACOMS version ANA001, message INVOIC (invoice), release 9

Before you analyze the EDI file, it is helpful to review the EDI standard(s) that you
will use. Obtain an EDI standards manual for each standard and version that you
are using. Standards manuals are available from EDI standard agencies.

After discussing with your partner what you will send, determining which
segments and elements your partner requires, and reviewing the EDI standard,
make a list of the map components that you must make available for use (activate).

When translating data, the system does not process groups, segments, composites,
and elements (or records and fields) that are not activated. Therefore, you must
activate the groups, segments, composites, and elements that you have determined
that you need to use in mapping if they are not defined as mandatory by the
standard.

Note: When you activate a conditional group or segment, the mandatory
subordinate segments, composites, and elements are automatically activated.

Outbound Invoice Map Components for ANSI X12
This table lists the ANSI X12 map components required for this tutorial.

Groups Segment Element

BIG

(already active)

v BIG03

v BIG04

REF REF02

N1 v N1

v N3

v N4

v REF:2

v N102

v N302

v N401

v N402

v N403

v REF02

ITD v ITD03

v ITD05

v ITD07

DTM DTM02

N9 N9 N902

MSG
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Groups Segment Element

IT1 IT1 v IT101

v IT106

v IT107

v IT108

v IT109

QTY

PID PID:2 PID05

ITD:2 v ITD01

v ITD03

CTT

(already active)

CTT02

Outbound Invoice Map Components for EDIFACT
This table lists the EDIFACT map components that are required, but are not
currently active.

Groups Segment Comp. Element

BGM segment

(already active)

BGM05 element

DTM segment

(already active)

C507 DTM02 element

FTX segment C108 v FTX06 element

v FTX07 element

RFF group RFF segment C506 RFF02 element

DTM:2 segment C507 DTM:202 element

NAD group NAD segment v C080

v C059

v C059

v NAD10 element

v NAD16 element

v NAD17 element

v NAD19 element

v NAD20 element

v NAD21 element

LOC segment C517 LOC05 element

CTA group CTA segment C056 CTA03 element

LIN group LIN segment v C212

v C212

v LIN01 element

v LIN03 element

v LIN04 element

PIA segment v C212

v C212

v PIA02 element

v PIA03 element

IMD:2 segment C273 IMD:206 element

QTY:2 segment C186 QTY:303 element

MOA group MOA:5 segment C516 MOA:502 element
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Groups Segment Comp. Element

CNT segment C270

MOA group

(already active)

MOA:10 segment C516 MOA:1002 element

Outbound Invoice Map Components for TRADACOMS
You will be invoicing only one order per INVOIC message. Therefore, you will
need to change the maximum usage for the IRF segment (Invoice References), PYT
segment (Settlement Terms), and ODD group (Order and Delivery Terms and
Invoice Line Details) to reflect the one order that you are invoicing.

This table lists the TRADACOMS map components that are required, but are not
currently active.

Group Segment Group Segment Comp. Element

CLO

(already
active)

CLOC CLO1

CNAM

CADD v CAD0

v CAD1

v CAD2

v CAD3

v CAD4

PYT PAYT

PAYY PAY2

DNA GNAR v GNA0

v GNA1

v GNA2

v GNA3

ODD

(already active)

ODD:2 ORNO v ORN0

v ORN2

DELN v DEL0

v DEL1

ILD

(already
active)

ILD:2 SPRO SPR1

CPRO CPR1

QTYI v QTY0

v CD04:2

AUCT CD04:3

TDES TDE0

Constants
Because you are creating an import map to translate outbound data, you must use
constants to define the qualifying relationships on the EDI (output) side of the
map. Part of the mapping analysis for an import map is determining in which
elements you must define and use qualifiers, and determining which elements they
qualify. You must use constant values that are compliant with the EDI standard.
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Literal constants are used by the system to store information that is used later in
the map. For an outbound map, constants are typically used to define qualifying
relationships. A qualifying relationship establishes a relationship between an
element and its qualifier. A qualifier contains a code that further defines the
element or the elements with which it is associated. Qualifying relationships are
typically defined in outbound maps. Qualifying relationships are defined using an
standard rule, as explained later in this tutorial.

Constants for ANSI X12

For this tutorial, you must define the following constants to create the required
qualifier elements:

Element Using
Constant Constant ID

Constant Value

(and type) Element it�Qualifies

REF01 BILL_OF_LADING BM (string) REF02

N101 (N1_Vendor) VENDOR VN (string) N102

(N1_Vendor)

N101 (N1_ShipTo) SHIP_TO ST (string) N102

(N1_ShipTo)

REF01
(N1_ShipTo)

DEPT_NUMBER DP (string) REF02

(N1_ShipTo)

REF01
(N1_ShipTo)

STORE_NUMBER SN (string) REF02

(N1_ShipTo)

N101
(N1_RemitTo)

REMIT_TO RI (string) N102

(N1_RemitTo)

DTM01 DATE DTM (string) DTM02

N901 VENDOR_NUMBER 1V (string) N902

IT106 UPC_CODE UI (string) IT107

IT108 BUYER_CODE BP (string) IT109

QTY01 ORIGINAL_QUANTITY OR (string) QTY02

PID01 FREE_FORM F (string) PID05

Constants for EDIFACT

This table lists the constants you must define to create the required qualifier
elements.

Element Using
Constant Constant ID

Constant Value

(and type) Element it Qualifies

DTM:2201 Invoice date/time 3 (string) DTM:2202

RFF:1101

(PONUM_RFF)

Order number (purchase) ON (string) RFF:1102

(PONUM_RFF)
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Element Using
Constant Constant ID

Constant Value

(and type) Element it Qualifies

DTM:2501

(PONUM_RFF)

Order date/time 4 (string) DTM:2502

(PONUM_RFF)

NAD:301

(Vend_NAD)

Vendor VN (string) NAD:310

(Vend_NAD)

NAD:501

(RemitTo_NAD)

RemitTo RE (string) NAD:510

(RemitTo_NAD)

NAD:401

(ShipTo_NAD)

ShipTo ST (string) NAD:410

(ShipTo_NAD)

LOC:1301

(ShipTo_NAD)

Goods receipt place 4 (string) LOC:1305

(ShipTo_NAD)

RFF:1201

(BOL_RFF)

Bill of lading number BM (string) RFF:1202

(BOL_RFF)

DTM:2601

(BOL_RFF)

Despatch date/time 11 (string) DTM:2602

(BOL_RFF)

FTX01 Invoice instruction INV (string) FTX06/FTX07

QTY:501 Despatch quantity 12 (string) QTY:502

QTY:601 Ordered quantity 21 (string) QTY:602

MOA:1301 Unit price 146 (string) MOA:1302

LIN04 Buyer’s part number BP (string) LIN03

PIA:203 UPC Code UP (string) PIA:202

PIA:201 Additional Identification 1 (string) PIA:202

UNS01 Summary S (string)

CNT:201 Number of line items in
message

2 (string) CNT:202

CNT:301 Total quantity 1 (string) CNT:302

MOA:1401 Total amount 128 (string) MOA:1402

Reconcile your Outbound Invoice Application File and the Customer
EDI File

When you translate data outbound, you need to build an import map and a
system import map. The system import map is used by Sterling Gentran:Server to
find the partner relationship for a document, to determine which import map is
used to translate the data. The system import map builds the key that the
translator uses to find the partner relationship. The sole function of the system
import map is to identify the appropriate partner relationship; the system import
map does not map any data.

There are two ways to build the key in a system import map:
v the five-field key (six-field for TRADACOMS standard)
v the three-field key
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You will have to decide whether which method to use for the header record for a
system import map. The six-field key method requires six EDI-specific fields in the
header record:
v partner key
v standard
v version
v transaction set (ANSI X12) or message (EDIFACT and TRADACOMS)
v release (for TRADACOMS only)
v test/production status

The combination of these fields defines a unique key that identifies the appropriate
partner relationship. We recommend using this method because it is flexible.
Typically, you use this method when you are defining your application from
scratch and can easily add the EDI-specific fields that are not already present in
the header record.

The second method is easier to build because it only requires three fields in the
header record (partner key, application ID, and application alias value). Please note
that an empty string is a valid value in the application ID and application alias
value fields. The combination of these three fields defines a unique key that
identifies the appropriate partner relationship. However, because only three fields
are combined to build the key, this method is not as flexible as the preferred
method. Typically, you use this method when you are using a legacy (existing)
application definition, and you do not want to add EDI-specific information.

To reconcile your application file with the EDI file, for each application field you
must determine which EDI element you need to populate with that information,
and how you can map that information to the EDI file. To map information to an
element, you can use linking, standard rules, extended rules, or a combination of
the three.

Header Mapping Operations for Outbound Invoices
This table describes the header mapping operations (by application field) that are
required for the system import map in this tutorial. For the import map, the fields
are the same but do not require mapping. This occurs once per document.

Field Name
Mapping Operations�for
ANSI X12

Mapping Operations�for
EDIFACT

Mapping Operations�for
TRADACOMS

PARTNER_ID Select standard rule to
match the EDI Code in the
Partner record (Partner by
EDI Code)

Select standard rule to
match the EDI Code in the
Partner record (Partner by
EDI Code)

Select standard rule to
match the EDI Code in the
Partner record (Partner by
EDI Code)

STANDARD Update standard rule to
update the Agency field on
the Document record

Update standard rule to
update the Agency field on
the Document record

Does not apply.

VERSION Update standard rule to
update the Version field on
the Document record

Update standard rule to
update the Version field on
the Document record

Does not apply.

TRANSACTION_SET Update standard rule to
update the Transaction Set
ID field on the Document
record

Update standard rule to
update the Transaction Set
ID field on the Document
record

Does not apply.
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Field Name
Mapping Operations�for
ANSI X12

Mapping Operations�for
EDIFACT

Mapping Operations�for
TRADACOMS

TEST_PROD Update standard rule to
update the Test Mode field
on the Document record

Update standard rule to
update the Test Mode field
on the Document record

Does not apply.

APPL_ID Does not apply. Does not apply. Update standard rule to
update the Application Field
1 on the document record.

APPL_ALIAS_VALUE Does not apply. Does not apply. Update standard rule to
update the Application Field
2 on the document record.

Beginning Record Mapping Operations for Outbound Invoices
This table lists and describes the beginning record mapping operations (by
application field) that are required for the import map in this tutorial.This occurs
once per document.

Field Name
Mapping Operations for
ANSI X12

Mapping Operations for
EDIFACT

Mapping Operations for
TRADACOMS

BILLTOACCTBEG No mapping required No mapping required No mapping required

DOCTYPBEG No mapping required No mapping required No mapping required

INVNUMBEG Link to BIG02 Link to BGM05 and UNS01 Link to IRF INVN

INVDATE Link to BIG01 Link to DTM:2202 using 3
(invoice date/time) code

Link to IRF IVDT and IRF
TXDT

PONUM Link to BIG04 Link to RFF:1102 using ON
(order number) code

Link to ODD:2 ORNO ORN0

PODATE Link to BIG03 Link to DTM:2502 using 4
(order date/time) code

Link to ODD:2 ORNO ORN2

VENDNAME Link to (N1_Vendor) N102 Link to (Vend_NAD)
NAD:310

Does not apply.

VENDADD1 Link to (N1_Vendor) N301 Link to (Vend_NAD)
NAD:316

Does not apply.

VENDADD2 Link to (N1_Vendor) N302 Link to (Vend_NAD)
NAD:317

Does not apply.

VENDCITY Link to (N1_Vendor) N401 Link to (Vend_NAD)
NAD:319

Does not apply.

VENDSTATE Link to (N1_Vendor) N402 Link to (Vend_NAD)
NAD:320

Does not apply.

VENDPOSTALCODE Link to (N1_Vendor) N403 Link to (Vend_NAD)
NAD:321

Does not apply.

SHIPTONAME Link to (N1_ShipTo) N102 Link to (ShipTo_NAD)
NAD:410

Link to CLO CNAM

SHIPTOADD1 Link to (N1_ShipTo) N301 Link to (ShipTo_NAD)
NAD:416

Link to CLO CADD CAD0

SHIPTOADD2 Link to (N1_ShipTo) N302 Link to (ShipTo_NAD)
NAD:417

Link to CLO CADD CAD1

SHIPTOCITY Link to (N1_ShipTo) N401 Link to (ShipTo_NAD)
NAD:419

Link to CLO CADD CAD2
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Field Name
Mapping Operations for
ANSI X12

Mapping Operations for
EDIFACT

Mapping Operations for
TRADACOMS

SHIPTOSTATE Link to (N1_ShipTo) N402 Link to (ShipTo_NAD)
NAD:420

Link to CLO CADD CAD3

SHIPTOPOSTALCODE Link to (N1_ShipTo) N403 Link to (ShipTo_NAD)
NAD:421

Link to CLO CADD CAD4

SHIPTOLOC Link to (N1_ShipTo) REF02 Link to (ShipTo_NAD)
LOC:1305 using 4 (goods
receipt place) code

Link to CLO CLOC CLO1

SHIPTODEPTNUM Link to (N1_ShipTo) REF02 Link to (ShipTo_NAD)
CTA:603

Does not apply.

REMITTONAME Link to (N1_RemitTo) N102 Link to (RemitTo_NAD)
NAD:510

Does not apply.

REMITTOADD1 Link to (N1_RemitTo) N301 Link to (RemitTo_NAD)
NAD:516

Does not apply.

REMITTOADD2 Link to (N1_RemitTo) N302 Link to (RemitTo_NAD)
NAD:517

Does not apply.

REMITTOCITY Link to (N1_RemitTo) N401 Link to (RemitTo_NAD)
NAD:519

Does not apply.

REMITTOSTATE Link to (N1_RemitTo) N402 Link to (RemitTo_NAD)
NAD:520

Does not apply.

REMITTO
POSTALCODE

Link to (N1_RemitTo) N403 Link to (RemitTo_NAD)
NAD:521

Does not apply.

BOLNUM Link to REF02 Link to RFF:1202 using BM
(bill of lading number) code

Link to ODD:2 DELN DEL0

SHIPDATE Link to DTM02 Link to DTM:2602 using 11
(despatch date/time) code

Link to ODD:2 DELN DEL1

TERMS_WHOLE Link to ITD03 Does not apply. Does not apply.

TERMSNETDUE Link to ITD07 Does not apply. Link to PYT PAYY PAY2

TERMSDISDUE Link to ITD05 Does not apply. Link to PYT PAYT

Comment Group Mapping Operations for Outbound Invoices
Each INVCommentGroup can occur up to:
v ANSI X12: once per document
v EDIFACT: 10 times per message
v TRADACOMS: 10 times per message

The ANSI X12 and EDIFACT application file first comment record layout for this
tutorial is as follows. This occurs once per document.

Field Name
Mapping Operations for
ANSI X12

Mapping Operations for
EDIFACT

BILLTOACCTCM1 No mapping required No mapping required

DOCTYPCM1 No mapping required No mapping required

INVNUMCM1 No mapping required No mapping required

REFNUM Link to N902 Link to FTX06 using INV
(invoice instruction) code
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The ANSI X12 and EDIFACT application file second comment record layout for
this tutorial is as follows. This occurs up to 10 times per ANSI X12 document or
once per EDIFACT message.

Field Name
Mapping Operations for
ANSI X12

Mapping Operations for
EDIFACT

BILLTOACCTCM2 No mapping required No mapping required

DOCTYPCM2 No mapping required No mapping required

INVNUMCM2 No mapping required No mapping required

MESSAGETEST Link to MSG01 Link to FTX07

The TRADACOMS application file comment record layout for this tutorial is as
follows. This occurs once per message.

Field Name Mapping Operations for TRADACOMS

BILLTOACCTCM2 No mapping required

DOCTYPCM2 No mapping required

INVNUMCM2 No mapping required

MESSAGETEST1 Link to DNA GNAR GNA0

MESSAGETEST2 Link to DNA GNAR GNA1

MESSAGETEST3 Link to DNA GNAR GNA2

MESSAGETEST4 Link to DNA GNAR GNA3

The application file detail record layout for this tutorial is as follows. This occurs
up to 200,000 times per document.

Field Name
Mapping Operations for
ANSI X12

Mapping Operations for
EDIFACT

Mapping Operations for
TRADACOMS

BILLTOACCT No mapping required No mapping required No mapping required

DOCTYPDET No mapping required No mapping required No mapping required

INVNUMDET No mapping required No mapping required No mapping required

ITEMNUM Link to IT101 Link to LIN01 Link to ILD:2 SEQB

QTYSHIP Link to IT102 Link to QTY:502 using 12
(despatch quantity) code

Link to ILD:2 QTYI QTY0
and use accum standard rule
to calculate extended price

QTYORD Link to QTY02 Link to QTY:602 using 21
(ordered quantity) code

Does not apply.

UNITPRICE Link to IT104 Link to MOA:1302 using 146
(unit price) code

Link to ILD:2 AUCT AUC0
and use accum standard rule
to calculate extended price

UOM Link to IT103 Link to QTY:503 and
QTY:603

Link to ILD:2 QTYI CD04:2
and ILD:2 AUCT CD04:3

CUSTPROCODE Link to IT107 Link to LIN03 using BP
(buyer’s part number) code

Link to ILD:2 CPRO CPR1

UPCCODE Link to IT109 Link to PIA:202 using UP
(UPC code) and 1
(additional information)
codes

Link to ILD:2 SPRO SPR1
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Field Name
Mapping Operations for
ANSI X12

Mapping Operations for
EDIFACT

Mapping Operations for
TRADACOMS

ITEMDESC Link to PID05 Link to IMD:306 Link to ILD:2 TDES TDE0

TERMSTYPE Link to ITD01 Does not apply. Does not apply.

TERMSDISP Link to ITD03 Does not apply. Does not apply.

VATCODE Does not apply. Does not apply. Extract Division lookup
from subtable VATCODES
and Link to ILD:2 CD12

TEMPVATRATE Does not apply. Does not apply. Standard rule to map
Division lookup from
subtable VATCODES

TEMPLEXC Does not apply. Does not apply. Use accum to extract
extended price and Link to
ILD:2 LEXC

The TRADACOMS application file temporary VAT storage record layout for this
tutorial is as follows. This occurs up to 10 times per message.

Field Name Mapping Operations for TRADACOMS

BILLTOACCTTS No mapping required

DOCTYPTS No mapping required

INVNUMTS No mapping required

SEQA Link to STL SEQA:7

VATRATE Link to STL VATP:2

VATRATECODE Link to STL CD12:2

NUMLINES Link to STL NRIL

LVLA Link to STL LVLA, STL EVLA, and STL ASDA

VATA Link to STL VATA

Summary Mapping Operations for Outbound Invoices
This table lists and describes the beginning record mapping operations (by
application field) that are required for the import map in this tutorial.This occurs
once per document.

Field Name
Mapping Operations�for
ANSI X12

Mapping Operations�for
EDIFACT

Mapping Operations�for
TRADACOMS

BILLTOACCTSUM No mapping required No mapping required No mapping required

DOCTYPSUM No mapping required No mapping required No mapping required

INVNUMSUM No mapping required No mapping required No mapping required

TOTALAMOUNT Link to TDS01 Link to MOA:1402 using 128
(total amount) code

Link to TLR TPSI

TRANSTOTAL Link to CTT01 Does not apply. Does not apply.

Cross-reference Tables
You must determine if you need code tables to convert map data. If you need code
tables, you must decide whether to create a code table in Sterling Gentran:Server
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that can only be used with this map or to add the table to either the partner
relationship or the internal system partner in Partner Editor.

In the Inbound Purchase Order tutorial, you need to map information from a
cross-reference table to translate your partner’s code for a purchased item to your
code for the same item. A cross-reference table is used when you and your partner
each reference an item by a different name (or number).

In the Outbound Invoices tutorial, you need to extract information from a lookup
table to be inserted into the outbound data. A lookup table is used when you want
to supplement data before it is sent to your partner.

The cross-reference table below is included in the tutorial data with the PETZONE
partner (INVATCO.LKP).

My Value Partner Value Description Reference Data

12345678901234 555666411 Large Dog Collar Red

23456789012345 555666817 Spring Breeze Cat Litter 10 lb or 5 kg Bag

34567890123456 555666908 Small Beef Basted
Rawhide Bones

Bag of 12

45678901234567 555666321 X-Large Food Bowl Black

56789012345678 555666287 FatKat Kitty Bed Blue with White Trim

67890123456789 555666413 Catnip Mouse Toy

Additional Information for TRADACOMS
Extended rules

To calculate the required VAT subtotals, summary, and invoice amount you will
need to use extended rules on the INPUT group (application file) and on certain
elements on the EDI side of the map. These extended rules will be explained in
detail later in this tutorial. You will also use a combination of standard rules
(accumulators) and direct mapping to complete the required calculations.

How to Map your Data

About Mapping
Each record in the import map contains a group of logically-related application
fields. These fields contain the information that your system needs to generate the
invoice. The group contains logically-related application records.

Each record (except the HEADER record that you defined for the system import
map using an explicit six-field key) contains a three-field record key that ensures
that the same identifying information is located at the beginning of each record.
Your application file format contains a record key so that each record can be
identified individually. The record key for this invoice consists of your partner's
bill to account number, the document type, and the invoice number.

HEADER Record
For the import map, you will not map from any of the fields in the HEADER
record. This record contains the five fields that comprise the key in the system
import map. However, because this header record is a part of your application file,
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it must be defined in the import map, as well. You did this when you copied the
HEADER record from the system import map to this import map. This header
record is mandatory and occurs only once.
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Chapter 3. System Import Map

Creating the System Import Map
For outbound translation, you must set up a system import map and an import
map. Generally, you create one system import map for each document type, and
set up an import map for each partner you are sending documents to.

About this task

A system import map is used by the system to find the partner relationship for a
document (flat file definition), to determine which import map is used to translate
the data. The system import map builds the key that the translator uses to find the
partner relationship. The sole function of the system import map is to identify the
appropriate partner relationship; the system import map does not map any data.

Use this procedure to create the system import map.

Procedure
1. Select File > New.

The system displays the New Map Wizard.
2. From the "What of map" list, select System Import Header.
3. In the "What is the name of the form" box, enter one of the following:

v HEADER (for ANSI X12)
v HEADER (for EDIFACT)
v HEADER_T (for TRADACOMS
The system adds the .MAP extension.

4. Verify that your name appears correctly in the "What is your name" box. and
click Next.
The system displays the New Map Wizard - Input Format dialog box.

Note: You need to complete the format of the Input side of the map. This is
the format of the data that is translated by the Sterling Gentran:Server system.

5. To create a new data format (for the input side) using this syntax list, select
Positional and click Next.
The system displays the New Map Wizard - Output Format dialog box.

6. To create a new data format (for the output side) using this syntax list, select
Positional and click Next.

7. Click Finish to create the new map (this may take a few seconds).
The system displays the new map in the Application Integration Window.

8. Select Edit > Details.
The system displays the Translation Object Details dialog box.
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9. In the Description field, type System Import HDR. We recommend that you
use the format System Import*, where * is the identifier for this system
import map. The Imports tab of the System Configuration program describes
which system import translation object will be used to begin translation
during the import process.

10. Complete the Major and Minor fields to designate a version number for this
translation object. Type 1 as the version number in the Major field and accept
the 0 as the release number in the Minor field.

Note: Whenever any major changes are made to your map, increase the
version to the next real number (for example, 2.0, 3.0). If you make a minor
change to the map, increase the version by a decimal (for example, 2.1, 2.2).

11. Click OK to save the translation object details.
12. Select File > Save.
13. Verify that the File name box contains Header.map (for ANSI X12 and

EDIFACT) or Header_t.map (for TRADACOMS).
14. Click Save to save the map.

Note: After you complete each section of this tutorial or when you make any
changes to the map, you should save the map.

Creating the HEADER Record
The only record that you define for the system import map is the header record.
The header record is subordinate to the icon on the input side of the map.

About this task

The HEADER record contains the five fields that comprise the system import map
key. This header record is mandatory and occurs only once.

Use this procedure to create the HEADER record.

Procedure
1. Right-click the Positional File icon (Output for an inbound map) and select

Create Sub > Record.
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2. In the Name box, type HEADER as the record identification code.
3. In the Desc box, type Header Record.
4. On the Tag tab, do the following:

v In the Tag box, type HDR as the record identification code <TAG>.
v In the Position box, accept the default of 1 as the starting column position of

the tag in the data record.
5. On the Looping tab, type 1 in the Min Usage box to make the header record

mandatory.
6. Click OK to create the HEADER record.

Defining the HEADER Fields
To use the preferred method of building the system import key, you need to define
at least five fields for the header record (partner key, standard, version, transaction,
and test/production status). These fields do not have to be in any order or
sequence, but they must be part of the header record.

About this task

After you define the header record and fields, you must set up the mapping
operations that define the key that the translator uses to find the partner
relationship.

Use this procedure to create the fields for the HEADER record.

Procedure
1. Right-click the HEADER record select Edit Fields.
2. The field you are creating is the first field record. Click New.
3. In the Name box, type PARTNER_ID, which is the name of the first field in

the HEADER record. Each field must have a unique name.
4. Select the Mandatory check box to identify it as a required field. For the

system import map, each field in the key is mandatory.
5. In the Description box, type Partner identifier.
6. From the Data Type list, select the appropriate type.

Notes:

v Select String if you want to specify that this field must contain
alphanumeric data.

v If the Data Type is Number or Dt/Tm, select the appropriate format from
the Format list.

7. In the Min Length box, type 1 as the minimum field length.
8. In the Max Length box, type 9 as the maximum length of the field.
9. To add the field and to create the next field positioned after it, press Enter.

10. Create the rest of the fields according to the Application File Header Layout
for Outbound Invoices.

11. After adding the last field, click Auto Position to automatically position the
field in the record. Click Yes to acknowledge the warning message that fields
are sequenced in order.
The Positional Field Editor dialog box should look like this:
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12. When you are finished with the HEADER record, click Close.

Note: If you press Enter after typing the information for the last field in the
record, a blank field is created. Click Delete and then Yes to delete the blank
field.

How to Define the Key

Defining the Partner Key
About this task

Use this procedure to define the partner key.

Procedure
1. Double-click the PARTNER_ID field to display the Field Properties dialog box.
2. Select the Standard Rule tab.
3. From the Standard Rule list, choose Select.
4. From the Table and Key list, select Partner by EDI Code. This indicates that the

system looks up the indicated partner key in the partner database and updates
this field.
The Standard Rule tab of the Field Properties dialog box should look like this:
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5. Click OK to add the standard rule to the partner key field.

Defining the EDI Standard Field
About this task

Use this procedure to define the EDI standard field.

Procedure
1. Double-click the STANDARD field to display the Field Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Update.
4. From the table list, choose Document record. This indicates that you wish to

store an item of data in the Sterling Gentran:Server tracking database for the
document.

5. From the column list, choose Agency.
6. Click OK to add the standard rule to the STANDARD field.

Defining the Version
About this task

Use this procedure to define the version.

Procedure
1. Double-click the VERSION field to display the Field Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Update.
4. From the table list, choose Document record.
5. From the column list, choose Version.
6. Click OK to add the standard rule to the VERSION field.

Defining the Transaction Set
About this task

Use this procedure to define the transaction set (document).

Chapter 3. System Import Map 41



Procedure
1. Double-click the TRANSACTION_SET field to display the Field Properties

dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Update.
4. From the table list, choose Document record.
5. From the column list, choose Transaction Set ID.
6. Click OK to add the standard rule to the TRANSACTION_SET field.

Defining the Test/Production Status Field
About this task

Use this procedure to define the test/production status field.

Procedure
1. Double-click the TEST_PROD field to display the Field Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Update.
4. From the table list, choose Document record.
5. From the column list, select Test Mode to update the release field.
6. Click OK to add the standard rule to the TEST_PROD field.

Defining the Application ID Field - TRADACOMS
About this task

Use this procedure to define the application ID field.

Procedure
1. Double-click the application ID field to display the Field Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Update.
4. From the table to update list, choose Document record.
5. From the column list, choose Application Field 1.
6. Click OK to add the standard rule to the application ID field.

Defining the Application Alias Value Field - TRADACOMS
About this task

Use this procedure to define the application alias value field.

Procedure
1. Double-click the application alias value field to display the Field Properties

dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Update.
4. From the table to update list, choose Document record.
5. From the Field list, select Application Field 2.
6. Click OK to add the standard rule to the application alias value field.
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Compiling the System Import Map
The Compile function compiles the map and generates a translation object. The
map that you created using the Application Integration subsystem is a source map.
When that source map is compiled, the result is a compiled translation object.

About this task

After you save the translation object, you must register it with Sterling
Gentran:Server before you can use it.

Use this procedure to compile a map and generate a translation object.

Procedure
1. Select File > Save to save the source map before compiling.
2. Select File > Compile.
3. Verify that the File name box contains either header.tpl or Header_t.tpl.
4. Navigate to where the compiled translation object is stored, if necessary.
5. Click Save. The system compiles the map and generates a translation object.

The Compile Error dialog box is displayed.
6. Verify that no errors occurred and click OK to exit the dialog box. The date on

which the translation object was compiled is automatically loaded into the
Compiled on box.
The Translation Object Details dialog box should look similar to the following.
(This is an ANSI X12 example; some details may be different for EDIFACT and
TRADACOMS.)

7. Select File > Save to save the source map with the Compiled on date.

Note: You must register this translation object with the Sterling Gentran:Server
system before you can use it.
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Printing the System Import Map Report
The Sterling Gentran:Server report enables you to validate, review the map, and
make modifications as needed. If you review the report and determine that the
map is incorrect, you should refine the mapping process as many times as
necessary (make the modifications, save the map, recompile the translation object,
and print the report again).

About this task

Use this procedure to print the report for the system import map.

Step

Action

Procedure
1. Select File > Print.
2. Accept the defaults on this dialog box so the report will include all sections

and only the activated map components.
3. Click OK.

The Print dialog box is displayed.
4. Click OK on the Print dialog box and the mapping report is printed.

Testing the System Import Translation Object
After you compile the map, print and verify the report, and register the translation
object with Sterling Gentran:Server, you should test the translation object to verify
that the data is translated correctly.

Procedure

You test the system import translation object (HEADER.TPL or HEADER_T.TPL)
when you test the import translation object.
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Chapter 4. Import Map

Creating the Import Map
The first task in creating a new map is to define the format for the input and
output sides of the map.

About this task

In this example, you are creating an import map so Sterling Gentran:Server can
translate your application file to an invoice that you are sending to your partner.
Therefore, the input side of the map needs to reflect your application file. The
output side of the map needs to reflect the invoice that you send to your partner.
Instead of defining the document in the system yourself, you want Sterling
Gentran:Server to use the standards database on your system to build the invoice
according to the standard.

Use this procedure to create the import map for the outbound invoice.

Procedure
1. Select File > New.

The system displays the New Map Wizard.
2. From the "What kind of map" list, select Import.
3. In the "What is the name of map" box, enter one of the following:

v PET_801 (for ANSI X12)
v PET_EINV (for EDIFACT)
v PET_TINV (for TRADACOMS)

Note: The system adds the .MAP extension.
4. Verify that your name appears correctly in the "What is your name" box and

click Next.

The system displays the New Map Wizard - Input Format dialog box.

Note: You need to complete the format of the Input side of the map. This is
the format of the data that is translated by the Sterling Gentran:Server system.

5. To create a new data format (for the input side) using this syntax list, select
Positional and click Next.
The system displays the New Map Wizard - Output Format dialog box.

6. To create a new data format (for the output side) using this syntax list, select
Delimited EDI and click Customize.
The system displays the New Delimited EDI Wizard.

7. Click Next.
8. From the ODBC data source list, select Gentran Standards (if you defined

your EDI standards data source with another name, select that name) and
click Next.

9. For ANSI X12, select one of the following and click Next:
v [X] X12 standards agency
v [003030] ANSI X12 VERSION 3 Release 3 version
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v {810] INVOICE transaction set
10. For EDIFACT, select one of the following and click Next:

v Select the [E] Edifact standards agency
v [092001] EDIFACT Release 1 (92.1) version
v [INVOIC] INVOICE MESSAGE transaction set

11. For TRADACOMS, select one of the following and click Next:
v [A] TRADACOMS standards agency
v [ANA001 TRADACOMS UNITED KINGDOM version
v [INVOIC] INVOICE DETAILS transaction set
v 9 release

12. Click Finish.
The system loads the selected transaction set and returns to the New Map
Wizard - Output Format dialog box.

13. Click Next.
The system displays the New Map Wizard.

14. Click Finish to create the new map (this may take a few seconds).
The system displays the new map in the Application Integration Window.

Note: After you finish creating and saving a new map, you need to define the
Input and Output sides of the map. The steps you take are different,
depending on whether the map is an Import, System Import, Export, or
Turnaround map.

15. Select Edit > Details.
The Translation Object Details dialog box should look similar to the following.
(This is an ANSI X12 example; some details will be different for
TRADACOMS.)

16. In the Description field, enter one of the following:
v PET X 3030 810 Import (for ANSI X12)
v PET E 92.1 INVOIC Import (for EDIFACT)
v PET T ANA001 9 INVOICE Import (for TRADACOMS)

17. Complete the Major and Minor fields to designate a version number for this
translation object. Type 1 as the version number in the Major field and accept
the 0 as the release number in the Minor field.
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Note: Whenever any major changes are made to your map, increase the
version to the next real number (for example, 2.0, 3.0). If you make a minor
change to the map, increase the version by a percentage point (for example,
2.1, 2.2).

18. Click OK to save the translation object details.
19. Select File > Save.

The system displays the Save As dialog box.
20. Verify that the File name box contains one of the following:

v pet_810.map (for ANSI X12)
v pet_einv.map (for EDIFACT)
v pet_tinv.map (for TRADACOMS)

21. Click Save.

Note: After you complete each section of this tutorial or when you make any
changes to the map, you should save the map by selecting Save from the File
menu.

Activating the EDI Map Components
About this task

Use this procedure to activate the required conditional groups, segments, and
elements.

Procedure
1. Double-click the segments and groups listed in the tables in Analysis of the

Customer EDI File for Outbound Invoices to open them. These are the groups,
subgroups, segments and elements that you must activate. Opening all
necessary segments and groups before you start to activate allows you to scroll
down the map and activate the segments and elements sequentially.

Note: When you activate a group or segment, the mandatory subordinate
segments and elements are automatically activated.

2. Click Activate on the Main Toolbar.
3. Click each inactive group that you need to use. This activates the groups.

Note: If you click a group, segment, or element that you did not mean to
activate, right-click it and select Deactivate.

4. Click each inactive segment that you need to use. This activates the segments.
5. Click each inactive element that you need to use. This activates the elements.
6. Once you have activated all the necessary groups, segments, and elements,

click Activate on the Main Toolbar to turn activation mode off.
7. Select View > Show Active Only.

Defining Literal Constants - ANSI X12, EDIFACT
About this task

Use this procedure to create the literal constants that are used in the import map
for this tutorial.
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Procedure
1. Select Edit > Constants.
2. Click New to display the Edit Constant dialog box.
3. In the ID box, type the name of the first literal constant identifier in the table.

v BILL_OF_LADING (for ANSI X12)
v Invoice Date/Time (for EDIFACT)

4. From the Type list, select String as the category of this literal constant.
5. In the Value box, type the actual constant expression. This is the value of the

literal constant.
v BM (for ANSI X12)
v 3 (for EDIFACT)

6. Click OK to add the constant to the system.
7. Repeat steps 2 – 6 to create the rest of the constants, according to the tables in

Constants .
8. Click Close to exit the Map Constants dialog box.

Mapping the UNS01 Element - EDIFACT
The UNS segment contains the section control information. Both the UNS segment
and the UNS01 element are mandatory. Since you are creating an outbound
(import) map, you must map data to the UNS01 element. Because this data is not
part of your application file, you must use a constant to map the appropriate data
to this element. You have already defined all the constants that you will use for
this map.

About this task

Use this procedure to map the mandatory data to the UNS01 element.

Procedure
1. Double-click the UNS01 element (Section Identification) in the UNS segment to

display the Element Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select the S constant (summary), to identify the UNS01

element as the summary section control.
5. Click OK. The S code is loaded in the Section Identification element.

Promote Groups and Repeating Segments - EDIFACT
The Promote function extracts one iteration (instance) of a group or repeating
segment. This enables you to map unique data from your application file and enter
a specialized definition. Only one-to-one (no loops) or many-to-many (loops)
mapping relationships are valid.

Promote is a specialized function that guarantees the integrity of your EDI
structure. You must promote several groups and repeating segments. You must
also enter a specialized definition for each group you promote so that you can
easily differentiate between the multiple instances of a group. You decide that the
naming convention that Sterling Gentran:Server uses for multiple instances of the
same segment is sufficient and you do not need to enter specialized definitions for
the segments you promote.
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Note: If a segment/record or element/field occurs more than once in a map, it is
identified by its name <ID>. Subsequent occurrences are identified by <ID>:n,
where n is the number of the occurrence in the map.

Promoting the DTM Segment
The DTM segment contains the date and time information for the map header and
repeats up to 35 times. You must extract one iteration of the DTM segment so you
can map the INVDATE field, which is in the INVBEGIN record that repeats once,
to the DTM segment.

About this task

Use this procedure to promote one iteration of the DTM segment.

Procedure
1. Right-click the DTM segment and select Promote to extract one iteration of the

DTM segment.
The new iteration is named DTM:22 and is located directly above the DTM
segment.

2. Right-click the original DTM segment and select Deactivate to deactivate the
DTM segment (which now repeats 34 times) so the system will not process it.

Promoting the RFF Group and Adding Specialized Definitions
The RFF group contains reference information and repeats up to 10 times. You
must extract two, singly occurring instances of the RFF group so you can map the
purchase order number and date and the bill of lading number and ship date from
the INVBEGIN record (which repeats once). You must add a specialized definition
to each group you promote so you can easily differentiate between the two
instances of the RFF group.

About this task

Use this procedure to promote two iterations of the RFF group and add specialized
definitions.

Procedure
1. Right-click the 0100_RFF group and select Promote to extract one iteration of

the RFF group.
The new iteration is named 0100_RFF:2 and is located directly above the
0100_RFF group.

2. Right-click the 0100_RFF group (which now repeats nine times) and select
Promote to extract one iteration of the RFF group.
The new iteration is named 0100_RFF:3 and is located directly above the
0100_RFF group.

3. Right-click the original 0100_RFF group and select Deactivate to deactivate the
0100_RFF group, which now repeats eight times.

4. Right-click the 0100_REF:2 group and select Properties.
5. In the Name box, type PONUM_RFF, which is a specialized definition that

identifies this group as containing purchase order number information.
6. Click OK to save the change and exit the Group Properties dialog box.
7. Right-click the 0100_REF:3 group and select Properties.
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8. In the Name box, type BOL_REF, which is a specialized definition that
identifies this group as containing bill of lading information.

9. Click OK to save the change and exit the Group Properties dialog box.

Promoting the DTM:23 Segment
The DTM:23 segment (in the PONUM_RFF group) contains the date and time
information for the purchase order number reference and repeats up to five times.
You must extract one iteration of the DTM:23 segment so you can map the
PODATE field (which is in the INVBEGIN record that repeats once) to the DTM:23
segment.

About this task

Use this procedure to promote one iteration of the DTM:23 segment.

Procedure
1. Right-click the DTM:23 segment in the PONUM_RFF group and select Promote

to extract one iteration of the DTM:23 segment.
The new iteration is named DTM:25 and is located directly above the DTM:23
segment.

2. Right-click the original DTM:23 segment and select Deactivate to deactivate the
DTM:23 segment, which now repeats four times.

Promoting the DTM:24 Segment
The DTM:24 segment in the BOL_RFF group contains the date and time
information for the bill of lading reference and repeats up to five times. You must
extract one iteration of the DTM:24 segment so you can map the SHIPDATE field
(which is in the INVBEGIN record that repeats once) to the DTM:24 segment.

About this task

Use this procedure to promote one iteration of the DTM:24 segment.

Procedure
1. Right-click the DTM:24 segment (in the BOL_RFF group) and select Promote to

extract one iteration of the DTM:24 segment.
The new iteration is named DTM:26 and is located directly above the DTM:24
segment.

2. Right-click the original DTM:24 segment and select Deactivate to deactivate the
DTM:24 segment, which now repeats four times.

Promoting the NAD Group and Adding Specialized Definitions
The NAD group contains name and address information and repeats up to 20
times. You cannot map from a non-repeating record (INVBEGIN) to a repeating
group (NAD). To map vendor, shipping, and remittance information from your
application file format, you must extract three single iterations of the NAD group
so the links between the application fields in the INVBEGIN record and the NAD
groups are valid. You must also add a specialized definition to each group you
promote so you can easily differentiate between the three instances of the NAD
group.
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About this task

Use this procedure to promote three iterations of the NAD group and add
specialized definitions.

Procedure
1. Right-click the 0200_NAD group and select Promote to extract one iteration of

the NAD group.
The new iteration is named 0200_NAD:2 and is located directly above the
0200_NAD group.

2. Right-click the 0200_NAD group, which now repeats 19 times, and select
Promote to extract one iteration of the NAD group.
The new iteration is named 0200_NAD:3 and is located directly above the
0200_NAD group.

3. Right-click the 0200_NAD group, which now repeats 18 times, and select
Promote to extract one iteration of the NAD group.
v

4. Right-click the 0200_NAD:2 group and select Properties.
5. In the Name box, type Vend_NAD, which is a specialized definition that

identifies this group as containing vendor information.
6. Click OK to save the change and exit the Group Properties dialog box.
7. Right-click the 0200_NAD:3 group and select Properties.
8. In the Name box, type ShipTo_NAD, which is a specialized definition that

identifies this group as containing shipping information.
9. Click OK to save the change and exit the Group Properties dialog box.

10. Right-click the 0200_NAD:4 group and select Properties.
11. In the Name box, type RemitTo_NAD, which is a specialized definition that

identifies this group as containing shipping information.
12. Click OK to save the change and exit the Group Properties dialog box.
13. Double-click the Vend_NAD group and the RemitTo_NAD group to open

them.
14. Click Deactivate on the Main Toolbar. Click the original 0200_NAD group,

which now repeats 17 times.
15. In the Vend_NAD group, click the LOC:10 segment and the 0500_CTA:2

group.
16. In the RemitTo_NAD group, click the LOC:12 segment and the 0500_CTA:4

group.
17. Click Deactivate on the Main Toolbar to turn off Deactivation mode.

Promoting the LOC:11 Segment
The LOC:11 segment (in the ShipTo_NAD group) contains the shipping location
information and repeats up to 25 times. You must extract one iteration of the
LOC:11 segment so you can map the SHIPTOLOC field (which is in the INVBEGIN
record that repeats once) to the LOC:11 segment.

About this task

Use this procedure to promote one iteration of the LOC:11 segment.
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Procedure
1. Right-click the LOC:11 segment (in the ShipTo_NAD group) and select Promote

to extract one iteration of the LOC:11 segment.
The new iteration is named LOC:13 and is located directly above the LOC:11
segment.

2. Right-click the original LOC:11 segment and select Deactivate to deactivate the
LOC:11 segment, which now repeats 24 times.

Promoting the CTA:3 Group
The CTA:3 group (in the ShipTo_NAD group) contains the contact information and
repeats up to five times. You must extract one iteration of the CTA:3 group so you
can map the SHIPTODEPTNUM field (which is in the INVBEGIN record that
repeats once) to the CTA:3 group.

About this task

Use this procedure to promote one iteration of the CTA:3 group.

Procedure
1. Right-click the CTA:3 group (in the ShipTo_NAD group) and select Promote to

extract one iteration of the CTA:3 group.
The new iteration is named CTA:5 and is located directly above the CTA:3
group.

2. Right-click the original CTA:3 group and select Deactivate to deactivate the
CTA:3 group, which now repeats four times.

Promoting the PIA Segment
The PIA segment (in the LIN group) contains additional product information and
repeats up to 25 times. You must extract one iteration of the PIA segment so you
can map your UPC code for the line item.

About this task

Use this procedure to promote one iteration of the PIA segment.

Procedure
1. Right-click the PIA segment and select Promote to extract one iteration of the

PIA segment.
The new iteration is named PIA:2 and is located directly above the PIA
segment.

2. Right-click the original PIA segment (that now repeats 24 times) and select
Deactivate to deactivate the PIA segment.

Promoting the IMD:2 Segment
The IMD:2 segment (in the LIN group) contains the Item description information
and repeats up to ten times. You must extract one iteration of the IMD:2 segment
so you can map the item description for the line item.

About this task

Use this procedure to promote one iteration of the IMD:2 segment.
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Procedure
1. Right-click the IMD:2 segment and select Promote to extract one iteration of

the IMD:2 segment.
The new iteration is named IMD:3 and is located directly above the IMD:2
segment.

2. Right-click the original IMD:2 segment (which now repeats nine times) and
select Deactivate to deactivate the IMD:2 segment.

Promoting the QTY:2 Segment
The QTY segment contains the quantity information and repeats up to five times.
You must extract two iterations of the QTY:2 segment so you can store the quantity
shipped and the quantity ordered.

About this task

Use this procedure to promote two iterations of the QTY:2 segment.

Procedure
1. Right-click the QTY:2 segment and select Promote to extract one iteration of the

QTY:2 segment.
The new iteration is named QTY:5 and is located directly above the QTY:2
segment.

2. Right-click the original QTY:2 segment, which now repeats four times, and
select Promote to extract one iteration of the QTY:2 segment.
The new iteration is named QTY:6 and is located directly above the QTY:2
segment.

3. Right-click the original QTY:2 segment and select Deactivate to deactivate the
QTY:2 segment, which now repeats three times.

Promoting the MOA Group
The MOA group in the detail section of the map (LIN group) contains the line item
unit price information and repeats up to five times. You must extract one iteration
of the MOA group so you can map the unit price to the MOA group. Since you are
only extracting one instance of the MOA group and then deactivating the original
group, you do not need to add a specialized definition to the new iteration of the
group.

About this task

Use this procedure to promote one iteration of the MOA group.

Procedure
1. Right-click the 2300_MOA group (in the LIN group) and select Promote to

extract one iteration of the MOA group.
The new iteration is named 2300_MOA:2 and is located directly above the
2300_MOA group.

2. Right-click the original 2300_MOA group and select Deactivate to deactivate
the 2300_MOA group, which now repeats four times.
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Promoting the CNT Segment
The CNT segment contains the control total information and repeats up to 10
times. You must extract two iterations of the CNT segment so you can store the
total number of line items and the total quantity invoiced.

About this task

Use this procedure to promote two iterations of the CNT segment.

Procedure
1. Right-click the CNT segment and select Promote to extract one iteration of the

CNT segment.
The new iteration is named CNT:2 and is located directly above the CNT
segment.

2. Right-click the original CNT segment (that now repeats nine times) and select
Promote to extract one iteration of the CNT segment.
The new iteration is named CNT:3 and is located directly above the CNT
segment.

3. Right-click the original CNT segment and select Deactivate to deactivate the
CNT segment, which now repeats eight times.

Promoting the MOA Group
The MOA group in the summary section of the map contains the total monetary
amount information for the and repeats up to 100 times. You must extract one
iteration of the MOA group so you will be able to map the TOTALAMOUNT field
(which is in the INVSUMMARY record that repeats once), to the MOA group.
Since you are only extracting one instance of the MOA group (and will then
deactivate the original group), you do not need to add a specialized definition to
the new iteration of the group.

About this task

Use this procedure to promote one iteration of the MOA group.

Procedure
1. Right-click the 4500_MOA group and select Promote to extract one iteration of

the MOA group.
The new iteration is named 4500_MOA:2 and is located directly above the
4500_MOA group.

2. Right-click the original 4500_MOA group and select Deactivate to deactivate
the 4500_MOA group, which now repeats 99 times.

Verifying EDI Delimiters for Outbound Invoices
If you are using an EDI standard that contains composite elements or subelements,
you must verify that Sterling Gentran:Server is specifying the correct EDI
delimiters. Delimiters are flags that you define to the system as separating specific
EDI components. Delimiters are necessary for all variable field-length standards,
because the data is compressed (and the leading zeroes and trailing blanks are
removed). Since the fields vary in length, the system needs a flag to determine
where one element ends and another begins. For example, an element delimiter
marks the beginning of a new element.
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About this task

Although verifying EDI delimiters in Sterling Gentran:Server is mandatory only if
you are using a standard with composite elements or subelements, we recommend
that perform this task regardless of which standard you use.

Use this procedure to verify EDI delimiters.

Procedure
1. Right-click one of the following and select Properties:

v 810 INVOICE (for ANSI X12)

v INVOIC INVOICE MESSAGE (for EDIFACT)
v INVOIC INVOICE DETAILS EDI (for TRADACOMS)

2. Select the Delimiters tab.
The system displays the delimiter settings.

3. Verify the required delimiters for your standard (see Default Delimiter Values).
If the delimiters differ, type either the character or the hexadecimal value in the
correct box.

4. Click OK to exit the File Properties dialog box.

Application File Format

About the Application File Format in Outbound Invoices
At this point, you have already defined the header record (in the system import
map) that you can copy and use in your import map. Now you must define the
rest of your application file to Sterling Gentran:Server. In the import map, the
input side of the map is positional. Your application file must contain all the
information that you need to generate the EDI document that you are sending to
your partner.

Before you define your application file format, you should obtain a layout of the
necessary records, fields, and groups. The records contain related fields and the
groups contain related records. Each level of your application file format must be
created sequentially.

For example, your application file format contains records and groups. The records
contain fields and the group contains records. This means that you must create
records and the group before you create the subordinate fields and records.

Copying the HEADER Record
Because you have already defined the header record for your application file
format in the system import map, you can copy that header record to the import
map. The copied record contains subordinate fields, which is also be copied.
Copied map components retain all the information of the original map component,
so you must remove the standard rules you created for the fields in the header
record for the system import map.

About this task

Use this procedure to copy the HEADER record from the system import map to
the import map.
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Procedure
1. Open the system import map, if it is not already open.
2. Click the HEADER record and click Copy on the Main Toolbar.
3. Open the import map, if it is not already open.
4. Click the INPUT positional file icon that you want the copied record pasted

after.
5. From the Main Toolbar, click Paste.

The HEADER record is pasted as a subordinate map component to the INPUT
positional file icon.

Removing Standard Rules from the Header Record
In the HEADER record that you just copied from the system import map , the first
field (PARTNER_ID) has a Select standard rule applied to it in the system import
map. The remaining fields in the copied HEADER record in the import map have
Update standard rules applied to them in the system import map. These standard
rules are not applicable to the import map, so you must remove them.

About this task

Use this procedure to remove the standard rules from the HEADER record in the
import map.

Procedure
1. Double-click the PARTNER_ID field in the HEADER record to display the

Field Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select <none> to remove the standard rule.
4. Depending on how you set the confirmation options on the Preferences dialog

box (Confirmations tab), the system may prompt you to confirm removal of the
standard rule from the field. If so, click Yes to remove the standard rule.

5. Click OK to save the change to the field.
6. Do one of the following:

v For ANSI X12 and EDIFACT: Repeat steps 1 - 5 for the STANDARD,
VERSION, TRANSACTION_SET, and TEST_PROD fields.

v For TRADACOMS: Repeat steps 1 - 5 for the APPL_ID and
APPL_ALIAS_VALUE fields.

Creating the INVBEGIN Record
The second record in your application file format you need to create INVBEGIN is
at the same level as the HEADER record.

About this task

The INVBEGIN record contains the purchase order number and date; the vendor,
shipping and remit to address information; and the bill of lading number, ship
date, and terms of the invoice. The beginning record is mandatory and occurs once
for each invoice.

Use this procedure to create the INVBEGIN record.
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Procedure
1. Click the HEADER record and select Edit > Insert > Record.

Note: Select Edit > Insert to create equal records/groups and select Edit >
Create Sub to create subordinate groups/records/fields.

2. In the Name box, type INVBEGIN as the record identification code.
3. In the Desc box, type Beginning Record.
4. On the Tag tab, do the following:

v In the Tag box, type BEG as the record identification code <TAG>.
v In the Position box, accept the default of 1 for the staring column position of

the tag in the data record.
5. On the Looping tab, type 1 in the Min Usage box to make the record

mandatory.
6. Click OK to create the INVBEGIN record.

Creating the INVCommentGroup
The INVCommentGroup (comment information) groups all the comment
information for the invoice, including the reference number and the message text.
The INVCommentGroup occurs once per invoice (for ANSI X12) or up to ten times
(for TRADACOMS). The information within the INVCommentGroup is further
segregated by related records.

About this task

Use this procedure to create the INVCommentGroup.

Procedure
1. To create a group that is at the same level as the INVBEGIN record, click the

INVBEGIN record and select Edit > Insert > Group.
The Group Properties dialog box is displayed.

2. In the Name box, type INVCommentGroup to indicate that this group contains
all of the comment records. This is the segment loop identification code.

3. In the Description box, type Comment Group.
4. On the Looping tab, type 1 in the Minimum Usage box to make the loop

mandatory.
5. Do one of the following:

v For ANSI X12: Accept the default of 1 in the Maximum Usage box. This
indicates that this group of records occurs only once.

v For EDIFACT and TRADACOMS: In the Maximum Usage box, type 10. This
indicates that this group of records will occur up to ten times.

6. Click OK to create the INVCommentGroup.

INVCommentGroup Subordinate Records - ANSI X12 and
EDIFACT

Creating the INVCOMMENT1 Record
The INVCOMMENT1 (first comment) record contains the reference number. The
first comment record is mandatory and occurs once per invoice translated (once for
each comment line).
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About this task

Use this procedure to create the INVCOMMENT1 record.

Procedure
1. Click the INVCommentGroup and select Edit > Create Sub > Record.
2. In the Name box, type INVCOMMENT1 as the record identification code.
3. In the Desc box, type Header Comment Record 1.
4. On the Tag tab, do the following:

v In the Tag box, type CM1 as the record identification code <TAG>.
v In the Position box, accept the default of 1 for the starting column position of

the tag in the data record.
5. On the Looping tab, type 1 in the Min Usage box to make the record

mandatory.
6. Click OK to create the INVCOMMENT1 record.

Creating the INVCOMMENT2 Record
The INVCOMMENT2 (second comment) record contains message text. The second
comment record is mandatory. For ANSI X12, it occurs up to ten times per invoice
translated (once for each comment line). For EDIFACT, it occurs once per invoice
translated (once for each comment line).

About this task

Use this procedure to create the INVCOMMENT2 record.

Procedure
1. Click the INVCOMMENT1 record and select Edit> Insert > Record.
2. In the Name box, type INVCOMMENT2 as the record identification code.
3. In the Desc box, type Header Comment 2.
4. On the Tag tab, do the following:

v In the Tag box, type CM2 as the record identification code <TAG>.
v In the Position box, accept the default of 1 as the starting column position of

the tag in the data record.
5. On the Looping tab, type 1 in the Min Usage box to make the record

mandatory.
6. Do one of the following:

v For ANSI X12: In the Max Usage box, type 10 as the maximum number of
times the record can repeat.

v For EDIFACT: Accept the default of 1 in the Max Usage box so this record
only occurs once (not a looping structure).

7. Click OK to create the INVCOMMENT2 record.

Creating the INVCOMMENT Record - TRADACOMS
The INVCOMMENT (comment record) record contains the message text. The first
comment record is mandatory and occurs once per invoice translated (once for
each comment line).

About this task

Use this procedure to create the INVCOMMENT record.
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Procedure
1. Click the INVCommentGroup and select Edit > Create Sub > Record.
2. In the Name box, type INVCOMMENT as the record identification code.
3. In the Desc box, type Invoice Comment Record 1.
4. On the Tag tab, do the following:

v In the Tag box, type CMT as the record identification code <TAG>.
v In the Position box, accept the default of 1 for the starting column position of

the tag in the data record.
5. On the Looping tab, type 1 in the Min Usage box to make the record

mandatory.
6. Click OK to create the INVCOMMENT record.

Creating the INVDETAIL Record
The INVDETAIL (detail) record is at the same level as the HEADER and
INVBEGIN records and the INVCommentGroup.

About this task

The INVDETAIL record contains line item number and description, quantity
shipped, quantity ordered, unit of measure, price, product code, and invoice terms.
The detail record is mandatory and occurs up to 200,000 times per invoice
translated (once for each line item invoiced).

Use this procedure to create the INVDETAIL record.

Procedure
1. Click the INVCommentGroup and select Edit > Insert > Record.
2. In the Name box, type INVDETAIL as the record identification code.
3. In the Desc box, type Detail Record.
4. On the Tag tab, do the following:

v In the Tag box, type DET as the record identification code <TAG>.
v In the Position box, accept the default of 1 as the starting column position of

the tag in the data record.
5. On the Looping tab, do the following:

v In the Min Usage box, type 1 to make the record mandatory.
v In the Max Usage box, type 200000 as the maximum number of times the

record can repeat.
6. Click OK to create the INVDETAIL record.

Creating the TEMPVATSTL Record - TRADACOMS
The TEMPVATSTL (Temporary Storage VAT Subtotals) record is at the same level
as the HEADER, INVBEGIN, and INVDETAIL records and the
INVCommentGroup.

About this task

The TEMPVATSTL (temporary storage for VAT subtotals) record contains
temporary storage fields to enable VAT subtotal calculations. The temporary
storage record is conditional and occurs up to 20 times per invoice translated (once
for each possible VAT code subtotal).
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Use this procedure to create the TEMPVATSTL record.

Procedure
1. Click the INVDETAIL record and select Edit > Insert > Record.
2. In the Name box, type TEMPVATSTL as the record identification code.
3. In the Desc box, type Temporary Storage VAT Subtotals.
4. On the Tag tab, do the following:

v In the Tag box, type $$$ as the record identification code <TAG>.
v In the Position box, accept the default of 1 as the starting column position of

the tag in the data record.
5. On the Looping tab, do the following:

v In the Min Usage box, accept the default of 0 to make the record conditional.
v In the Max Usage box, type 20 as the maximum number of times the record

can repeat.
6. Click OK to create the TEMPVATSTL record.

Creating the INVSUMMARY Record
The INVSUMMARY (summary) record contains the total invoice amount and the
total transaction amount. The summary record is mandatory and occurs once per
invoice translated.

About this task

Use this procedure to create the INVSUMMARY record.

Procedure
1. Click one of the following records and select Edit > Insert > Record.

v INVDETAIL (for ANSI X12 and EDIFACT)
v TEMPVATSTL (for TRADACOMS)

2. In the Name box, type INVSUMMARY as the record identification code.
3. In the Desc box, type Summary Record.
4. On the Tag tab, do the following:

v In the Tag box, type SUM as the record identification code <TAG>.
v In the Position box, accept the default of 1 as the starting column position of

the tag in the data record.
5. On the Looping tab, do the following:

v In the Min Usage box, type 1 to make the record mandatory.
v Accept the default of 1 in the Max Usage box.

6. Click OK to create the INVSUMMARY record.
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Current Map Structure
ANSI X12 Map

The following example shows the ANSI X12 application (input) side of the map.

EDIFACT Map

The following example shows the EDIFACT application (input) side of the map.

TRADACOMS Map

The following example shows the TRADACOMS application (input) side of the
map.

Application Fields

About Application Fields in Outbound Invoices
Each record you create contains a group of logically-related application fields.
These fields define the structure and content of the data that your system needs to
process the invoice.

The easiest way to add application fields to a record is to use the Positional Field
Editor. Generally, you create the fields for each sequential record, starting with the
INVBEGIN record.
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Creating the INVBEGIN Record Application Fields
You created the fields for the HEADER record in the system import map, copied
the fields to the import map, and removed the standard rules from those fields.
Therefore, the first record for which you need to define fields is the INVBEGIN
record.

About this task

Use this procedure to create the application fields for the INVBEGIN record.

Procedure
1. Right-click the INVBEGIN application record and select Edit Fields.
2. If the field you are creating is the first field in the record, click New.
3. In the Name box, type BILLTOACCTBEG, which is the name of the first field

in the INVBEGIN record.
4. Select the Mandatory check box to identify it as a required field.
5. In the Description box, type Bill To Account Number.
6. From the Data Type list, select the appropriate type.

Notes:

v Select String if you want to specify that this field must contain
alphanumeric data.

v If the Data Type is Number or Dt/Tm, select the appropriate format from
the Format list.

7. In the Min Length box, type 1 as the minimum field length. If the minimum
length of the field is 0, then accept that default in the Min length box.

8. In the Max Length box, type 9 as the maximum length of the field.
9. To add the field and create the next field positioned after it, press Enter.

10. Create the rest of the fields according to the Application File Beginning Record
Layout for Outbound Invoices .

11. After adding the last field, click Auto Position to automatically position the
fields in the record. Click Yes to acknowledge the warning message that fields
are sequenced in order.
The Positional Field Editor dialog box should look similar to the following.
(This is an ANSI X12 example; some details may be different for EDIFACT
and TRADACOMS.)
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12. When you are finished with the INVBEGIN record, click Close.

Creating the INVCOMMENT1 Record Application Fields - ANSI
X12, EDIFACT

About this task

Use this procedure to create the application fields for the INVCOMMENT1 record.

Procedure
1. Right-click the INVCOMMENT1 application record and select Edit Fields.
2. If the field you are creating is the first field in the record, click New.
3. In the Name box, type BILLTOACCTCM1, which is the name of the first field

in the INVCOMMENT1 record.
4. Select the Mandatory check box to identify it as a required field.
5. In the Description box, type Bill To Account Number.
6. From the Data Type list, select the appropriate type.

Notes:

v Select String if you want to specify that this field must contain
alphanumeric data.

v If the Data Type is Number or Dt/Tm, select the appropriate format from
the Format list.

7. In the Min Length box, type 1 as the minimum field length. If the minimum
length of the field is 0, then accept that default in the Min Length box.

8. In the Max Length box, type 9 as the maximum length of the field.
9. To add the field and to create the next field positioned after it, press Enter.

10. Create the rest of the fields according to the Application File Comment Group
Layout for Outbound Invoices .
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11. After adding the last field, click Auto Position to automatically position the
fields in the record. Click Yes to acknowledge the warning message that fields
are sequenced in order.

12. When you are finished with the INVCOMMENT1 record, click Close.

Creating the INVCOMMENT2 Record Application Fields - ANSI
X12, EDIFACT

About this task

Use this procedure to create the application fields for the INVCOMMENT2 record.

Procedure
1. Right-click the INVCOMMENT2 application record and select Edit Fields.
2. If the field you are creating is the first field in the record, click New.
3. In the Name box, type BILLTOACCTCM2, which is the name of the first field

in the INVCOMMENT2 record.
4. Select the Mandatory check box to identify it as a required field.
5. In the Description box, type Bill To Account Number.
6. From the Data Type list, select the appropriate type.

Notes:

v Select String if you want to specify that this field must contain
alphanumeric data.

v If the Data Type is Number or Dt/Tm, select the appropriate format from
the Format list.

7. In the Min Length box, type 1 as the minimum field length. If the minimum
length of the field is 0, then accept that default in the Min Length box.

8. In the Max Length box, type 9 as the maximum length of the field.
9. To add the field and to create the next field positioned after it, press Enter.

10. Create the rest of the fields according to the Application File Comment Group
Layout for Outbound Invoices .

11. After adding the last field, click Auto Position to automatically position the
fields in the record. Click Yes to acknowledge the warning message that fields
are sequenced in order.

12. When you are finished with the INVCOMMENT2 record, click Close.

Creating the INVCOMMENT Record - TRADACOMS
The INVCOMMENT (comment record) record contains the message text. The first
comment record is mandatory and occurs once per invoice translated (once for
each comment line).

About this task

Use this procedure to create the INVCOMMENT record.

Procedure
1. Click the INVCommentGroup and select Edit > Create Sub > Record.
2. In the Name box, type INVCOMMENT as the record identification code.
3. In the Desc box, type Invoice Comment Record 1.
4. On the Tag tab, do the following:
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v In the Tag box, type CMT as the record identification code <TAG>.
v In the Position box, accept the default of 1 for the starting column position of

the tag in the data record.
5. On the Looping tab, type 1 in the Min Usage box to make the record

mandatory.
6. Click OK to create the INVCOMMENT record.

Creating the INVDETAIL Record Application Fields
About this task

Use this procedure to create the application fields for the INVDETAIL record.

Procedure
1. Right-click the INVDETAIL application record and select Edit Fields.
2. If the field you are creating is the first field in the record, click New.
3. In the Name box, type BILLTOACCTDET, which is the name of the first field

in the INVDETAIL record.
4. Select the Mandatory check box to identify it as a required field.
5. In the Description box, type Bill To Account Number.
6. From the Data Type list, select the appropriate type.

Notes:

v Select String if you want to specify that this field must contain
alphanumeric data.

v If the Data Type is Number or Dt/Tm, select the appropriate format from
the Format list.

7. In the Min Length box, type 1 as the minimum field length. If the minimum
length of the field is 0, then accept that default in the Min Length box.

8. In the Max Length box, type 9 as the maximum length of the field.
9. To add the field and to create the next field positioned after it, press Enter.

10. Create the rest of the fields according to the Application File Comment Group
Layout for Outbound Invoices .

11. After adding the last field, click Auto Position to automatically position the
fields in the record. Click Yes to acknowledge the warning message that fields
are sequenced in order.
The Positional Field Editor dialog box should look similar to the following.
(This is a TRADACOMS example; some details may be different for ANSI X12
and EDIFACT.)
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12. When you are finished with the INVDETAIL record, click Close.

Creating the TEMPVATSTL Record Application Fields -
TRADACOMS

About this task

Use this procedure to create the application fields for the TEMPVATSTL record.

Procedure
1. Right-click the TEMPVATSTL application record and select Edit Fields.
2. If the field you are creating is the first field in the record, click New.
3. In the Name box, type BILLTOACCTTS, which is the name of the first field

in the TEMPVATSTL record.
4. Click the Mandatory check box to identify it is a required field.
5. In the Description box, type Bill To Account Number.
6. From the Data Type list, select the appropriate type.

Notes:

v Select String if you want to specify that this field must contain
alphanumeric data.

v If the Data Type is Number or Dt/Tm, select the appropriate format from
the Format list.

7. In the Min Length box, type 1. This is the minimum number of characters for
this field. If the minimum length of the field is 0, then accept that default in
the Min Length box.

8. In the Max Length box, type 9 as the maximum length of the field.
9. To add the field and to create the next field positioned after it, press Enter.
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10. Create the rest of the fields according to Application File Summary Layout for
Outbound Invoices .

11. After adding the last field, click Auto Position to automatically position the
fields in the record. Click Yes to acknowledge the warning message that fields
will be sequenced in order.
The Positional Field Editor dialog box should now look like this:

12. When you are finished with the TEMPVATSTL record, click Close.

Creating the INVSUMMARY Record Application Fields
About this task

Use this procedure to create the application fields for the INVSUMMARY record.

Procedure
1. Right-click the INVSUMMARY application record and select Edit Fields.
2. If the field you are creating is the first field in the record, click New.
3. In the Name box, type BILLTOACCTSUM, which is the name of the first

field in the INVSUMMARY record.
4. Select the Mandatory check box to identify it as a required field.
5. In the Description box, type Bill To Account Number

6. From the Data Type list, select the appropriate type.

Notes:

v Select String if you want to specify that this field must contain
alphanumeric data.

v If the Data Type is Number or Dt/Tm, select the appropriate format from
the Format list.
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7. In the Min Length box, type 1 as the minimum number of characters for this
field. If the minimum length of the field is 0, then accept that default in the
Min Length box.

8. In the Max Length box, type 9 as the maximum length of the field.
9. To add the field and to create the next field positioned after it, press Enter.

10. Create the rest of the fields according to the Application File Summary Layout
for Outbound Invoices .
The Positional Field Editor dialog box should look similar to the following.
(This is a TRADACOMS example; some details may be different for ANSI X12
and EDIFACT.)

11. When you are finished with the INVSUMMARY record, click Close.
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Chapter 5. INVBEGIN Record

About the INVBEGIN Record
The INVBEGIN record contains the purchase order number and date, shipping and
billing address information, bill of lading number, ship date, and terms informatin.
The beginning record is mandatory and occurs once for each invoice.

The following fields are part of the application file format key. However, they do
not contain data that the system needs to use to generate the invoice and do not
need to be mapped:
v BILLTOACCTBEG field
v DOCTYPBEG field

INVNUMBEG Field

Mapping the Invoice Number
About this task

Do one of the following to map the invoice number.

Procedure
v For ANSI X12: Link the application field INVNUMBEG in the INVBEGIN

record to the BIG02 element in the BIG segment.
v For EDIFACT: Link the application field INVNUMBEG in the INVBEGIN record

to the BGM05 element in the BGM record.
v For TRADACOMS: Link the application field INVNUMBEG in the INVBEGIN

record to the IRF INVN element (Invoice Number) in the IRF segment.

Setting up the Document Name for the Outbound Invoice
You should set up a document name for this map.

About this task

Use this procedure to set up the Document Name for this Invoice.

Note: See Document names for more information.

Procedure
1. Double-click one of the following elements:

v BIG02 (0076) (for ANSI X12)
v BGM05 (for EDIFACT)
v IRF INVN (for TRADACOMS)

2. In the Element Properties dialog box, select the Standard Rule tab.
3. From the standard rule list, select Update.
4. From the table list, choose Document record.
5. From the column list, select Document Name.
6. Click OK to set up the document name.
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Mapping the INVDATE Field - ANSI X12 and TRADACOMS
About this task

For ANSI X12, you can map the INVDATE field directly to the BIG01 element.

For TRADACOMS, you can map the INVDATE field directly to both the IRF IVDT
(Date of Invoice) and IRF TXDT (Tax-Point Date) elements by using the Link
function, because both of these dates are the same.

Procedure
1. If the Linking function is not currently active, click Link.
2. For ANSI X12: Link the application field INVDATE in the INVBEGIN record to

the BIG01 element in the BIG segment.
Steps 3 through 6 apply only to TRADACOMS.

3. Click the application field INVDATE in the INVBEGIN record.
4. Click the IRF IVDT element (Date of Invoice).
5. Click the application field INVDATE in the INVBEGIN record again.
6. Click the IRF TXDT element (Tax-Point Date).

About the INVDATE Field - EDIFACT
On the EDI side of the map, the date information is contained in the DTM:22
segment. You must change the properties of the DTM:2202 element
(Date/Time/Period) to reflect the minimum and maximum length, the type, and
the format that your partner will send you.

Use the Link function to map the INVDATE field directly to the DTM:2202
(Date/Time/Period) element. If the DTM:2201 (Date/Time/Period Qualifier) is 3,
the DTM:22 segment contains the invoice date/time. You must map a constant to
the Date/Time/Period Qualifier and establish a qualifying relationship with the
Date/Time/Period. This enables you to specify that the Date/Time/Period element
contains the invoice date/time.

Complete the following tasks:
v Changing the Properties of the DTM:2202 Element
v Setting the Date/Time/Period Qualifier
v Mapping the Invoice Date

Changing the Properties of the DTM:2202 Element
You informed your partner that you will send six digits for the DTM:2202 element
(Date/Time/Period) and these six digits will be a Dt/Tm data type in the
YYMMDD format (two-digit year, two-digit month, and two-digit day). You must
change the minimum and maximum length, the type, and the format of the
DTM:2202 element.

About this task

Use this procedure to change the length of the DTM2202 element.

Procedure
1. Double-click the DTM:2202 element to display the Element Properties dialog

box.
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2. Select the Validation tab.
3. In the Minimum box, type 6 as the minimum length.
4. In the Maximum box, type 6 as the maximum length.
5. From the Type list, select Date/Time The system may prompt you with a

message that changing the field's data type will invalidate its format. If so, click
Yes to acknowledge the message and proceed.

6. From the Format list, select YYMMDD.

7. Click OK to exit the Element Properties dialog box.

Setting the Date/Time/Period Qualifier
You must map a constant to the Date/Time/Period Qualifier (DTM:2201 element)
and define a qualifying relationship with the Date/Time/Period (DTM:2202
element).

About this task

You have already defined all the constants that you will use for this map. Now
map the appropriate constant to the Date/Time/Period Qualifier element.

Use this procedure to set the Date/Time/Period Qualifier for the DTM:22 segment.

Procedure
1. Double-click the DTM:2201 element (Date/Time/Period Qualifier) in the

DTM:22 segment to display the Element Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select 3 (invoice date/time) to identify the DTM:2202

element as containing the invoice date and time.
5. From the Qualifies list, select 2380:2 DATE/TIME/PERIOD, to set up a

qualifying relationship with the DTM:2202 element.

Note: The Qualifies list contains only active elements in the same segment as
the qualifying element.

6. Click OK. The 3 code is loaded in the Date/TIme/Qualifier element. The
qualifying relationship between the DTM:2201 and the DTM:2202 elements is
established.

Mapping the Invoice Date
About this task

Use this procedure to map the invoice date.

Procedure

Link the application field INVDATE in the INVBEGIN record to the DTM:2202
element in the DTM:22 segment.

Mapping the PONUM Field
About this task

Use this procedure to map the PONUM field.
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Procedure
v For ANSI X12: Link the application field PONUM in the INVBEGIN record to

the BIG04 element in the BIG segment.

Note: We recommend that you set up a Document Reference for each map to
make message identification easier. Continue with “Setting up the Document
Reference - ANSI X12 and EDIFACT” on page 73.

v For EDIFACT: Link the PONUM field directly to the RFF:1102 (Reference
Number) field.
If the RFF:1101 (Reference Qualifier) is ON, the RFF:11 segment contains the
order number (purchase). You must map a constant to the Reference Qualifier
and establish a qualifying relationship with the Reference Number. This allows
you to specify that the Reference Number element contains the order number
(purchase).

Note: We recommend that you set up a Document Reference for each map to
make message identification easier. Continue with the following:
1. “Setting the Reference Qualifier - EDIFACT”
2. “Setting up the Document Reference - ANSI X12 and EDIFACT” on page 73

v For TRADACOMS:
The ODD group contains order and delivery terms and invoice line details. This
group repeats up to 999,999 times. You only need to send one ODD group to
your partner because you are invoicing only one order for this message.
Therefore, you need to change the maximum usage of the ODD group to make
it a non-repeating group.
Because you will only be invoicing one order per INVOIC message, you can use
extended rules to hard code the first level sequence numbers to one. The first
level sequence numbers (PYT SEQA, DNA SEQA:2, ODD:2 SEQA, and ILD:2
SEQA) each indicate the number of orders that this message is invoicing.
Continue with the following:
1. “Changing the Maximum Usage of the ODD Group - TRADACOMS” on

page 73
2. “Creating an Extended Rule to Specify the PYT SEQA - TRADACOMS” on

page 74
3. “Creating an Extended Rule to Specify the DNA SEQA:2 - TRADACOMS” on

page 74
4. “Creating an Extended Rule to Specify the ODD:2 SEQA - TRADACOMS” on

page 74
5. “Creating an Extended Rule to Specify the ILD:2 SEQA - TRADACOMS” on

page 75
6. “Mapping the Order Number - TRADACOMS” on page 75

Setting the Reference Qualifier - EDIFACT
About this task

Use this procedure to set the Reference Qualifier for the RFF:11 segment.

Procedure
1. Double-click the RFF:1101 element (Reference Qualifier) in the PONUM_RFF

group to display the Element Properties dialog box.
2. Select the Standard Rule tab.
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3. From the standard rule list, select Use Constant.
4. From the Constants list, select the ON constant to identify the RFF:1102 element

as containing the order number (purchase).
5. From the Qualifies list, select the 1154:2 REFERENCE NUMBER to set up a

qualifying relationship with the RFF:1102 element.
6. Click OK and the ON code is loaded in the Reference Qualifier element.

The qualifying relationship between the RFF:1101 and RFF:1102 elements is also
established.

Setting up the Document Reference - ANSI X12 and EDIFACT
To set up a Document Reference, you must select an element or field in the map
that contains data that distinguishes the documents translated by this map. If you
set up the Reference in the Application Integration subsystem, the RefData field of
the document browsers that contain this document in Sterling Gentran:Server
contains the data from that mapped field.

About this task

Use this procedure to set up the Document Reference for this invoice.

Procedure
1. Double-click one of the following elements:

v BIG04 (0324) (for ANSI X12)
v RFF:1102 (for EDIFACT)
The system displays the Element Properties dialog box.

2. Select the Standard Rule tab.
3. From the standard rule list, select Update.
4. From the table list, choose Document record. This indicates that you are

updating the document record in Sterling Gentran:Server.
5. From the column list, select Reference Data. This indicates that you are

updating the RefData field in the document browsers with the contents of this
element.

6. Click OK to set up the document reference.

Changing the Maximum Usage of the ODD Group -
TRADACOMS

About this task

Use this procedure to make the ODD a non-repeating group.

Procedure
1. Right-click the ODD group and select Properties.
2. In the Maximum Usage box, type 1 to make the ODD group a non-repeating

group. This box currently contains 999999.
3. Click the Promote records to parent check box to specify that when the group

is compiled, the subordinate segments and group are extracted from the loop
and located in the parent group.

4. Click OK to accept the change to the ODD group.
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Creating an Extended Rule to Specify the PYT SEQA -
TRADACOMS

About this task

Use this procedure to create an extended rule to hard code the first level sequence
numbers for the PYT segment (Settlement Terms) to one, indicating the number of
orders that this message is invoicing.

Procedure
1. Double-click the PYT SEQA element (First Level Sequence Number) to display

the Element Properties dialog box.
2. Select the Extended Rule tab.
3. In the Rule list, type the following:

#SEQA = 1;

The #SEQA = 1 sets the first level sequence number for the PYT segment to one.
The system executes this rule when it processes the PYT SEQA element.

4. Click Compile to validate the syntax of the extended rule.
5. Click OK to add the extended rule to the PYT SEQA element.

Creating an Extended Rule to Specify the DNA SEQA:2 -
TRADACOMS

About this task

Use this procedure to create an extended rule to hard code the first level sequence
number for the DNA segment (Data Narrative) to one, indicating the number of
orders that this message is invoicing.

Procedure
1. Double-click the DNA SEQA:2 element (First Level Sequence Number) to

display the Element Properties dialog box.
2. Select the Extended Rule tab.
3. In the Rule list, type the following:

#SEQA:2 = 1;

The #SEQA:2 = 1 sets the first level sequence number for the DNA segment to
one. The system executes this rule when it processes the DNA SEQA:2 element.

4. Click Compile to validate the syntax of the extended rule.
5. Click OK to add the extended rule to the DNA SEQA:2 element.

Creating an Extended Rule to Specify the ODD:2 SEQA -
TRADACOMS

About this task

Use this procedure to create an extended rule to hard code the first level sequence
numbers for the ODD:2 segment (Order and Delivery Terms) to one, indicating the
number of orders that this message is invoicing.

Procedure
1. Double-click the ODD:2 SEQA element (First Level Sequence Number) to

display the Element Properties dialog box.
2. Select the Extended Rule tab.
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3. In the Rule list, type the following:
#SEQA = 1;

The #SEQA = 1 sets the first level sequence number for the ODD:2 segment to
one. The system executes this rule when it processes the ODD:2 SEQA element.

4. Click Compile to validate the syntax of the extended rule.
5. Click OK to add the extended rule to the ODD:2 SEQA element.

Creating an Extended Rule to Specify the ILD:2 SEQA -
TRADACOMS

About this task

Use this procedure to create an extended rule to hard code the first level sequence
numbers for the ILD:2 segment (Invoice Line Details) to one, including the number
of orders that this message is invoicing.

Procedure
1. Double-click the ILD:2 SEQA element (First Level Sequence Number) to

display the Element Properties dialog box.
2. Select the Extended Rule tab.
3. In the Rule list, type the following:

#SEQA = 1;

The #SEQA = 1 sets the first level sequence number for the ILD:2 segment to
one. The system executes this rule when it processes the ILD:2 SEQA element.

4. Click Compile to validate the syntax of the extended rule.
5. Click OK to add the extended rule to the ILD:2 SEQA element.

Mapping the Order Number - TRADACOMS
About this task

Use this procedure to map the customer’s order number.

Procedure
1. If the Linking function is not currently active, click Link.
2. Click the application field PONUM in the INVBEGIN record.
3. Click the ODD:2 ORNO ORN0 element (Customer’s Order Number).

PODATE Field

Mapping the PODATE Field
About this task

Use this procedure to map the PODATE field.

Procedure
v For ANSI X12: Link the application field PODATE in the INVBEGIN record to

the BIG03 element in the BIG segment.
v For EDIFACT: Complete the following tasks:

1. Changing the Properties of the DTM:2502 Element
2. Setting the Date/Time/Period Qualifier
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3. Mapping the Purchase Order Date
The purchase order date information is contained in the DTM:25 segment (in the
PONUM_RFF group). You must change the properties of the DTM:2502 element
(Date/Time/Period) to reflect the minimum and maximum length, type, and
format that your partner will send you.
Use the Link function you to map the PODATE field directly to the DTM:2502
(Date/Time/Period) element. If the DTM:2501 (Date/Time/Period Qualifier) is 4,
the DTM:25 segment contains the order date/time. You must map a constant to
the Date/Time/Period Qualifier and establish a qualifying relationship with the
Date/Time/Period. This enables you to specify that the Date/Time/Period
element contains the order date/time.

v For TRADACOMS: Link the application field PODATE in the INVBEGIN record
to the ODD:2 ORNO ORN2 element (Date Order Placed by Customer).

Changing the Properties of the DTM:2502 Element
You have informed your partner that you will send six digits for the DTM:2502
element (Date/Time/Period) and that these six digits will be a Dt/Tm data type in
the YYMMDD format (two-digit year, two-digit month, and two-digit day). You
must change the minimum and maximum length, type, and format of the
DTM:2502 element.

About this task

Use this procedure to change the length of the DTM:2502 element.

Procedure
1. Double-click the DTM:2502 element to display the Element Properties dialog

box.
2. Select the Validation tab.
3. In the Minimum box, type 6 as the minimum length.
4. In the Maximum box, type 6 as the maximum length.
5. From the Type list, select Date/Time. Click Yes to acknowledge the message

and proceed.
6. From the Format list, select YYMMDD.
7. Click OK to exit the Element Properties dialog box.

Setting the Date/Time/Period Qualifier
About this task

Use this procedure to set the Date/Time/Period Qualifier for the DTM:25 segment.

Procedure
1. Double-click the DTM:2501 element (Date/Time/Period Qualifier) in the

DTM:25 segment to display the Element Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select 4 (order date/time) to identify the DTM:2502

element as containing the order date and time.
5. From the Qualifies list, select 2380:5 DATE/TIME/PERIOD to set up a

qualifying relationship with the DTM:2502 element.
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6. Click OK. The 4 code is loaded in the Date/Time/Period Qualifier element and
the qualifying relationship between the DTM:2501 and DTM:2502 elements is
established.

Mapping the Purchase Order Date
About this task

Use this procedure to map the purchase order date.

Procedure

Link the application field PODATE in the INVBEGIN record to the DTM:2502
element in the DTM:25 segment (in the PONUM_RFF group).
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Chapter 6. Shipping and Billing

Shipping and Billing Information for ANSI X12

About Shipping and Billing Information for ANSI X12
The N1 group contains vendor, shipping, and billing name and address
information, and repeats multiple times. Your application file contains Vendor, Ship
To, and Remit To information that you need to map to the N1 group. However,
you can only map fields and elements that are at the same level. This means that
you cannot map from a non-repeating record to a group. Specifically, you cannot
map the vendor, shipping, and remittance information in the INVBEGIN record
directly to the N1 group, because the INVBEGIN record does not repeat. Also, you
cannot map to the N3 (address information) repeating segment from your
application file Ship To fields (which are in the INVBEGIN record that does not
repeat).

Therefore, to map vendor, shipping, and remittance information from your
application file format, you must create three single iterations of the N1 group, so
that the links between the application fields in the INVBEGIN record and the N1
groups are valid. The Split function extracts the specified number of iterations
(instances) of a group (or repeating segment). This enables you to map unique data
from your application file and enter a specialized definition for each N1 group
(N1_Vendor, N1_ShipTo, and N1_RemitTo).

You can then map a constant to the Entity Identifier Code (in the N1 segment) for
each iteration of the N1 group. If the Entity Identifier Code is VN, that iteration of
the N1 group contains shipping information. You need to map the Vendor name
and address fields in your application file format to the N1_Vendor group. If the
Entity Identifier Code is ST, that iteration of the N1 group contains shipping
information. You need to map the Ship To name and address fields in your
application file format to the N1_ShipTo group. If the Entity Identifier Code is RI,
that iteration of the N1 group contains remittance information. You need to map
the remittance name and address fields in your application file format to the
N1_RemitTo group.

The N1 Group

Changing the Max Use of the N3 Segment
You cannot map from your application file format Vendor, Ship To, and Remit To
fields (which are in the INVBEGIN record that does not repeat) to the N3 (address
information) repeating segment. Therefore, before you split the N1 group, you
need to change the maximum usage of the N3 segment from 2 to 1 (to make the
N3 a non-repeating segment for each iteration of the group).

About this task

Use this procedure to make the N3 a non-repeating segment.

Procedure
1. Right-click the N3 segment (in the N1 group) and select Properties.
2. Select the Looping tab.
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3. In the Max Usage box, type 1 to make the N3 a non-repeating segment. This
box is currently set to 2.

4. Click OK to accept the change to the N3 segment.

Splitting the N1 Group
You cannot map from a non-repeating record (INVBEGIN) to a group (N1).
Therefore, to map vendor, shipping, and remittance information from your
application file format, you must split three single iterations of the N1 group, so
that the links between the application fields in the INVBEGIN record and the N1
groups are valid.

About this task

Use this procedure to map to split three iterations of the N1 group and add
specialized definitions.

Procedure
1. Click the N1 group and click Split on the Main Toolbar.
2. In the First Loop Entries box, type 1 to indicate the sequential number of

iterations where you want the group or repeating segment split.
3. Click OK to exit the Split dialog box.
4. Select Edit > Properties.
5. In the Name box, type N1_Vendor, which is a specialized definition to

identify this group as containing vendor information.
6. Click OK to save the change and exit the Group Properties dialog box.
7. Click the original N1 group (that now repeats 199 times) and click Split on

the Main Toolbar to extract another single instance of the N1.
8. In the First Loop Entries box, type 1 to indicate the sequential number of

iterations where you want the group or repeating segment split.
9. Click OK to exit the Split dialog box.

10. Select Edit > Properties.
11. In the name box, type N1_ShipTo, which is a specialized definition to identify

this group as containing shipping information.
12. Click OK to save the change and exit the Group Properties dialog box.
13. Click the original N1 group (that now repeats 198 times) and click Split on

the Main Toolbar to extract another single instance of the N1.
14. In the First Loop Entries box, type 1 to indicate the sequential number of

iterations where you want the group or repeating segment split.
15. Click OK to exit the Split dialog box.
16. Select Edit > Properties.
17. In the Name box, type N1_RemitTo, which is the specialized definition to

identify this group as containing remittance information.
18. Click OK to save the change and exit the Group Properties dialog box.
19. Click Deactivate on the Main Toolbar and then click the original N1 group

(that now repeats 197 times) so the system does not process it.
20. Click the REF:6 segment (in the N1_Vendor group) so the system does not

process it.
21. Click Deactivate on the Main Toolbar to turn off Deactivation mode.
22. Double-click the N1_RemitTo group to open it.
23. Click Deactivate.
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24. Click the REF:8 segment (in the N1_RemitTo group) so the system does not
process it.

25. Click Deactivate on the Main Toolbar to turn off Deactivation mode.

Setting the Entity Identifier Code for N1_Vendor Group
You need to set the Entity Identifier Code for the N1_Vendor, N1_ShipTo, and
N1_RemitTo groups, so the system is able to distinguish the type of name and
address information each N1 group should contain.

About this task

You already defined all the constants that you are using in this map, so now you
can map the appropriate constant to each Entity Identifier Code element.

Use this procedure to set the Entity Identifier Code for the N1_Vendor group.

Procedure
1. Double-click the N1:301 element (Entity Identifier Code) in the N1:3 segment to

display the Element Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select the VN constant, to identify this iteration of the

N1 group as containing vendor name and address information.
5. From the Qualifies list, select 0093:5 NAME, to set up a qualifying relationship

with the Name element.

Note: The Qualifies list contains only the other active elements in the same
segment as the qualifying element.

6. Click OK and the VN code is loaded to the Entity Identifier Code element and
the qualifying relationship between the N1:301 and N1:302 elements is
established.

Setting the Entity Identifier Code for N1_ShipTo Group
About this task

Use this procedure to set the Entity Identifier Code for the N1_ShipTo group.

Procedure
1. Double-click the N1:401 element (Entity Identifier Code) in the N1:4 segment to

display the Element Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select the ST constant, to identify this iteration of the

N1 group as containing shipping name and address information.
5. From the Qualifies list, select 0093:21 NAME, to set up a qualifying relationship

with the Name element.
6. Click OK and the ST code is loaded in the Entity Identifier Code element and

the qualifying relationship between the N1:401 and N1:402 elements is
established.
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Setting the Entity Identifier Code for N1_RemitTo group
About this task

Use this procedure to set the Entity Identifier Code for the N1_RemitTo group.

Procedure
1. Double-click the N1:501 element (Entity Identifier Code) in the N1:5 segment to

display the Element Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select the RI constant, to identify this iteration of the

N1 group as containing vendor name and address information.
5. From the Qualifies list, select 0093:85 NAME, to set up a qualifying relationship

with the Name element.
6. Click OK and the RI code is loaded in the Entity Identifier Code element and

the qualifying relationship between the N1:501 and the N1:502 elements is
established.

Mapping the Vendor Application Fields
Now you can link the elements in your Vendor application fields in the single
occurrence of the INVBEGIN record to the appropriate single occurrence of the N1
that contains vending information (N1_Vendor).

About this task

Use this procedure to map the application fields and elements.

Procedure
1. Link the application field VENDNAME in the INVBEGIN record to the

N1:302 element in the N1:3 segment (N1_Vendor group).
2. Link the application field VENDADD1 in the INVBEGIN record to the N3:301

element in the N3:3 segment (N1_Vendor group).
3. Link the application field VENDADD2 in the INVBEGIN record to the N3:302

element in the N3:3 segment (N1_Vendor group).
4. Link the application field VENDCITY in the INVBEGIN record to the N4:301

element in the N4:3 segment (N1_Vendor group).
5. Link the application field VENDSTATE in the INVBEGIN record to the

N4:302 element in the N4:3 segment (N1_Vendor group).
6. Link the application field VENDPOSTALCODE in the INVBEGIN record to

the N4:303 element in the N4:3 segment (N1_Vendor group).
7. Link the application field SHIPTONAME in the INVBEGIN record to the

N1:402 element in the N1:4 segment (N1_ShipTo group).
8. Link the application field SHIPTOADD1 in the INVBEGIN record to the

N3:401 element in the N3:4 segment (N1_ShipTo group).
9. Link the application field SHIPTOADD2 in the INVBEGIN record to the

N3:402 element in the N3:4 segment (N1_ShipTo group).
10. Link the application field SHIPTOCITY in the INVBEGIN record to the

N4:401 element in the N4:4 segment (N1_ShipTo group).
11. Link the application field SHIPTOSTATE in the INVBEGIN record to the

N4:40 element in the N4:4 segment (N1_ShipTo group).
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12. Link the application field SHIPTOPOSTALCODE in the INVBEGIN record to
the N4:403 element in the N4:4 segment (N1_ShipTo group).

Shipping Application Fields
The SHIPTOLOC (ship to location) and the SHIPTODEPTNUM (ship to
department number) fields both contain additional reference information about the
Ship To address. Both fields are in the INVBEGIN record that occurs once. To map
both these fields to the REF:7 (reference) segment in the N1_ShipTo group, which
repeats twelve times, you must promote a single instance of the REF segment, so
that two target fields exists to which you can map the SHIPTOLOC and
SHIPTODEPTNUM. And, because the original REF segment (REF:7) still repeats
eleven times, you must change the maximum usage to one. Therefore, a link
between the INVHEADER and the original REF segment (REF:7) is valid.

You must also map a constant to the Reference Number Qualifier (REF01 element)
and define a qualifying relationship with the Reference Number (REF02 element),
for both instances of the REF segment (REF:9 and REF:7). If the Reference Number
Qualifier is DP (department number), that iteration of the REF segment contains
the ship to department number. If the Reference Number Qualifier is ST (store
number), that iteration of the REF segment contains the ship to location.

Promoting the REF Segment
To map both the SHIPTOLOC and SHIPTODEPTNUM fields to the REF (reference)
segment in the N1_ShipTo group, which repeats twelve times, you must promote a
single instance of the REF segment, so that two target fields exists to which you
can map the SHIPTOLOC and SHIPTODEPTNUM.

About this task

Use this procedure to map to promote a single instance of the REF segment.

Procedure
1. Click the REF:7 segment in the N1_ShipTo group.
2. Click Promote on the Main Toolbar to extract a single instance of the REF

segment.
The REF:9 segment that only occurs once is extracted.

Changing the Max Use of the REF:7 Segment
The original REF segment (REF:7) still repeats eleven times, so you need to change
the maximum usage to one. Therefore, a link between the INVHEADER and the
original REF segment (REF:7) is valid.

About this task

Use this procedure to make the REF:7 a non-repeating segment.

Procedure
1. Right-click the REF:7 segment (in the N1_ShipTo group) and select Properties.
2. Select the Looping tab.
3. In the Max Usage box, type 1 to make the REF:7 a non-repeating segment. This

box is currently set to 11.
4. Click OK to accept the change to the REF:7 segment.
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Reference Number Qualifier
You must map a constant to the Reference Number Qualifier (REF01 element) and
define a qualifying relationship with the Reference Number (REF02 element), for
both instances of the REF segment (REF:9 and REF:7).

You already defined all the constants that you are using in this map, so now you
can map the appropriate constant to each Reference Number Qualifier element.

Setting the Reference Number Qualifier for REF:9
About this task

Use this procedure to set the Reference Number Qualifier for the REF:9 segment.

Procedure
1. Double-click the REF:901 element in the REF:9 segment in the N1_ShipTo

group to display the Element Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select the DP constant, to identify this iteration of the

REF segment as containing the ship to department number.
5. From the Qualifies list, select 0127:12 REFERENCE NUMBER, to set up a

qualifying relationship with the Reference number element.
6. Click OK and the DP code is loaded in the Reference Number Qualifier

element and the qualifying relationship between REF:901 and REF:902 elements
is established.

Setting the Reference Number Qualifier for REF:7
About this task

Use this procedure to set the Reference Number Qualifier for the REF:7 segment.

Procedure
1. Double-click the REF:701 element in the REF:7 segment in the N1_ShipTo

group to display the Element Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select the SN constant, to identify this iteration of the

REF segment as containing the store number.
5. From the Qualifies list, select the 0127:10 REFERENCE NUMBER, to set up a

qualifying relationship with the Reference Number element.
6. Click OK and the SN code is loaded in the Reference Number Qualifier

element and the qualifying relationship between the REF:701 and REF:702
elements is established.

Mapping the Shipping Reference Information
After promoting the REF segment, changing the maximum usage, mapping
constants to the Reference Number Qualifier elements, and establishing the
appropriate qualifying relationship, you can map the shipping reference
information.
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About this task

Use this procedure to map the shipping reference fields.

Procedure
1. Link the application field SHIPTOLOC in the INVBEGIN record to the REF7:02

element in the REF:7 segment (N1_ShipTo group).
2. Link the application field SHIPTODEPTNUM in the INVBEGIN record to the

REF9:02 element in the REF:9 segment (N1_ShipTo group).
3. Link the application field REMITTONAME in the INVBEGIN record to the

N1:502 element in the N1:5 segment (N1_RemitTo group).
4. Link the application field REMITTOADD1 in the INVBEGIN record to the

N3:501 element in the N3:5 segment (N1_RemitTo group).
5. Link the application field REMITTOADD2 in the INVBEGIN record to the

N3:502 element in the N3:5 segment (N1_RemitTo group).
6. Link the application field REMOTTOCITY in the INVBEGIN record to the

N4:501 element in the N4:5 segment (N1_RemitTo group).
7. Link the application field REMITTOSTATE in the INVBEGIN record to the

N4:502 element in the N4:5 segment (N1_RemitTo group).
8. Link the application field REMITTOPOSTALCODE in the INVBEGIN record

to the N4:503 element in the N4:5 segment (N1_RemitTo group).

Bill of Lading Number
You need to send only one header REF segment to your trading partner. (Typically,
the REF segment repeats up to 12 times.) After you change the max usage of the
REF segment to 1, the BOLNUM (bill of lading number) field can be directly
mapped to the REF02 element. However, you must also map a constant to the
Reference Number Qualifier (REF01 element) and define a qualifying relationship
with the Reference Number (REF02 element) to indicate that the REF02 contains
the bill of lading number.

Changing the Max Use of the REF Segment
You have determined that you only send your partner one header REF segment
(reference information), so you must change the maximum usage allowed for that
segment from 12 to 1.

About this task

Use this procedure to make the REF a non-repeating segment.

Procedure
1. Right-click the REF segment (in the header) and select Properties.
2. Select the Looping tab.
3. In the Max Usage box, type 1 to make the REF a non-repeating segment. This

box is currently set to 12.
4. Click OK to accept the change to the REF segment.

Setting the Reference Number Qualifier
You already defined all the constants that you are using in this map, so now you
can map the appropriate constant to the Reference Number Qualifier element.
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About this task

Use this procedure to set the Reference Number Qualifier for the REF segment.

Procedure
1. Double-click the REF:01 element (Reference Number Qualifier) in the REF

segment to display the Element Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select the BM constant, to identify this iteration of the

REF segment as containing the bill of lading number.
5. From the Qualifies list, select the 0127 REFERENCE NUMBER, to set up a

qualifying relationship with the Reference Number element.
6. Click OK and the BM code is loaded in the Reference Number Qualifier

element and the qualifying relationship between the REF01 and REF02 elements
is established.

Mapping the BOLNUM Field
After mapping the constant to the Reference Number Qualifier element and
establishing the appropriate qualifying relationship, you need to map the
BOLNUM field.

About this task

Use this procedure to map the BOLNUM field.

Procedure

Link the application field BOLNUM in the INVBEGIN record to the REF02
element in the REF segment.

Ship Date
You need to send only one header DTM segment to your trading partner.
(Typically, the DTM segment repeats up to 10 times.) After you change the max
usage of the DTM segment to 1, the SHIPDATE field can be directly mapped to the
DTM02 element (in the DTM header segment). However, you must also map a
constant to the Date/Time Qualifier (DTM01 element) and define a qualifying
relationship with the Date (DTM02 element) to indicate that the DTM02 contains
the ship date.

Changing the Max Use of the DTM Segment
You have determined that you only send your partner one header DTM segment
(date/time information), so you must change the maximum usage allowed for that
segment from 10 to 1.

About this task

Use this procedure to make the DTM a non-repeating segment.

Procedure
1. Right-click the DTM segment (in the header) and select Properties.
2. Select the Looping tab.
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3. In the Max Usage box, type 1 to make the DTM a non-repeating segment. This
box is currently set to 10.

4. Click OK to accept the change to the DTM segment.

Setting the Ship Date Qualifier
You already defined all the constants that you are using in this map, so now you
can map the appropriate constant to the Date/Time Qualifier element.

About this task

Use this procedure to set the Date/Time Qualifier for the DTM segment.

Procedure
1. Double-click the DTM:01 element (Date/Time Qualifier) in the DTM segment

to display the Element Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select the DTM constant, to identify this iteration of

the DTM segment as containing the bill of lading number.
5. From the Qualifies list, select the 0373:6 DATE, to set up a qualifying

relationship with the Date element.
6. Click OK and the DTM code is loaded in the Date/Time Qualifier element and

the qualifying relationship between the DTM01 and DTM02 elements is
established.

Mapping the SHIPDATE Field
After mapping the constant to the Date/Time Qualifier element and establishing
the appropriate qualifying relationship, you can map the SHIPDATE field.

About this task

Use this procedure to map the SHIPDATE field.

Procedure

Link the application field SHIPDATE in the INVBEGIN record to the DTM02
element in the DTM segment.

Changing the Max Use of the ITD Segment
You have determined that you only send your partner one header ITD segment
(terms of sale/deferred terms of sale), so you must change the maximum usage
allowed for that segment from 5 to 1.

About this task

Use this procedure to make the ITD segment non-repeating.

Procedure
1. Right-click the ITD segment (in the header) and select Properties.
2. Select the Looping tab.
3. In the Max Usage field, type 1 to make the ITD a non-repeating segment. This

field is currently set to 5.
4. Click OK to accept the change to the ITD segment.
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Mapping the TERMS Fields
About this task

Use this procedure to map the TERMS fields.

Procedure
1. Link the application field TERMS_WHOLE in the INVBEGIN record to the

ITD03 element in the ITD segment (in the header).
2. Link the application field TERMSNETDUE in the INVBEGIN record to the

ITD07 element in the ITD segment.
3. Link the application field TERMSDISDUE in the INVBEGIN record to the

ITD05 element in the ITD segment.

Shipping and Billing Information for EDIFACT

About Shipping and Billing Information for EDIFACT
The NAD group contains vendor, shipping, and billing name and address
information. It repeats multiple times. Your application file contains Vendor, Ship
To, and Remit To information that you must map to the NAD group. However,
you can only map fields and elements that are at the same level. This means that
you cannot map from a non-repeating record to a group. Specifically, you cannot
map the vendor, shipping, and remittance information in the INVBEGIN record
directly to the NAD group, because the INVBEGIN record does not repeat.

To map vendor, shipping, and remittance information from your application file
format, you created three single iterations of the NAD group using the promote
function, so that the links between the application fields in the INVBEGIN record
and the NAD groups are valid. The Promote function extracts the one iteration
(instance) of a group (or repeating segment). This enables you to map unique data
from your application file to each NAD group (Vend_NAD, ShipTo_NAD, and
RemitTo_NAD).

VENDNAME Field
You can map a constant to the NAD segment Party Qualifier for each iteration of
the NAD group. If the Party Qualifier is VN, that iteration of the NAD group
contains shipping information. You must map the Vendor name and address fields
in your application file format to the Vend_NAD group. If the Party Qualifier is ST,
that iteration of the NAD group contains shipping information. You must map the
Ship To name and address fields in your application file format to the
ShipTo_NAD group. If the Party Qualifier is RE, that iteration of the NAD group
contains remittance information. You must map the remittance name and address
fields in your application file format to the RemitTo_NAD group.

Setting the Party Qualifier
You must set the Party Qualifier for the Vend_NAD, ShipTo_NAD, and
RemitTo_NAD groups, so the system can distinguish the type of name and address
information each NAD group should contain.

About this task

You have already defined all the constants that you will use for this map. Now
you can map the appropriate constant to each Party Qualifier element.

88 IBM Sterling Gentran:Server for Windows: Application Integration Tutorial for Outbound Invoices



Procedure
1. Double-click the NAD:310 element (Party Qualifier) in the NAD:3 segment to

display the Element Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select VN to identify this iteration of the NAD group

as containing vendor name and address information.
5. Click OK. The VN code is loaded in the Party Qualifier element.

Setting the Party Qualifier for the ShipTo_NAD Segment
About this task

Use this procedure to set the Party Qualifier for the ShipTo_NAD group.

Procedure
1. Double-click the NAD:401 element (Party Qualifier) in the NAD:4 segment to

display the Element Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select ST to identify this iteration of the NAD group as

containing shipping name and address information.
5. Click OK. The ST code is loaded in the Party Qualifier element.

Setting the Party Qualifier for the RemitTo_NAD Group
About this task

Use this procedure to set the Party Qualifier for the RemitTo_NAD group.

Procedure
1. Double-click the NAD:501 element (Party Qualifier) in the NAD:5 segment to

display the Element Properties dialog box
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select RE to identify this iteration of the NAD group as

containing vendor name and address information.
5. Click OK. The RE code is loaded in the Party Qualifier element.

Linking the NAD Group
About this task

Use this procedure to map the terms fields.

Procedure
1. Link the application field VENDNAME in the INVBEGIN record to the

NAD:310 element in the NAD:3 segment (Vend_NAD group).
2. Link the application field VENADD1 in the INVBEGIN record to the

NAD:316 element in the NAD:3 segment (Vend_NAD group).
3. Link the application field VENADD2 in the INVBEGIN record to the

NAD:317 element in the NAD:3 segment (Vend_NAD group).
4. Link the application field VENDCITY in the INVBEGIN record to the

NAD:319 element in the NAD:3 segment (Vend_NAD group).
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5. Link the application field VENDSTATE in the INVBEGIN record to the
NAD:320 element in the NAD:3 segment (Vend_NAD group).

6. Link the application field VENDPOSTALCODE in the INVBEGIN record to
the NAD:321 element in the NAD:3 segment (Vend_NAD group).

7. Link the application field SHIPTONAME in the INVBEGIN record to the
NAD:410 element in the NAD:4 segment (ShipTo_NAD group).

8. Link the application field SHIPTOADD1 in the INVBEGIN record to the
NAD:416 element in the NAD:4 segment (ShipTo_NAD group).

9. Link the application field SHIPTOADD2 in the INVBEGIN record to the
NAD:417 element in the NAD:4 segment (ShipTo_NAD group).

10. Link the application field SHIPTOCITY in the INVBEGIN record to the
NAD:419 element in the NAD:4 segment (ShipTo_NAD group).

11. Link the application field SHIPTOSTATE in the INVBEGIN record to the
NAD:420 element in the NAD:4 segment (ShipTo_NAD group).

12. Link the application field SHIPTOPOSTALCODE in the INVBEGIN record to
the NAD:421 element in the NAD:4 segment (ShipTo_NAD group).

SHIPTOLOC Field
The SHIPTOLOC (ship to location) contains additional reference information about
the Ship To address. This field is in the INVBEGIN record that occurs once. Map
this field to the LOC:1305 element (place/location) in the LOC:13 segment in the
ShipTo_NAD group.

You must also map a constant to the Place Location Qualifier (LOC:1301 element)
and define a qualifying relationship with the Place/Location (LOC:1305 element). If
the Place/Location Qualifier is 4 (goods receipt place), that iteration of the LOC:13
segment contains the ship to location.

Setting the Place/Location Qualifier
You have already defined all constants that you will use for this map. Now map
the appropriate constant to each Place/Location Qualifier element.

About this task

Use this procedure to set the Place/Location Qualifier for the LOC:13 segment.

Procedure
1. Double-click the LOC:1301 element (Place/Location Qualifier) in the LOC:13

segment in the ShipTo_NAD group to display the Element Properties dialog
box.

2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select the second 4 constant in the list to identify this

iteration of the LOC:13 segment as containing the ship to department number.
5. From the Qualifies list, select 3224:5 PLACE/LOCATION to set up a qualifying

relationship with the Place/Location element.
6. Click OK.

The 4 code is loaded in the Place/Location Qualifier element and the qualifying
relationship between the LOC:1301 and LOC:1305 elements is established.
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Mapping the Shipping Fields
After mapping the constant to the Place/Location Qualifier element and
establishing the appropriate qualifying relationship, map the SHIPTOLOC field.

About this task

The SHIPTODEPTNUM (ship to department number) contains additional reference
information about the Ship To address. This field is in the INVBEGIN record that
occurs once. Map this field to the CTA:603 element (department or employee) in
the CTA:6 segment in the CTA:5 group in the ShipTo_NAD group.

Use this procedure to map the shipping fields.

Procedure
1. Link the application field SHIPTOLOC in the INVBEGIN record to the

LOC:1305 element in the LOC:13 segment (ShipTo_NAD group).
2. Link the application field SHIPTODEPTNUM in the INVBEGIN record to the

CTA:603 element in the CTA:6 segment in the CTA:5 group (ShipTo_NAD
group).

3. Link the application field REMITTONAME in the INVBEGIN record to the
NAD:510 element in the NAD:5 segment (RemitTo_NAD group).

4. Link the application field REMITTOADD1 in the INVBEGIN record to the
NAD:516 element in the NAD:5 segment (RemitTo_NAD group).

5. Link the application field REMITTOADD2 in the INVBEGIN record to the
NAD:517 element in the NAD:5 segment (RemitTo_NAD group).

6. Link the application field REMITTOCITY in the INVBEGIN record to the
NAD:519 element NAD:5 segment (RemitTo_NAD group).

7. Link the application field REMITTOSTATE in the INVBEGIN record to the
NAD:520 element element in the NAD:5 segment (RemitTo_NAD group).

8. Link the application field REMITTOPOSTALCODE in the INVBEGIN record
to the NAD:521 element in the NAD:5 segment (RemitTo_NAD group).

BOLNUM Field
Use the Link function to map the BOLNUM field directly to the RFF:1202
(Reference Number) field.

If the RFF:1201 (Reference Qualifier) is BM, the RFF:12 segment contains the bill of
lading number. You must map a constant to the Reference Qualifier and establish a
qualifying relationship with the Reference Number. This enables you to specify
that the Reference Number element contains the bill of lading number.

Setting the Reference Qualifier - EDIFACT
About this task

Use this procedure to set the Reference Qualifier for the RFF:11 segment.

Procedure
1. Double-click the RFF:1101 element (Reference Qualifier) in the PONUM_RFF

group to display the Element Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
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4. From the Constants list, select the ON constant to identify the RFF:1102 element
as containing the order number (purchase).

5. From the Qualifies list, select the 1154:2 REFERENCE NUMBER to set up a
qualifying relationship with the RFF:1102 element.

6. Click OK and the ON code is loaded in the Reference Qualifier element.
The qualifying relationship between the RFF:1101 and RFF:1102 elements is also
established.

Mapping the Bill of Lading Number
About this task

Use this procedure to map the bill of lading number.

Procedure

Link the application field BOLNUM in the INVBEGIN record to the RFF:1202
element in the RFF:12 segment (BOL_RFF group).

SHIPDATE Field
On the EDI side of the map, the purchase order date information is contained in
the DTM:26 segment (in the BOL_RFF group). You must change the properties of
the DTM:2602 element (Date/Time/Period) to reflect the minimum and maximum
length, type, and format that your partner will send you.

Use the Link function to map the SHIPDATE field directly to the DTM:2602
(Date/Time/Period) element. If the DTM:2601 (Date/Time/Period Qualifier) is 11,
the DTM:26 segment contains the despatch date/time. You must map a constant to
the Date/Time/Period Qualifier and establish a qualifying relationship with the
Date/Time/Period. This enables you to specify that the Date/Time/Period element
contains the despatch date/time.

Changing the Properties of the DTM:2602 Element
You have informed your partner that you will send six digits for the DTM:2602
element (Date/Time/Period), and these six digits will be a Dt/Tm data type in the
YYMMDD format (two-digit year, two-digit month, and two-digit day). You must
change the minimum and maximum length, type, and format of the DTM:2602
element.

About this task

Use this procedure to change the length of the DTM:2602 element.

Procedure
1. Double-click the DTM:2602 element to display the Element Properties dialog

box.
2. Select the Validation tab.
3. In the Minimum box, type 6 as the minimum length.
4. In the Maximum box, type 6 as the maximum length.
5. From the Type list, select Date/Time.
6. From the Format list, select YYMMDD.
7. Click OK to exit the Element Properties dialog box.
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Setting the Date/Time/Period Qualifier
You must map a constant to the Date/Time/Period Qualifier (DTM:2601 element)
and define a qualifying relationship with the Date/Time/Period (DTM:2602
element).

About this task

You have already defined all the constants that you will use for this map. Now
you map the appropriate constant to the Date/Time/Period Qualifier element.

Use this procedure to set the Date/Time/Period Qualifier for the DTM:26 segment.

Procedure
1. Double-click the DTM:2601 element (Date/Time/Period Qualifier) in the

DTM:26 segment to display the Element Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select 11 (dispatch date/time) to identify the DTM:2602

element as containing the ship date and time.
5. From the Qualifies list, select 2380:6 DATE/TIME/PERIOD to set up a

qualifying relationship with the DTM:2602 element.
6. Click OK.

The 11 code is loaded in the Date/Time/Period Qualifier element and the
qualifying relationship between the DTM:2601 and DTM:2602 elements is
established.

Mapping the Purchase Order Date
About this task

Use this procedure to map the purchase order date.

Procedure

Link the application field SHIPDATE in the INVBEGIN record to the DTM:2602
element in the DTM:26 segment (in the BOL_RFF group).

Shipping Information for TRADACOMS

Mapping the ShipTo Fields
Use this procedure to map the shipping information.

About this task

Procedure
1. If the Linking function is not currently active, click Link.

Note: All of the application fields you are linking from are in the INVBEGIN
record.

2. Click the application field SHIPTONAME and click the CLO CNAM element
(Customer’s Name).

3. Click the application field SHIPTOADD1 and click the CLO CADD CAD0
element (Customer’s Address Line 1).
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4. Click the application field SHIPTOADD2 and click the CLO CADD CAD1
element (Customer’s Address Line 2).

5. Click the application field SHIPTOCITY and click the CLO CADD CAD2
element (Customer’s Address Line 3).

6. Click the application field SHIPTOSTATE and click the CLO CADD CAD3
element (Customer’s Address Line 4).

7. Click the application field SHIPTOPOSTALCODE and click the CLO CADD
CAD4 element (Customer’s Postal Code).

8. Click the application field SHIPTOLOC and click the CLO CLOC CLO1
element (Customer’s Own Location Code).

9. Click the application field BOLNUM and cick the ODD:2 DELN DEL0
element (Delivery Note Number).

10. Click the application field SHIPDATE and click the ODD:2 DELN DEL1
element (Date of Despatch by Supplier).

11. To make the PYT a nonrepeating segment, do the following:
v Right-click the PYT segment and select Properties.
v In the Max Usage box, type 1 to make the PYT a nonrepeating segment.

This box currently contains 999999.
v Click OK to accept the change to the PYT segment.
The PYT segment contains settlement terms and it repeats up to 999,999 times.
You only need to send one PYT segment to your partner because you are
invoicing only one order for this message. Therefore, you need to change the
maximum usage of the PYT segment from to make it a nonrepeating segment.

12. Click the application field TERMSNETDUE and click the PYT PAYY PAY2
element (Number of Days).

13. Click the application field TERMSTEXT and click the PYT PAYT element
(Terms of Payment).
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Chapter 7. INVComment Group

INVComment Group: INVCOMMENT1 and INVCOMMENT2 for ANSI X12
and EDIFACT

INVCOMMENT1 Record
The INVCommentGroup (comment information) groups all the comment
information for the invoice, including the reference number and the message text.
For ANSI X12, the INVCommentGroup occurs once per invoice translated. For
EDIFACT, the INVCommentGroup occurs up to 10 times per invoice translated.
The information within the INVCommentGroup is further segregated by record.

The INVCOMMENT1 record contains the reference number. The first comment
record is mandatory and occurs once per invoice translated (once for each
comment line).

The following fields are part of the application file format key but do not contain
data that the system needs to generate the invoice. Therefore, you do not need to
map these fields:

BILLTOACCTCM1

DOCTYPCM1

INVNUMCM1

REFNUM Field
The REFNUM field can be directly mapped to the N902 element (for ANSI X12) or
FTX06 (for EDIFACT).

For ANSI X12, the REFNUM field refers to the related vendor order number. You
must map a constant to the Reference Number Qualifier (N901 element) and define
a qualifying relationship with the Reference Number (N902 element) to indicate
that the segment contains the reference number.

For EDIFACT, the REFNUM field refers to the invoice instruction. You must map a
constant to the Text Subject Qualifier (FTX01 element) and define a qualifying
relationship with the Free Text (FTX06) element to indicate that the FTX06 contains
the reference number.

Setting the Reference Number Qualifier
About this task

Use this procedure to set the Reference Number Qualifier.

Procedure
1. Double-click one of the following elements to display the Element Properties

dialog box:
v N901 - Reference Number Qualifier in the N9 group (for ANSI X12)
v FTX01 - Text Subject Qualifier in the FTX segment (for EDIFACT)
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2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select one of the following constants to identify this

iteration as containing the reference number. This is in addition to the primary
order number.
v 1V (for ANSI X12)
v INV (for EDIFACT)

5. From the Qualifies list, select one of the following to set up a qualifying
relationship:
v 0127 REFERENCE NUMBER (for ANSI X12)
v 4440 FREE TEXT (for EDIFACT)

6. Click OK.
The code is loaded in the Reference Number Qualifier element and the
qualifying relationship between the elements is established.

Mapping the Reference Number

About this task

Use this procedure to map the reference number.

Procedure
v For ANSI X12: Link the application field REFNUM in the INVCOMMENT1

record to the N902 element in the REF segment.
v For EDIFACT: Link the application field REFNUM in the INVCOMMENT1

record to the FTX06 element in the REF segment.

INVCOMMENT2 Record
The INVCOMMENT2 record contains message text. The second comment record is
mandatory and occurs up to ten times per invoice translated (once for each
comment line).

The following fields are part of the application file format key but do not contain
data that the system needs to generate the invoice. Therefore, you do not need to
map these fields:

BILLTOACCTCM2

DOCTYPCM2

INVNUMCM2

Mapping the MESSAGETEXT Field - ANSI X12
About this task

Use this procedure to map the MESSAGETEXT field.

Procedure

Link the application field MESSAGETEXT in the INVCOMMENT2 record to the
MSG01 element in the MSG segment (N9 group).
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INVCOMMENTGroup: INVDETAIL Record for ANSI X12 and EDIFACT

About the INVDETAIL Record for ANSI X12 and EDIFACT
This section describes the actions necessary for you to map from each field in the
INVDETAIL (detail) record. For ANSI X12, the INVCOMMENT2 record contains
line item number and description, quantity shipped, quantity ordered, unit of
measure, price, product code, and invoice terms. For TRADACOMS, the
INVDETAIL (detail) record contains line item number and description, quantity
shipped, unit of measure, price, product code, and VAT calculation information.
The detail record is mandatory and occurs up to 200,000 times per invoice
translated (once for each line item invoiced).

The following fields are part of the application file format key but do not contain
data that the system needs to generate the invoice. Therefore, you do not need to
map these fields:

BILLTOACCDET

DOCTYPDET

INVNUMDET

Mapping the ITEMNUM Field
The ITEMNUM field can be mapped directly. However, you also need to calculate
an incremental count of the number of line items, and you want to use that total
value in the Number of Line Items Total field.

About this task

The ITEMNUM field can be directly mapped to the LIN01 Line Item Number
element in the LIN segment (LIN group). However, you must first calculate an
incremental count of the number of line items. Use that total value in the
Transaction Totals element (CNT:202).

Use this procedure to count line items, generate a control total, and map the
ITEMNUM field.

Procedure
1. Double-click the IT101 element (for ANSI X12) or LIN01 element (for

EDIFACT). This is the field that you typically use to count the line items. The
Element Properties dialog box is displayed.

2. Select the Standard Rule tab.
3. From the standard rule list, select Use Accumulator.
4. Click New to display the Edit Accumulator Entry dialog box to create a new

calculation for this element.
5. From the Primary Accumulator list, select 0. Before any calculations are

performed on an accumulator, its content is 0. When you use an accumulator,
the system adds a new accumulator to the bottom of this list.

Note: There is only one set of accumulators for each map. This means that the
accumulator 0, whether it is used in the Primary Accumulator or Alternate
Accum box, is the same accumulator with the same contents. If you assign
calculations to accumulator 0 at the beginning of the map and then use
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accumulator 0 again later in the map, the content of that accumulator is the
result of the earlier calculation. Any additional calculations you assign to that
accumulator are performed on the contents resulting from an earlier
calculation.

6. In the Name box, type Line Item Number. This is a descriptive alias that
enables you to differentiate what the accumulators you create are used for.

7. From the First list, select Increment primary. This is the first operation that
the system performs. This specifies that the system increments the value in the
accumulator by one for each iteration of the IT1 or LIN group.

Note: The First box is active only after you select a Primary Accumulator.
8. Click OK to add the accumulator.

The Standard Rule tab of the Element Properties dialog box should now look
like this:

9. Click OK on the Element Properties dialog box to add the standard rule to the
IT101 or LIN01 element.

10. Double-click one of the following elements:
v CTT01 in the CTT segment (for ANSI X12)
v CNT:202 in the CNT:2 segment (for EDIFACT)
This is the field that typically contains the total number of line items. The
Element Properties dialog box is displayed.

11. Select the Standard Rule tab.
12. From the standard rule list, select Use Accumulator.
13. Click New to display the Edit Accumulator Entry dialog box to create a new

calculation for this element.
14. From the Primary Accumulator list, select primary accumulator 0. This

accumulator currently contains the total number of line items.
15. From the First list, select Use primary. This specifies that the system loads the

current value of the accumulator into the element. For ANSI, this is CTT01
(Number of Line Items Total). For EDIFACT, this is CNT:202 (Control Value).

16. Click OK to add the accumulator.
17. Click OK on the Element Properties dialog box to add the standard rule to the

CTT01 (for ANSI X12) or CNT:202 (for EDIFACT) element.
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The element now contains the total number of line items in the invoice.
18. After using an accumulator to calculate the incremental count of the number

of line items, you can map the ITEMNUM field directly to the IT101 or LIN01
element. Link the application field ITEMNUM in the INVDETAIL record to
one of the following:
v IT101 element in the IT1 segment (for ANSI X12)
v LIN01 element in the LIN segment in the LIN group (for EDIFACT)

QTYSHIP Field
For ANSI X12, the QTYSHIP field can be directly mapped to the IT102 Quantity
Invoiced element in the IT1 segment (IT1 group). However, you also need to count
the quantity invoiced for each line item and load the total quantity in the CTT02
(Hash Total) field.

For EDIFACT, you have already promoted two iterations of the QTY segment in
the LIN group. You can map the QTYSHIP field directly to the QTY:502 Quantity
element in the QTY:5 segment in LIN group. However, you must map a constant
to the Quantity Qualifier (QTY:501 element) and define a qualifying relationship
with the Quantity (QTY:502 element). If the Quantity Qualifier is 12 (despatch
quantity), that iteration of the QTY:5 segment contains the quantity shipped.

You must also count the quantity shipped for each line item and load the total
quantity in the CNT:302 (Hash Total) field. Additionally, you must map a constant
to the Control Qualifier (CNT:301 element) and define a qualifying relationship
with the Monetary Amount (CNT:302) element. If the Control Qualifier is 1 (total
quantity), that iteration of the CNT:3 segment contains the total quantity.

Setting the Quantity Qualifier for EDIFACT
About this task

Use this procedure to set the Quantity Qualifier for the QTY:5 segment.

Procedure
1. Double-click the QTY:501 element (Quantity Qualifier) in the QTY:5 segment in

the LIN group to display the Element Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select 12 to identify this iteration of the QTY:5 segment

as containing the quantity shipped.
5. From the Qualifies list, select 6060:2 QUANTITY to set up a qualifying

relationship with the Quantity element.
6. Click OK. The 12 code is loaded in the Quantity Qualifier element and the

qualifying relationship between the QTY:501 and QTY:502 elements is
established.

Counting the Quantity Invoiced
About this task

Use this procedure to count the quantity invoiced and generate a hash total.

Procedure
1. Double-click one of the following elements:

v IT102 in the IT1 segment in the IT1 group (for ANSI X12)
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v QTY:502 in the QTY:5 segment in the LIN group (for EDIFACT)
This is the field that you typically use to count the quantity invoiced or line
items.
The Element Properties dialog box is displayed.

2. Select the Standard Rule tab.
3. From the standard rule list, select Use Accumulator.
4. Click New to display the Edit Accumulator Entry dialog box.
5. From the Primary Accumulator list, select 1. Before any calculations are

performed on an accumulator, its content is 0. When you use an accumulator,
the system adds a new accumulator to the bottom of this list.

6. In the Name box type Total Quantity. This is a descriptive alias that enables
you to differentiate what the accumulators you create are used for.

7. From the First list, select Sum in primary. This is the first operation that the
system performs. This specifies that the system adds the numeric value (takes
the positive or negative sign of the numbers into account) of the field to the
contents of the Primary Accumulator for each iteration of the PO1 group.

8. Click OK to add the accumulator.
9. Click OK on the Element Properties dialog box to add the standard rule to the

IT102 or QTY:502 element.
10. Double-click one of the following elements:

v CTT02 in the CTT segment (for ANSI X12)
v CNT:302 in the CNT:3 segment (for EDIFACT)
This is the field that typically contains the total quantity of the purchase order.
The Element Properties dialog box is displayed.

11. Select the Standard Rule tab.
12. From the standard rule list, select Use Accumulator.
13. Click New to display the Edit Accumulator Entry dialog box.
14. From the Primary Accumulator list, select primary accumulator 1. This

accumulator currently contains the total quantity.
15. From the First list, select Use primary. This specifies that the system loads the

current value of the accumulator into the CTT02 (Hash Total—for ANSI X12)
or CNT:302 (Control Value—for EDIFACT) element.

16. Click OK to add the accumulator.
17. Click OK on the Field Properties dialog box to add the standard rule to the

element.
The element now contains the total quantity of the purchase order.

Setting the Control Qualifier for EDIFACT
About this task

Use this procedure to set the Control Qualifier for the CNT:3 segment.

Procedure
1. Double-click the CNT:301 element (Control Qualifier) in the CNT:3 segment to

display the Element Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select 1 to identify this iteration of the CNT:3 segment

as containing the total quantity.
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5. From the Qualifies list, select the 6066:3 CONTROL VALUE to set up a
qualifying relationship with the Control Value element.

6. Click OK.
The 1 code is loaded in the Control Qualifier element and the qualifying
relationship between the CNT:301 and CNT:302 elements is established.

Mapping the QTYSHIP Field
After using an accumulator to calculate the quantity invoiced for each line item
and generate a hash total, you can map the QTYSHIP field directly to the IT102 or
QTY:502 element.

About this task

Use this procedure to map the QTYSHIP field.

Procedure
v For ANSI X12: Link the application field QTYSHIP in the INVDETAIL record to

the IT102 element in the IT1 segment (IT1 group).
v For EDIFACT: Link the application field QTYSHIP in the INVDETAIL record to

the QTY:502 element in the QTY:5 segment (LIN group).

QTYORD Field
For ANSI X12: You need to send only one QTY segment (in the IT1 group) to your
trading partner (typically the QTY segment repeats up to 5 times). Therefore, after
you change the max usage of the QTY segment to 1, the QTYORD (quantity
ordered) field can be directly mapped to the QTY02 element. However, you must
map a constant to the Quantity Qualifier (QTY01 element) and define a qualifying
relationship with the Quantity (QTY02 element) to indicate that the QTY02
contains the quantity ordered.

For EDIFACT: You have already promoted two iterations of the QTY segment (in
the LIN group). The QTYORD field can be directly mapped to the QTY:602
Quantity element in the QTY:6 segment (LIN group). However, you must map a
constant to the Quantity Qualifier (QTY:601 element) and define a qualifying
relationship with the Quantity (QTY:602 element). If the Quantity Qualifier is 21
(ordered quantity), that iteration of the QTY:6 segment contains the quantity
ordered.

Changing the Max Use of the QTY Segment for ANSI X12
About this task

Use this procedure to make the QTY a non-repeating segment.

Procedure
1. Right-click the QTY segment (in the IT1 group) and select Properties.
2. Select the Looping tab.
3. In the Max Usage box, type 1 to make the QTY a non-repeating segment. This

box is currently set to 5.
4. Click OK to accept the change to the QTY segment.

Setting the Quantity Qualifier
You already defined all the constants that you are using in this map, so now you
can map the appropriate constant to the Quantity Qualifier element.
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About this task

Use this procedure to set the Quantity Qualifier for the REF segment.

Procedure
1. Double-click one of the following elements:

v QTY01 in the IT1 group (for ANSI X12)
v QTY:601 in the LIN group (for EDIFACT)
This displays the Element Properties dialog box.

2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, do one of the following:

v For ANSI X12: Select the OR constant to identify the Quantity segment as
containing the quantity ordered

v For EDIFACT: Select 21 to identify this iteration of the QTY:6 segment as
containing the quantity ordered

5. From the Qualifies list, select one of the following options to set up a
qualifying relationship with the Quantity element.
v 0380 QUANTITY (for ANSI X12)
v 6060:3 QUANTITY (for EDIFACT)

6. Click OK and the code is loaded in the Quantity Qualifier element.

Mapping the QTYORD Field
About this task

Use this procedure to map the QTYORD field.

Procedure
v For ANSI X12: Link the application field QTYORD in the INVDETAIL record to

the QTY02 element in the QTY segment (IT1 group).
v For EDIFACT: Link the application field QTYORD in the INVDETAIL record to

the QTY:602 element in the QTY:6 segment (LIN group).

UNITPRICE Field
For ANSI X12: The UNITPRICE field can be directly mapped to the IT104 Unit
Price element in the IT1 segment (IT1 group). However, you also need to multiply
the quantity invoiced for each line item by the unit price to obtain the extended
price. You also need to generate a running total of the extended price and load the
final total in the TDS01 (Total Invoice Amount) element.

For EDIFACT: You can map the UNITPRICE field directly to the MOA:1302
Monetary Amount element in the MOA:13 segment (MOA:2 group, LIN group).
However, you must map a constant to the Monetary Amount Type Qualifier
(MOA:1301 element) and define a qualifying relationship with the Monetary
Amount (MOA:1302) element. If the Monetary Amount Type Qualifier is 146 (unit
price), that iteration of the MOA:13 segment contains the unit price.

You must multiply the quantity invoiced for each line item by the unit price to
obtain the extended price. You must also generate a running total of the extended
price and load the final total in the MOA:1402 (Total Invoice Amount) element.
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Setting the Monetary Amount Type Qualifier for EDIFACT
About this task

Use this procedure to set the Monetary Amount Type Qualifier for the MOA:13
segment.

Procedure
1. Double-click the MOA:1301 element in the MOA:2 group to display the

Element Properties dialog box
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select 146 to identify this iteration of the MOA:13

segment as containing the unit price.
5. From the Qualifies list, select the 5004:2 MONETARY AMOUNT to set up a

qualifying relationship with the Quantity element.
6. Click OK.

The 146 code is loaded in the Monetary Amount Type Qualifier element and
the qualifying relationship between the MOA:1301 and MOA:1302 elements is
established.

Obtaining the Extended Price
About this task

Use this procedure to multiply the quantity invoiced for each line item by the unit
price to obtain the extended price.

Procedure
1. Double-click one of the following elements:

v IT102 element in the IT1 group (for ANSI X12)
v QTY:502 in the LIN group (for EDIFACT)
This is the field that you typically use to count the quantity invoiced. The
Element Properties dialog box is displayed.

2. Select the Standard Rule tab.

Note: The Standard Rule list already shows that Use Accumulator is selected.
3. Click New to display the Edit Accumulator Entry dialog box.
4. From the Primary Accumulator list, select 2. This number is a name by which

the accumulator is referred. Before any calculations are performed on an
accumulator, its content is 0. When you use an accumulator, the system adds a
new accumulator to the bottom of this list.

5. In the Name box, type Extended Price. This is a descriptive alias that enables
you to differentiate what the accumulators you create are used for.

6. From the First list, select Load primary. This is the first operation that the
system performs. This specifies that the system loads the contents of the
element group into the Primary Accumulator for each iteration of the IT1 or
QTY:5 group.

7. Click OK to add the accumulator.
8. Click OK on the Element Properties dialog box to add the standard rule to the

IT102 or QTY:502 element.
9. Double-click one of the following elements:

v IT104 element in the IT1 group (for ANSI X12)
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v MOA:1302 in the LIN group (for EDIFACT)
This is the field that contains the unit price for each line item. The Element
Properties dialog box is displayed.

10. Select the Standard Rule tab.
11. From the standard rule list, select Use Accumulator.
12. Click New to display the Edit Accumulator Entry dialog box.
13. From the list, select primary accumulator 2.
14. From the First list, select Multiply with primary. This is the first operation

that the system performs. This specifies that the system multiplies the value of
the element with the contents of the primary accumulator, and stores the
result in the primary accumulator for each iteration of the group.

15. Click OK to add the accumulator.
16. Click OK on the Element Properties dialog box to add the standard rule to the

element.

Tip: If there is an extended price element in your EDI file, load the total from
the extended price calculation into that element. To do this, use an
accumulator on that extended price element that specifies "Use primary" for
accumulator 2.

Generating a Running Total
About this task

Use this procedure to generate a running total of the extended price.

Procedure
1. Double-click one of the following elements:

v IT104 in the IT1 group (for ANSI X12)
v MOA:1302 in the LIN group (for EDIFACT)
This is the field that contains the unit price for each line item.
The Element Properties dialog box is displayed.

2. Select the Standard Rule tab.

Note: The Standard Rule list already shows that Use Accumulator is selected.
3. Click New to display the Edit Accumulator Entry dialog box.
4. From the Primary Accumulator list, select primary accumulator 3.
5. In the Name box, type Running Total.
6. From the First list, select Add primary to alternate. This specifies that the

system adds the contents of the primary accumulator to the contents of the
alternate accumulator, and stores the result in the primary accumulator for each
iteration of the group.

7. From the Alternate Accum list, select 2. This operation specifies that the system
add the value of accumulator 2 (which contains the extended price for a line
item) to the value of accumulator 3. The system stores the sum in accumulator
3, which therefore contains a running total of the extended price with each
iteration of the group.

8. Click OK to add the accumulator.
9. Click OK to add the standard rule to the element.
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Loading the Running Total
About this task

Use this procedure to load the running total of the extended price into the TDS01
(Total Invoice Amount) element.

Procedure
1. Double-click one of the following elements:

v TDS01 in the TDS segment (for ANSI X12)
v MOA:1402 in the summary section of the map (for EDIFACT)
The Element Properties dialog box is displayed.

2. Select the Standard Rule tab.
3. From the standard rule list, select Use Accumulator.
4. Click New to display the Edit Accumulator Entry dialog box.
5. From the list, select primary accumulator 3.
6. From the First list, select Use primary. This specifies that the system loads the

contents of the primary accumulator into the element.
7. Click OK to add the accumulator.
8. Click OK on the Element Properties dialog box to add the standard rule to the

element.

Mapping the UNITPRICE Field
After using accumulators to multiply the quantity invoiced for each line item by
the unit price to obtain the extended price and generate a running total of the
extended price, map the UNITPRICE field directly to the element.

About this task

Use this procedure to map the UNITPRICE field.

Procedure
v For ANSI X12: Link the application field UNITPRICE in the INVDETAIL record

to the IT104 element in the IT1 segment (IT1 group).
v For EDIFACT: Link the application field UNITPRICE in the INVDETAIL record

to the MOA:1302 element in the MOA:13 segment (in the MOA:2 group in the
LIN group).

Mapping the UOM Field
About this task

Use this procedure to map the UOM field.

Procedure
v For ANSI X12: Link the application field UOM in the INVDETAIL record to the

IT103 element in the IT1 segment (IT1 group).
v For EDIFACT: You have already mapped the quantity shipped to the QTY:5

segment and the quantity ordered to the QTY:6 segment. Now, you must map
the unit of measure to both segments.
1. Link the application field UOM in the INVDETAIL record to the QTY:503

element in the QTY:5 segment (LIN group).
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2. Link the application field UOM in the INVDETAIL record to the QTY:603
element in the QTY:6 segment (LIN group).

Customer Product Code and Your UPC Code
For ANSI X12: You can map the CUSTPROCODE (customer product code) and
UPCCODE (your UPC code) fields directly to two Product/Service ID elements in
the IT1 segment.

For EDIFACT: You can map the CUSTPROCODE (customer product code) field
directly to the LIN03 element in the LIN segment in the LIN group. You can also
map the UPCCODE (your UPC code) field directly to the PIA:202 element in the
PIA:2 segment (in the LIN group).

However, you must map a constant to each element and establish a qualifying
relationship. For ANSI, these elements are called the Product/Service ID elements.
For EDIFACT, these elements are called the Item Number Type, Coded elements.
This enables you to specify which element contains your partner’s product code,
and which contains your UPC code.

Setting the Elements
About this task

Use this procedure to set the elements.

Procedure
1. For the CUSTPROCODE, double-click one of the following elements:

v IT106 in the IT1 group (for ANSI X12)
v LIN04 in the LIN group (for EDIFACT)
This displays the Element Properties dialog box.

2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select the BP constant (buyer’s part number), to

identify the element as containing the customer product code.
5. From the Qualifies list, select one of the following to set up a qualifying

relationship with the Product/Service ID element:
v 0234 PRODUCT/SERVICE ID (for ANSI X12)
v 7140 ITEM NUMBER (for EDIFACT)

6. Click OK and the BP code is loaded in the element and the qualifying
relationship between the elements is established.

7. For your UPCCODE, double-click one of the following:
v For ANSI X12: IT108 element (Product/Service ID Qualifier) in the IT1

segment in the IT1 group
v For EDIFACT: PIA:203 element (Item Number Type, Coded) in the PIA:2

segment in the LIN group
This displays the Element Properties dialog box.

8. Select the Standard Rule tab.
9. From the standard rule list, select Use Constant.

10. From the Constants list, select one of the following:
v For ANSI X12: UI constant (UPC identification), to identify the IT109

element as containing the UPC code
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v For EDIFACT: UP constant (UPC Code) to identify the PIA:202 element as
containing your UPC Code

11. From the Qualifies list, select one of the following to set up a qualifying
relationship with the element:
v 0234:2 PRODUCT/SERVICE ID (for ANSI X12)
v 7140:7 ITEM NUMBER (for EDIFACT)

12. Click OK.
The code is loaded in the element and the qualifying relationship between the
elements is established.

Setting the Product ID Function Qualifier for EDIFACT
About this task

Use this procedure to set a constant for the Product ID Function Qualifier element.

Procedure
1. Double-click the PIA:201 element in the LIN group to display the Element

Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select the second 1 constant (additional information) to

identify the PIA:202 element as containing additional product information.
5. From the Qualifies list, select 7140:7 ITEM NUMBER to set up a qualifying

relationship with the Item Number element.
6. Click OK. The 1 code is loaded in the Product ID Function Qualifier element

and the qualifying relationship between the PIA:201 and PIA:202 elements is
established.

Mapping the CUSTPROCODE/UPCCODE Fields
You need to map information from a cross-reference table for the Petzone partner
profile to translate your partner’s code for a purchased item to your code for the
same item.

About this task

Your partner uses a customer product code (CUSTPROCODE), and your company
uses a UPC code (UPCCODE). After you and your partner determine what the
equivalent customer product code is for each UPC code, you can create a
cross-reference table in the Partner Editor and use that information in your map.
For this tutorial, use the cross-reference table included in the tutorial data. See
Cross-reference Tables for more information.

You need to use a standard rule to map the translated value from the
CUSTPROCODE field to the UPCCODE field.

Use this procedure to map the customer’s item code and then translate your
partner’s customer product code to your UPC code for each item your partner
ordered.

Procedure
1. If the Linking function is not currently active, click Link.
2. Do one of the following:
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v For ANSI X12: Link the PO107 element in the PO1 segment (in the PO1
group) to the application field CUSTPROCODE in the PODETAIL record.

v For EDIFACT: Link the LIN03 element in the LIN segment (in the LIN
group) to the application field CUSTPROCODE in the PODETAIL record.

v For TRADACOMS: Link the OLD:2 CPRO CPR1 element (Customer’s Item
Code) to the application field CUSTPROCODE in the PODETAIL record.

3. Double-click the CUSTRPOCODE field (in the PODETAIL record).
The Field Properties dialog box is displayed.

4. Select the Standard Rule tab.
5. From the Standard Rule list, choose Select.
6. From the Table and Key box, select Partner cross-reference by partner item.

This indicates that you are using a cross-reference table and translating by
your item.

7. In the Sub Table box, type PRODCODE. This is the name of the
cross-reference table.

8. Select the check box to signal the system that if this translation fails, you want
the system to generate an error.

9. From the Map From list on the left, select My Item. This is the field from
which the contents are mapped.

10. From the Map To list on the right, select UPCCODE.
The Standard Rule tab of the Field Properties dialog box should look similar
to the following. (This is an ANSI X12 example; some details may be different
for EDIFACT and TRADACOMS.)

11. Click OK to map from the cross-reference table.

Item Description
For ANSI X12: You need to send only one PID:2 segment (in the PID subgroup in
the IT1 group) to your trading partner (typically the PID subgroup repeats up to
1,000 times). Therefore, after you change the max usage of the PID subgroup to 1,
the ITEMDESC (item description) field can be directly mapped to the PID:205
element. However, you must map a constant to the Item Description Type (PID:201
element) and define a qualifying relationship with the Description (PID:205
element) to indicate that the PID2:05 contains a free-form item description.
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Complete the following tasks:
v Changing the Max Use of the PID Subgroup
v Setting the Item Description Type
v Mapping the ITEMDESC Field
v Changing the Max Use of the ITD:2 Segment
v Mapping the TERMS Fields

For EDIFACT: Since you have already promoted one instance of the IMD segment
in the LIN group, you can map the ITEMDESC (item description) field directly to
the IMD:306 element. To map the item description, see Mapping the ITEMDESC
Field.

Changing the Max Use of the PID Subgroup
You have determined that you only send your partner one PID:2 segment (in the
PID subgroup in the IT1 group), so you must change the maximum usage allowed
for that subgroup from 1,000 to 1.

About this task

Use this procedure to change the maximum usage of the PID subgroup.

Procedure
1. Right-click the PID subgroup (in the IT1 group) and select Properties.
2. Select the Looping tab.
3. In the Maximum Usage box, type 1 to make the PID subgroup a non-repeating

group. This box is currently set to 1,000.
4. Click OK to accept the change to the PID subgroup.

Setting the Item Description Type
About this task

Use this procedure to set the Item Description Type (in the PID:2 segment in the
PID subgroup in the IT1 group).

Procedure
1. Double-click the PID:201 element in the IT1 group to display the Element

Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select the F constant (free-form), to identify the PID:201

element as containing the free-form item description.
5. From the Qualifies list, select 0352 DESCRIPTION, to set up a qualifying

relationship with the Description element.
6. Click OK and the F code is loaded in the Item Description Type element and

the qualifying relationship between the PID:201 and PID:205 elements is
established.

Mapping the ITEMDESC Field
About this task

Use this procedure to map the ITEMDESC field.
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Procedure
v For ANSI X12: Link the application field ITEMDESC in the INVDETAIL record

to the PID:205 element in the PID:2 segment (PID subgroup, IT1 group).
v For EDIFACT: Link the application field ITEMDESC in the INVDETAIL record

to the IMD:306 element in the IMD:3 segment (LIN group).

Changing the Max Use of the ITD:2 Segment
About this task

Use this procedure to make the ITD:2 a non-repeating segment.

Procedure
1. Right-click the ITD:2 segment (in the IT1 group) and select Properties.
2. Select the Looping tab.
3. In the Max Usage field, type 1 to make the ITD:2 a non-repeating segment. This

field is currently set to 2.
4. Click OK to accept the change to the ITD:2 segment.

Mapping the TERMS Fields
About this task

Use this procedure to map both the TERMSTYPE field and the TERMSDISP field.

Procedure
1. Link the application field TERMSTYPE in the INVDETAIL record to the

ITD:201 element in the ITD:2 segment (IT1 group).
2. Link the application field TERMSDISP in the INVDETAIL record to the

ITD:203 element in the ITD:2 segment (IT1 group).

INVCommentGroup: INVCOMMENT Record for TRADACOMS

INVCOMMENT Record
The INVCommentGroup (comment information) groups all the comment
information for the invoice, including the message text. The INVCommentGroup is
mandatory and occurs up to ten times per invoice translated.

The INVCOMMENT (comment record) record contains the message text. The first
comment record is mandatory and occurs once per invoice translated (once for
each comment line).

The following fields are part of the application file format key, but do not contain
data that the system needs to generate the invoice. Therefore, you do not need to
map these fields:

BILLTOACCTCMT

DOCTYPCMT

INVNUMCMT
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Mapping the MESSAGETEXT Fields
The message text (comment) information is contained in the DNA segment (Data
Narrative). The MESSAGETEXT1, MESSAGETEXT2, MESSAGETEXT3, and
MESSAGETEXT4 fields can all be directly mapped to elements in the DNA
segment.

About this task

Use this procedure to map the Message Text fields.

Procedure
1. If the Linking function is not currently active, click Link.

Note: The application fields you are linking from are all in the INVCOMMENT
record.

2. Click the application field MESSAGETEXT1 and click the DNA GNAR GNA0
element.

3. Click the application field MESSAGETEXT2 and click the DNA GNAR GNA1
element.

4. Click the application field MESSAGETEXT3 and click the DNA GNAR GNA2
element.

5. Click the application field MESSAGETEXT4 and click the DNA GNAR GNA3
element.

INVCommentGroup: INVDETAIL Record for TRADACOMS

About the INVDETAIL Record for TRADACOMS
The following topics describe the actions necessary for you to map from each field
in the INVDETAIL (detail) record. The INVDETAIL (detail) record contains line
item number and description, quantity shipped, unit of measure, price, product
code, and VAT calculation information. The detail record is mandatory and occurs
up to 200,000 times per invoice translated (once for each line item invoiced).

The following fields are part of the application file format key but do not contain
data that the system needs to generate the invoice. Therefore, you do not need to
map these fields:

BILLTOACCDET

DOCTYPDET

INVNUMDET

Mapping the ITEMNUM Field
The ITEMNUM field can be directly mapped to the ILD:2 SEQB element (2nd
Level Sequence No.), by using the Link function, because the number of the line
item is the second level sequence number. The second level of the invoice is the
line item details.

About this task

Use this procedure to map the second level sequence number (item number).
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Procedure
1. If the Linking function is not currently active, click Link.
2. Click the application field ITEMNUM in the INVDETAIL record.
3. Click the ILD:2 SEQB element (2nd Level Sequence No.).

A line is displayed, visually illustrating the link between the ITEMNUM field
and the ILD:2 SEQB element.

QTYSHIP Field
On the EDI side of the map, the quantity shipped information is contained in the
ILD:2 QTYI QTY0 element (Number of Order Units Invoiced). The ILD:2 QTYI
QTY0 element is defined as a string-type element in the standard. However, you
have determined that you will send your partner a number-type element in N0
format (formatted with an implicit decimal point and no decimal places).

Therefore, you will need to change the properties of the ILD:2 QTYI QTY0 element
to reflect the type and the format that you have determined that your partner will
send you. Then, you can map the quantity shipped directly from the QTYSHIP
field to the ILD:2 QTYI QTY0 element.

Changing the Properties of the ILD:2 QTY1 QTY0 Element
About this task

Use this procedure to change the type and format of the ILD:2 QTY1 QTY0
element.

Procedure
1. Double-click the ILD:2 QTY1 QTY0 element (Number of Order Units Invoiced)

to display the Element Properties dialog box.
2. Select the Validation tab.
3. From the data-type list, select Number to indicate that this is a number

element. The system prompts you with a message that changing the field’s data
type invalidates its format. Click Yes to acknowledge this message and proceed.

4. From the Format list, select N0 to indicate that this element will be formatted
with an implicit decimal point and no decimal place.

Mapping the Number of Order Units Invoiced
After changing the type and format of the ILD:2 QTYI QTY0 element, you can map
the QTYSHIP field directly to it.

About this task

Use this procedure to map the quantity shipped.

Procedure
1. If the Linking function is not currently active, click Link.
2. Click the application field QTYSHIP in the INVDETAIL record.
3. Click the ILD:2 QTY1 QTY0 element (Number of Order Units Invoiced).

Mapping the UNITPRICE Field
About this task

Use this procedure to map the cost price (excluding VAT).
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Procedure
1. If the linking function is not currently active, click Link.
2. Click the application field UNITPRICE in the INVDETAIL record.
3. Click the ILD:2 AUCT AUC0 element (Cost Price (Excluding VAT)).

Mapping the UOM Field
You mapped the quantity shipped to the QTYI composite and the unit price to the
AUCT composite. Therefore, you want to map the unit of measure to both
composites.

About this task

Use this procedure to map the unit of measure.

Procedure
1. If the linking function is not currently active, click Link.
2. Click the application field UOM in the INVDETAIL record.
3. Click the ILD:2 QTY1 CD04:2 element (Measure Indicator).
4. Click the application field UOM in the INVDETAIL record again.
5. Click the ILD:2 AUCT CD04:3 element (Measure Indicator).

Mapping the CUSTPROCODE Field
About this task

Use this procedure to map the customer’s item code (customer product code).

Procedure
1. If the linking function is not currently active, click Link.
2. Click the application field CUSTPROCODE in the INVDETAIL record.
3. Click the ILD:2 CPRO CPR1 element (Customer’s Item Code).

Mapping the UPCCODE Field
About this task

Use this procedure to map the supplier’s code for the traded unit (UPC code).

Procedure
1. If the linking function is not currently active, click Link.
2. Click the application field UPCCODE in the INVDETAIL record.
3. Click the ILD:2 SPRO CPR1 element (Supplier’s Code for the Traded Unit).

Mapping the ITEMDESC Field
About this task

Use this procedure to map the traded unit description (item description).

Procedure
1. If the linking function is not currently active, click Link.
2. Click the application field ITEMDESC in the INVDETAIL record.
3. Click the ILD:2 TDES TDE0 element (Traded Unit Descr. Line 1).
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VATCODE Field
For this map, you need to map the appropriate VAT rate based on the code in the
VATCODE field from a lookup table, to look up data that you will map (via
standard rule) to the TEMPVATRATE field. If you need to use tables, you must
decide whether to create a code table in the Application Integration subsystem that
can only be used with this map, or to add the table to either the partner
relationship or the internal system partner in Partner Editor. You will set up the
table you use in this tutorial under the internal system partner (Internal System
User) so it can be used globally.

In this tutorial, you need to extract information from a lookup table to be inserted
into the outbound data. A lookup table is used when you want to supplement data
before it is sent to your partner.

Note: You do not need to create this lookup table (INVATCO.LKP). It is included
with the tutorial data that is provided when you install Sterling Gentran:Server.

Mapping the VAT Rate
About this task

Use this procedure to look up the appropriate VAT rate for the specified VAT code.

Procedure
1. Double-click the VATCODE field (in the INVDETAIL record). The Field

Properties dialog box is displayed.
2. Select the Standard Rule tab.
3. From the standard rule list, choose Select.
4. From the Table list, select Division lookup. This indicates that the key is the

partner lookup table name for the Internal System User partner and enables
you to map from any field on the Lookup Entry dialog box of the Partner
Editor.

5. In the sub-table box, type VATCODES. This is the name of the lookup table
you imported.

6. From the Map From list on the left, select Text 1. This is the box on the Lookup
Entry dialog box of the Partner Editor from which the contents will be mapped.

7. From the Map To list on the right, select TEMPVATRATE. This is the box to
which the information from the Partner Editor will be mapped.
The Standard Rule tab of the Field Properties dialog box should now look like
this:
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8. Click OK to map from the lookup table to the TEMPVATRATE field.

Mapping the VAT Rate Category Code
About this task

Use this procedure to map the VAT rate category code (VAT code).

Procedure
1. If the Linking function is not currently active, click Link.
2. Click the application field VATCODE in the INVDETAIL record.
3. Click the ILD:2 CD12 element (VAT Rate Category Code).

Mapping the TEMPVATRATE Field
You already used a division lookup table and a standard rule on the VATCODE
field to map the appropriate VAT rate (based on the code in the VATCODE field)
from the VATCODES division lookup table to the TEMPVATRATE field. To map
from the partner database to the TEMPVATRATE field, the target field
(TEMPVATRATE) needed to be a string-type field. However, in order to map the
TEMPVATRATE field to the ILD:2 VATP element (VAT rate percentage), you need
to convert the TEMPVATRATE field to a number-type. You will use an extended
rule to perform the conversion and the mapping.

About this task

Use this procedure to create an extended rule to convert the TEMPVATRATE field
from a string-type to a number-type field and map the TEMPVATRATE field to the
ILD:2 VATP element (VAT rate percentage).

Procedure
1. Double-click the ILD:2 VATP element (VAT rate percentage) to display the

Element Properties dialog box.
2. Select the Extended Rule tab.
3. In the Rule list, type the following:

#VATP = ATON($INVDETAIL.#TEMPVATRATE);
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ATON is a numerical function that converts strings into real numbers, which
enables you to convert a string type field to a number-type field. The #VATP =
maps the resulting real number to the ILD:2 VATP element. The system
executes this rule when it processes the ILD:2 VATP element.

4. Click Compile to validate the syntax of the extended rule.

Note: The Compile function will compile the rule interactively, and allow you
to correct any errors that are generated. Any errors or warnings generated in
the compilation process will be displayed in the Compile Errors list.

5. Click OK to exit the Element Properties dialog box.

TEMPLEXC Field

Calculating the Extended Price
You need to calculate the extended price (quantity shipped multiplied by unit cost)
for each line item and load that extended price into the TEMPLEXC field. Then,
the TEMPLEXC field can be directly mapped to the ILD:2 LEXC element (Extended
Line Cost (Excluding VAT)).

About this task

Use this procedure to multiply the quantity shipped for each line item by the unit
price to obtain the extended price.

Procedure
1. Double-click the QTYSHIP field (in the INVDETAIL segment).

The Field Properties dialog box is displayed.
2. Select the Standard Rule tab.
3. From the standard rule list, choose Use Accumulator.
4. Click New to display the Edit Accumulator Entry dialog box.
5. From the Primary Accumulator drop-down list, select 0. This number is a

name by which the accumulator will be referred. Before any calculations are
performed on an accumulator, its content is 0. When you use an accumulator,
the system adds a new accumulator to the bottom of this drop-down list.

6. In the Name box, type Extended Price. This is a descriptive alias that enables
you to differentiate what the accumulators you create are used for.

7. From the First list, select Load primary. This is the first operation that the
system performs. This specifies that the system loads the contents of the field
into the Primary Accumulator for each iteration of the INVDETAIL segment.

Note: The First box is active only after you select a Primary Accumulator.
8. Click OK to add the accumulator.
9. Click OK on the Field Properties dialog box to add the standard rule to the

QTYSHIP field.
10. Double-click the UNITPRICE field (in the INVDETAIL segment).

The Field Properties dialog box is displayed.
11. Select the Standard Rule tab.
12. From the standard rule list, choose Use Accumulator.
13. Click New to display the Edit Accumulator Entry dialog box.
14. From the list, select primary accumulator 0.
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15. From the First list, select Multiply with primary. This is the first operation
that the system performs. This specifies that the system multiplies the value of
the UNITPRICE field with the contents of the primary accumulator, and stores
the result in the primary accumulator for each iteration of the INVDETAIL
segment.

Note: The First box is active only after you select a Primary Accumulator.
16. Click OK to add the accumulator.
17. Click OK on the Field Properties dialog box to add the standard rule to the

UNITPRICE field.
18. Double-click the TEMPLEXC field (in the INVDETAIL segment). The Field

Properties dialog box is displayed.
19. Select the Standard Rule tab.
20. From the standard rule list, choose Use Accumulator.
21. Click New to display the Edit Accumulator Entry dialog box.
22. From the list, select primary accumulator 0.
23. From the First list, select Use primary. This specifies that the system loads the

contents of the primary accumulator into the TEMPLEXC field.
24. Click OK to add the accumulator.
25. Click OK on the Field Properties dialog box to add the standard rule to the

TEMPLEXC field.
This loads the extended price for the current line item into the TEMPLEXC
field.

Mapping the Extended Line Cost (Excluding VAT)
About this task

Use this procedure to map the extended line cost (excluding VAT).

Procedure
1. If the Linking function is not currently active, click Link.
2. Click the application field TEMPLEXC in the INVDETAIL record.
3. Click the ILD:2LEXC element (Extended Line Cost (Excluding VAT)).

INVCommentGroup: TEMPVATSTL Record for TRADACOMS

The TEMPVATSTL Record
The following topics describe the actions necessary for you to map from each field
in the TEMPVATSTL record (temporary storage for VAT subtotals). The
TEMPVATSTL record contains temporary storage fields to enable VAT subtotal
calculations. The temporary storage record is conditional and occurs up to 20 times
per invoice translated (once for each possible VAT code subtotal).

The following fields are part of the application file format key but do not contain
data that the system needs to generate the invoice. Therefore, you do not need to
map these fields.

BILLTOACCTS

DOCTYPS
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INVNUMS

Mapping the SEQA Field
The SEQA field will be used in an extended rule later in this tutorial, to calculate
the subtotals for the various VAT tax rates used in this invoice, and to produce a
summary of all the VAT rates. The SEQA field can be directly mapped to the STL
SEQA:7 element (First Level Sequence Number), by using the Link function.

About this task

Use this procedure to map the first level sequence number (SEQA).

Procedure
1. If the Linking function is not currently active, click Link.
2. Click the application field SEQA in the TEMPVATSTL record.
3. Click the STL SEQA:7 element (First Level Sequence Number).

Mapping the VATRATE Field
The VATRATE field will be used in an extended rule later in this tutorial, to
calculate the subtotals for the various VAT tax rates used in this invoice, and to
produce a summary of all the VAT rates. The VATRATE field can be directly
mapped to the STL VATP:2 element (VAT Rate Percentage), by using the Link
function.

About this task

Use this procedure to map the VAT rate percentage (VATRATE).

Procedure
1. If the Linking function is not currently active, click Link.
2. Click the application field VATRATE in the TEMPVATSTL record.
3. Click the STL VATP:2 element (VAT Rate Percentage).

Mapping the VATRATECODE Field
The VATRATECODE field will be used in an extended rule later in this tutorial, to
calculate the subtotals for the various VAT tax rates used in this invoice, and to
produce a summary of all the VAT rates. The VATRATECODE field can be directly
mapped to the STL CD12:2 element (VAT Rate Category Code), by using the Link
function.

About this task

Use this procedure to map the VAT rate category code (VATRATECODE).

Procedure
1. If the Linking function is not currently active, click Link.
2. Click the application field VATRATECODE in the TEMPVATSTL record.
3. Click the STL CD12:2 element (VAT Rate Category Code).

Mapping the NUMLINES Field
The NUMLINES field will be used in an extended rule later in this tutorial, to
calculate the subtotals for the various VAT tax rates used in this invoice, and to
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produce a summary of all the VAT rates. The NUMLINES field can be directly
mapped to the STL NRIL element (Number of Line Items), by using the Link
function.

About this task

Use this procedure to map the number of line items (NUMLINES).

Procedure
1. If the Linking function is not currently active, click Link.
2. Click the application field NUMLINES in the TEMPVATSTL record.
3. Click the STL NRIL element (Number of Line Items).

Mapping the LVLA Field
The LVLA field will be used in an extended rule later in this tutorial, to calculate
the subtotals for the various VAT tax rates used in this invoice, and to produce a
summary of all the VAT rates. You will use the Link function to directly map the
LVLA field to three different elements in the EDI file: the STL LVLA element (Lines
Sub-Total (Excluding VAT)), the STL EVLA element (Extended Sub-Total Amount
(Excluding VAT)), and the STL ASDA element (Extended Sub-Total Amount (After
Settlement Discount Has Been Approved)).

About this task

Use this procedure to map the line subtotal amount (LVLA).

Procedure
1. If the Linking function is not currently active, click Link.

Note: The application fields you are linking from are all in the TEMPVATSTL
record.

2. Click the application field LVLA and click the STL LVLA element.
3. Click the application field LVLA and click the STL EVLA element.
4. Click the application field LVLA and click the STL ASDA element.

Mapping the VATA Field
The VATA field will be used in an extended rule later in this tutorial, to calculate
the subtotals for the various VAT tax rates used in this invoice, and to produce a
summary of all the VAT rates. The VATA field can be directly mapped to the STL
VATA element (VAT Amount Payable), by using the Link function.

About this task

Use this procedure to map the VAT Amount Payable (VATA).

Procedure
1. If the Linking function is not currently active, click Link.
2. Click the application field VATA in the TEMPVATSTL record.
3. Click the STL VATA element (VAT Amount Payable).
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INVCommentGroup: INVSUMMARY Record

Mapping Totals
The following topics describe the actions necessary for you to map from each field
in the INVSUMMARY (summary) record. The INVSUMMARY record contains the
total invoice amount and the total transaction amount. The summary record is
mandatory and occurs once per invoice translated.

About this task

The following fields are part of the application file format key but do not contain
data that the system needs to generate the invoice. Therefore, you do not need to
map these fields.
v BILLTOACCTSUM
v DOCTYPSUM
v INVNUMSUM

TOTALAMOUNT Field

Mapping the TOTALAMOUNT Field
For the system to create output segments, there must be at least one explicit link to
an element in that segment, and data to support that link. Therefore, even though
you are mapping the total amount with accumulators or extended rules, you must
add an explicit link with an application field that contains data.

About this task

Use this procedure to map the TOTALAMOUNT Field.

Procedure
v For ANSI X12: Link the application field TOTALAMOUNT in the

INVSUMMARY record to the TDS01 element in the TDS segment.
v For EDIFACT: You must also map a constant to the Monetary Amount Type

Qualifier (MOA:1401 element) and define a qualifying relationship with the
Monetary Amount (MOA:1402) element. If the Monetary Amount Type Qualifier
is 128 (total amount), that iteration of the MOA:14 segment contains the total
invoice amount. Complete the following tasks:
1. Setting the Monetary Amount Type Qualifier
2. Mapping the Total Monetary Value Summary

v For TRADACOMS: Link the application field TOTALAMOUNT in the
INVSUMMARY record to the TLR TPSI element (Total Payable Inc. Settlement).

Setting the Monetary Amount Type Qualifier
You must map a constant to the Monetary Amount Type Qualifier (MOA:1401
element) and define a qualifying relationship with the Monetary Amount
(MOA:1402) element.

About this task

You have already defined the constants that you will use for this map. Now map
the appropriate constant to the Monetary Amount Type Qualifier element.
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Use this procedure to set the Monetary Amount Type Qualifier for the MOA:14
segment.

Procedure
1. Double-click the MOA:1401 element MOA:2 group to display the Element

Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select 128 to identify this iteration of the MOA:14

segment as containing the total invoice amount.
5. From the Qualifies list, select 5004:3 MONETARY AMOUNT to set up a

qualifying relationship with the Quantity element.
6. Click OK. The 128 code is loaded in the Monetary Amount Type Qualifier

element and the qualifying relationship between the MOA:1401 and MOA:1402
elements is established.

Mapping the Total Monetary Value Summary
About this task

Use this procedure to map the total monetary value summary.

Procedure

Link the application field TOTALAMOUNT in the INVSUMMARY record to the
MOA:1402 element in the MOA:14 segment (in the MOA:2 group).

TRANSTOTAL Field

Mapping the TRANSTOTAL Field - ANSI X12 and EDIFACT
For the system to create output segments, there must be at least one explicit link to
an element in that segment, and data to support that link. Therefore, even though
you are mapping the transaction total with accumulators, you must add an explicit
link with an application field that contains data.

About this task

Use this procedure to map the TRANSTOTAL field.

Procedure
1. For ANSI X12; Link the application field TRANSTOTAL in the INVSUMMARY

record to the CTT01 element in the CTT segment.
2. For EDIFACT: Additionally, you must map a constant to the Control Qualifier

(CNT:201 element) and define a qualifying relationship with the Monetary
Amount (CNT:202) element. If the Control Qualifier is 2 (number of line items
in message), that iteration of the CNT:2 segment contains the total number of
line items. Complete the following tasks:
a. Setting the Control Qualifier
b. Mapping the Total Transaction Amount

Setting the Control Qualifier
You must map a constant to the Control Qualifier (CNT:201 element) and define a
qualifying relationship with the Control Value (CNT:202) element.
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About this task

You have already defined all the constants that you will use for this map. Now
map the appropriate constant to the Control Qualifier element.

Use this procedure to set the Control Qualifier for the CNT:2 segment.

Procedure
1. Double-click the CNT:201 element (Control Qualifier) in the CNT:2 segment to

display the Element Properties dialog box.
2. Select the Standard Rule tab.
3. From the standard rule list, select Use Constant.
4. From the Constants list, select 2 to identify this iteration of the CNT:2 segment

as containing the total number of line items.
5. From the Qualifies list, select 6066:2 CONTROL VALUE to set up a qualifying

relationship with the Control Value element.
6. Click OK.

The 2 code is loaded in the Control Qualifier element and the qualifying
relationship between the CNT:201 and CNG:202 elements is established.

Mapping the Total Transaction Amount
About this task

Use this procedure to map the transaction totals.

Procedure

Link the application field TRANSTOTAL in the INVSUMMARY record to the
CNT:202 element in the CNT:2 segment.

VAT Summary - TRADACOMS
Subtotals for VAT Rates

To calculate the subtotals (STL) for the various VAT rates, you must first determine
which VAT code is used for each line item. By grouping the line items that use the
same VAT code, you can determine the VAT rate percentage, and then calculate the
total VAT amount payable for each VAT code. Then, you can add the extended cost
for each line item that uses the same VAT code together. Finally, by adding the
total VAT amount payable (VATA) with the total extended cost (ASDA), you have
calculated the sub-total amount (APSI) for each group of line items with the same
VAT code.

To perform these calculations, you also will need to track the sequence numbers of
each subtotal (STL), the VAT code and corresponding VAT percentage rate for each
STL, and the total number of line items that use each VAT code.

This table provides an example of an application file that contains six line items
that use three different VAT codes.

Line Item
Number Item VAT Code

Extended Cost (Quantity
Shipped * Unit Price)

1 Item 1 S 100

2 Item 2 E 50

122 IBM Sterling Gentran:Server for Windows: Application Integration Tutorial for Outbound Invoices



Line Item
Number Item VAT Code

Extended Cost (Quantity
Shipped * Unit Price)

3 Item 3 S 200

4 Item 4 Z 70

5 Item 5 S 150

6 Item 6 E 300

This table provides the corresponding VAT percentage rates for the VAT codes in
the sample application file.

VAT Code Description VAT Percentage Rate

S Standard rate 17.5

E Export item 0

Z Zero rate 0

Using this information, you can calculate the required VAT summary information.

STL
Sequence
Number

VAT
Code

Number of Line
Items Using this
VAT Code

Total Extended
Cost (ASDA)

Total VAT
Amount
(VATA)

Subtotal
Amount
(APSI)

1 S 3 450 18 468

2 E 2 350 0 350

3 Z 1 70 0 70

Extended Rule on the Input Group

To perform the required VAT calculations in this tutorial, you will use two
extended rules. The first extended rule you will define is an On End rule on the
INPUT (application file) group that will be executed when the system concludes its
processing of the application file. For each VAT code used, the first rule will
calculate the total VAT amount payable and the extended cost for each set of line
items. The second extended rule you will define is on the STL APSI element, and
will be executed when the system concludes its processing of that element. The
second rule will add the total VAT amount payable (VATA) to the total extended
cost (ASDA), to calculate the sub-total amount (APSI) for each group of line items
with the same VAT code.

The first extended rule (on the INPUT group) will involve many different
calculations. So, you determine that it will be easiest if you break the various tasks
involved into manageable pieces, and write the rule for that part before building
all the parts into the whole rule. This process is outlined in the steps below.

This table illustrates the extended rule.
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Stage Description

1 You need to define two temporary variables (i and j), a variable defined to count the number of line
items (invlimit), and a variable to count the number of STL segments (stllimit) that is initialized to zero.

integer i,j,invlimit,stllimit;
invlimit = count($INVDETAIL[*]);
stllimit = 0;

You need to visit each iteration of the INVDETAIL record.

i=1;
while i<=invlimit do
begin
.
.
i=i+1
end

2 For each iteration of the INVDETAIL record, you need to determine the VAT code used, and ascertain
whether or not a TEMPVATSTL (STL) record exists for that VAT code.

j=1;
while j<=stllimit do
begin

if $INVDETAIL[i].#VATCODE = $TEMPVATSTL[j].#VATRATECODE then
begin
.
.
end

j=j+1
end

3 If a TEMPVATSTL record does exist for that VAT code, you need to add the extended cost for that line
item into the total extended cost for this STL, and increase the number of line items in this STL by one.

begin
$TEMPVATSTL[j].#LVLA = $TEMPVATSTL[j].#LVLA + $INVDETAIL[i].#TEMPLEXC;
$TEMPVATSTL[j].#NUMLINES = $TEMPVASTL[j].#NUMLINES + 1
break;
end

4 If a TEMPVATSTL record does not exist for that VAT code, you need to create an STL for that VAT code,
set the sequence number to the line item number, set the VAT percentage, set the STL number, and set
the total extended cost of that line item.

$TEMPVATSTL[j].#SEQA = j
$TEMPVATSTL[j].#VATRATE = ATON($INVDETAIL[i].#TEMPVATRATE);
$TEMPVATSTL[j].#VATRATECODE = $INVDETAIL[i].#VATCODE;
$TEMPVATSTL[j].#LVLA = $INVDETAIL[i].#TEMPLEXC;
$TEMPVATSTL[j].#NUMLINES = 1;

5 Finally, you need to calculate the VAT amount that is payable for each STL.

j=1
while j<= stllimit do
begin
$TEMPVATSTL[j].#VATA = ($TEMPVATSTL[j].#LVLA * $TEMPVATSTL[j].#VATRATE) / 100.0;
j = j + 1;
end

Creating an Extended Rule to Perform VAT Calculations
Now you need to combine all the pieces that you wrote into one extended rule,
including the necessary keywords to define loops. The extended rule should be
executed when the system concludes its processing of the application file (INPUT
group).
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About this task

Use this procedure to create the extended rule.

Procedure
1. Right-click the INPUT group and select Extended Rules to display the

Positional File Properties dialog box.
2. Select On End to specify that the rule will be executed when the loop

terminates. The system executes this rule when it has concluded its processing
of the application file.

3. In the Editor box, type the following (or copy from the provided map file).
integer i,j,invlimit,stllimit;
invlimit = count($INVDETAIL[*]);
stllimit = 0;
i=1;
while i <= invlimit do
begin

j=1;
while j <= stllimit do
begin

if ($INVDETAIL[i].#VATCODE = $TEMPVATSTL[j].#VATRATECODE then
begin

$TEMPVATSTL[j].#LVLA = $TEMPVATSTL[j].#LVLA + $INVDETAIL[i].#TEMPLEXC;
$TEMPVATSTL[j].#NUMLINES = $TEMPVATSTL[j].#NUMLINES + 1;
break;

end
j=j+1
end
if j > stllimit then
begin

$TEMPVATSTL[j].#SEQA = j;
$TEMPVATSTL[j].#VATRATE = ATON($INVDETAIL[i].#TEMPVATRATE);
$TEMPVATSTL[j].#VATRATECODE = $INVDETAIL[i].#VATCODE;
$TEMPVATSTL[j].#LVLA = $INVDETAIL[i].#TEMPLEXC;
$TEMPVATSTL[j].#NUMLINES = 1;
stllimit = j;

end
i=i+1;

end
j=1;
while j<= stllimit do
begin
$TEMPVATSTL[j].#VATA = ($TEMPVATSTL[j].#LVLA * $TEMPVATSTL[j].#VATRATE) / 100.0;
j = j + 1;
end

4. Click Compile to validate the syntax of the extended rule.
5. Click OK to add the extended rule to the INPUT group (application file).

Creating an Extended Rule to Calculate the Amount Payable
The second extended rule will add the total VAT amount payable (VATA) with the
total extended cost (ASDA), to calculate the sub-total amount (APSI) for each
group of line items with the same VAT code. The extended rule should be executed
when the system concludes its processing of the STL APSI element.

About this task

Use this procedure to create the extended rule.
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Procedure
1. Double-click the STL APSI element to display the Element Properties dialog

box.
2. Select the Extended Rule tab.
3. In the Rule box, type the following:

#APSI = #ASDA + #VATA;

The system executes this rule when it processes the STL APSI element.
4. Click Compile to validate the syntax of the extended rue.
5. Click OK to add the extended rule to the STL APSI element.

Invoice Trailer - TRADACOMS
You already used an explicit link (the TOTALAMOUNT field to the STL TPSI
element) so the system will be able to create the TLR segment (Invoice Trailer).
Now, you need to calculate the total amount (extended cost) of all the line items in
the invoice (LVLT) and the total VAT amount payable for all the line items in the
invoice (TVAT). This calculation is the sum of all the STL segments that you
calculated in the last section of this tutorial.

Also, because you are not using settlement discounts, you can set the EVLT (Total
Extended Amount Excluding Settlement Discount) and the ASDT (Total Amount
Excluding VAT Including Settlement) equal to the LVLT (Lines Total Amount
(Excluding VAT)). You can also set the TPSI equal to the ASDT (Total Amount
Excluding VAT Including Settlement) plus the TVAT (Total VAT Amount Payable).

Extended rule to calculate totals

You will use an extended rule on the TLR NSTL element (Number of Total
Segments) to calculate these totals. This rule will involve many different
calculations. So, you determine that it will be easiest if you break the various tasks
involved into manageable pieces, and write the rule for that part before building
all the parts into the whole rule. This process is outlined in the steps below.

This table illustrates the extended rule.

Stage Description

1 You need to define a variable to count the number of TEMPVATSTL records (limit), define a temporary
variable (i) that is set to one, and initialize the TLR LVLT and the TLR TVAT elements to zero.

integer i,limit;
limit = count($TEMPVATSTL[*]);
i=1;
#LVLT = 0;
#TVAT = 0;

2 You need to visit each iteration of the TEMPVATSTL record.

while i <= limit do
begin
i = i + 1;
end

3 You need to calculate the total amount (extended cost) of all the line items in the invoice (LVLT) and the
total VAT amount payable for all the line items in the invoice (TVAT).

#LVLT = #LVLT + $TEMPVATSTL[i].#LVLA;
#TVAT = #TVAT + $TEMPVATSTL[i].#VATA;

4 You need to set the NSTL (Number of Total Segments) equal to the number of TEMPVATSTL records.

#NSTL = limit;
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Stage Description

5 You need to set both the EVLT (Total Extended Amount Excluding Settlement Discount) and the ASDT
(Total Amount Excluding VAT Including Settlement) equal to the LVLT (Lines Total Amount (Excluding
VAT)).

#EVLT = #LVLT;
#ASDT = #LVLT;

6 Finally, you need to set the TPSI equal to the ASDT (Total Amount Excluding VAT Including Settlement)
plus the TVAT (Total VAT Amount Payable).

#TPSI = #ASDT + #TVAT;

Creating an Extended Rule to Calculate TLR Totals
Now you need to combine all the pieces that you wrote into one extended rule,
including the necessary keywords to define loops.

About this task

Use this procedure to create the extended rule.

Procedure
1. Double-click the TLR NSTL element (Number of Total Segments) to display the

Element Properties dialog box.
2. Select the Extended Rule tab.
3. In the Rule box, type the following:

integer i,limit;
limit = count($TEMPVATSTL[*]);
i=1;
#LVLT = 0;
#TVAT = 0;

while i <= limit do
begin

#LVLT = #LVLT + $TEMPVATSTL[i].#LVLA;
#TVAT = #TVAT + $TEMPVATSTL[i].#VATA;
i=i+1;

end

#NSTL = limit;
#EVLT = #LVLT;
#ASDT = #LVLT;
#TPSI = #ASDT + #TVAT;

The system executes this rule when it processes the TLR NSTL element.
4. Click Compile to validate the syntax of the extended rue.
5. Click OK to add the extended rule to the TLR NSTL element.
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Chapter 8. Finalize the Map

Compiling the Final Map
The Compile function compiles the map and generates a translation object. The
map that you created using the Application Integration subsystem is a source map.
When that source map is compiled, the result is a compiled translation object.

About this task

After you save the translation object, you must register it with Sterling
Gentran:Server before you can use it.

Use this procedure to compile a map and generate a translation object.

Procedure
1. Select File > Save to save the source map before compiling.
2. Select File > Compile.
3. Verify that the File name box contains one of the following:

v PET_810.TPL (for ANSI X12)
v PET_EINV.TPL (for EDIFACT)
v PET_TINV.TPL (for TRADACOMS)

4. Navigate to where the compiled translation object is stored, if necessary.

Important: Do not store the compiled translation object in the
GENSRVNT\RegTransObj subfolder. This subfolder is reserved for storing a
copy of each translation object you register with Sterling Gentran:Server.

5. Click Save and the system compiles the map and generates a translation object.
The Compile Error dialog box is displayed. Verify that no errors occurred and
click OK to exit the dialog box. The date on which the translation object was
compiled is automatically loaded into the Compiled on box on the Transaction
Object Details dialog box.

6. Select File > Save to save the source map with the Compiled on date.

Note: You must register this translation object with the Sterling Gentran:Server
system before you can use it.

Printing the Final Report
The Sterling Gentran:Server report enables you to validate and review the map,
and make modifications as needed. If you review the report and determine that the
map is incorrect, you should reiterate the mapping process as many times as
necessary (make the modifications, save the map, recompile the translation object,
and print the report again).

About this task

Use this procedure to print the Sterling Gentran:Server report.
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Procedure
1. Select File > Print.
2. Accept the defaults on this dialog box so the report will include all sections

and only the activated map components. Click OK and the Print dialog box is
displayed.

3. Click OK on the Print dialog box and the report is printed.

Testing the Translation Object
After you compile the map, print and verify the report, and register the translation
object with Sterling Gentran:Server, you should test the translation object to verify
that the data is translated correctly. To test the compiled translation object, you
should obtain test data from your partners and process the data. You should also
verify acknowledgement processing (if applicable) and verify communications with
your network.

About this task

Use this procedure to test the system import and import translation objects.

Note: The default path is C:\GENSRVNT\TRANSOBJ\.

Procedure
1. Register both system import and import translation objects with Sterling

Gentran:Server.
2. If you have not already done so, import the partner relationship into Sterling

Gentran:Server.
3. For TRADACOMS: Import the division lookup table (INVATCO.LKP) for the

system partner (Internal System User) into Sterling Gentran:Server.
4. Verify in Partner Editor that the import translation object is selected for the

Outbound Relationship.
5. Ask your system administrator to add the system import translation object to

the System Configuration program.
6. Use the Import option in Sterling Gentran:Server to process the data file

through the translation object. The data file is located in the default directory.
7. After the document is translated, it is located in the Workspace in Sterling

Gentran:Server. View the EDI data to ensure that the document was translated
correctly.

SDT and CDT Segments - TRADACOMS
The T_INVGRP.MAP group build map that we provide for you to use for
outbound TRADACOMS messages contains a standard rule on both the SDT01 and
CDT01 elements. These standard rules look up information by the Reference Code
from a Partner Location table, and the information that the system finds in this
partner table is used to populate the SDT and CDT segments in the Outbound
TRADACOMS Group.

If you want to populate the SDT01 and CDT01 elements in your outbound maps
with data, you need to create two partner location tables—one for the SDT
segment and one for the CDT segment.
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SDT elements

This table describes each partner location table field and its corresponding SDT
element (from the outbound SDT segment) that is populated with data.

Location Table Field Outbound Group Build Map SDT Element

Name SNAM - SUPPLIER’S NAME

Address1 SAD0 - SUPPLIER’S ADDRESS LINE 1

Address2 SAD1 - SUPPLIER’S ADDRESS LINE 2

Address3 SAD2 - SUPPLIER’S ADDRESS LINE 3

City SAD3 - SUPPLIER’S ADDRESS LINE 4

Zip SAD4 - SUPPLIER’S POST CODE

Reference Code 2 VAT0 - SUPPLIER’S VAT REGISTRATION NUMBER

CDT elements

This table describes each partner location table field and its corresponding CDT
element (from the outbound CDT segment) that is populated with data.

Location Table Field Outbound Group Build Map SDT Element

Name CNAM - SUPPLIER’S NAME

Address1 CAD0 - SUPPLIER’S ADDRESS LINE 1

Address2 CAD1 - SUPPLIER’S ADDRESS LINE 2

Address3 CAD2 - SUPPLIER’S ADDRESS LINE 3

City CAD3 - SUPPLIER’S ADDRESS LINE 4

Zip CAD4 - SUPPLIER’S POST CODE

Reference Code 2 VAT0:2 - SUPPLIER’S VAT REGISTRATION NUMBER

Populating the SDT and CDT Elements
About this task

Use this procedure to set up your partner to populate the SDT and CDT elements
in the Outbound TRADACOMS Group.

Procedure
1. Select Tools > Partner Editor.
2. Select the partner profile for which you want to create the location table and

click Outbound.
3. From the Relationship list, select the appropriate relationship and click Group.
4. From the Groups list, select the appropriate relationship and click Edit.

The system displays the Outbound Group Entry dialog box.
5. Click Envelope.

The system displays the Outbound BAT Functional Group dialog box. Note
the values listed in Field 3 and Field 4 on this dialog box.

6. Select the partner profile for which you want to create the location table and
click Locations.

7. Click New to display the Location Entry dialog box.
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8. In the Name box, type a unique identifier that defines this location within the
partner.

9. For the Reference Code 1 box for the SDT Partner Location Table, type the
value from Field 3 on the Outbound BAT Functional Group dialog box.

10. For the Reference Code 1 box for the CDT Partner Location Table, type the
value from Field 4 on the Outbound BAT Functional Group dialog box.

11. Complete the remaining boxes, as necessary.

Note: If you use Reference Code 2, it must also be unique.
12. Click Save.
13. To create the second location table, repeat steps 7 - 12.
14. Click Exit to return to the Partner Editor dialog box.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku

Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
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incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

J46A/G4

555 Bailey Avenue

San Jose, CA 95141-1003

U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.
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This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© IBM 2012. Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. 2012.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at http://www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.
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Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java™ and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise®, Gentran®,
Gentran®:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce®, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks
of others.
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